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คำนำ 
  แผนการจัดการเรียนรู้มุ่งเน้นสมรรถนะ วิชา พิมพ์ดีดอังกฤษ รหัสวิชา 20200-1005 ฉบับนี้จัดทำข้ึน
เพ่ือใช้เป็นคู ่มือครู สำหรับประกอบการจัดการเรียนการสอน หลักสูตรประกาศนียบัตรวิชาชีพ (ปว ช.) 
พุทธศักราช 2567 โดยได้ยึดแนวทางปฏิบัติในการดำเนินการทั้งรูปแบบและเนื้อหารายวิชา จากคู่มือการจัดทำ
แผนการจัดการเรียนรู้มุ่งเน้นสมรรถนะของสำนักงานคณะกรรมการการอาชีวศึกษา  กระทรวงศึกษาธิการ ซึ่ง
ครอบคลุมทั้งจุดประสงค์รายวิชา สมรรถนะรายวิชา และคำอธิบายรายวิชา นำเสนอ  แผนการจัดการเรียนรู้
เป็นรายชั่วโมงตามบทเรียน และการเรียนรู้ มีการวัดและประเมินผลทั้ง 3 ด้าน ได้แก่ ด้าน ความรู้ ด้านทักษะ 
และคุณลักษณะที่พึงประสงค์ ออกแบบการเรียนรู้ด้วยเทคนิคและวิธีการสอนที่หลากหลาย เพื่อการจัดการ
เรียนรู ้สำหรับผู ้เร ียนให้บรรลุเป้าหมายของหลักสูตร  เนื้อหาในเล่มสอดคล้องกับคำอธิบายรายวิชา 
ประกอบด้วย งานพ้ืนฐานเกี่ยวกับการฝึกพิมพ์ตัวอักษรภาษาอังกฤษอย่างถูกต้อง รวดเร็ว และมีประสิทธิภาพ 
โดยมุ่งเน้นให้ผู้เรียนสามารถใช้แป้นพิมพ์ภาษาอังกฤษได้คล่องแคล่ว เพื่อใช้ในการทำงานหรือการเรียนต่อใน
ด้านคอมพิวเตอร์และธุรกิจดิจิทัล 
         การจัดทำแผนการจัดการเรียนนรู้ฉบับนี้ ถือเป็นเป้าหมายหนึ่งของผู้จัดทำที่จะพัฒนางานด้านวิชาการ 
สู่กระบวนการจัดการเรียนการสอนอย่างมีประสิทธิภาพและประสิทธิผล ส่งผลให้การจัดการเรียนรู้บรรลุ
เป้าหมาย ตามหลักสูตรและการพัฒนาการศึกษาต่อไป 
 
        นางสาวแพรวพรรณ  ในเมือง 
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ลกัษณะรายวิชา 
หลกัสตูร ประกาศนียบตัรวิชาชีพ(ปวช.) 2567 

ประเภทวิชา บรหิารธุรกิจ    กลุม่อาชีพ การตลาด 
สาขาวิชา  เทคโนโลยีธุรกิจดิจิทลั 

ชื่อวิชา  พิมพอ์งักฤษดิจิทลั       รหสัวิชา  20200-1005 
ทฤษฎี.........0.......ชั่งโมง/สัปดาห์  ปฏิบัติ...........4.........ชัว่โมง/สัปดาห์      จำนวน.........2........หนว่ยกิต 

 
อ้างอิงมาตรฐาน 
มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า อิเล็กทรอนิกส์และคอมพิวเตอร์ 
สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1 
ผลลัพธ์การเรียนรู้ระดับรายวิชา 
พิมพ์สัมผัสอักษรภาษอังกฤษ ตัวเลข สัญลักษณ์ เครื่องหมายวรรคตอนภาษาอังกฤษ พิมพ์ประโยคาษาอังกฤษ 
พิมพ์พัฒนาความเร็วและความถูกต้องของภาษาอังกฤษ การคำนวณคำสุทธิ พิมพ์จดหมายพิมพ์เอกสารทาง
ธุรกิจการบำรุงรักษารักษาเครื่องใช้ในการพิมพ์ 
จุดประสงค์รายวิชา เพื่อให้ 
1  มีความรู้ความเข้าใจเกี่ยวกับการพิมพ์อังกฤษ 
2. มีทักษะในการพิมพ์อังกฤษแบบสัมผัส 
3. มีความขยัน อดทน วินัย กิจนิสัยและเจตคติท่ีดีในการพิมพ์อังกฤษแบบสัมผัส 
4. ประยุกต์การพิมพ์เอกสารทางธุรกิจด้วยโปรแกรมการพิมพ์ได้ถูกต้องสมรรถนะรายวิชา 
สมรรถนะรายวิชา 
1. แสดงความรู้เกี่ยวกับหลักการพิมพ์อังกฤษแบบสัมผัส 
2. พิมพ์สัมผัสแป้นอักษรภาษาอังกฤษตามหลักการ 
3. พิมพ์สัมผัสได้ตามเกณฑ์ท่ีกำหนด 
4. พิมพ์จดหมาย เอกสารทางธุรกิจตามหลักการ 
5. บำรุงรักษาเครื่องใช้ในการพิมพ์ตามค 
คำอธิบายรายวิชา 
ปฏิบัติการพิมพ์สัมผัสอักษรภาษาอังกฤษ ตัวเลข สัญลักษณ์ เครื่องหมายวรรคตอนภาษาอังกฤษ 
พิมพ์ประโยคภาษาอังกฤษ พิมพ์พัฒนาความเร็วและความถูกต้องของภาษาอังกฤษ การคำนวณคำสุทธิ 
พิมพ์จดหมาย พิมพ์เอกสารทางธุรกิจ และการบำรุงรักษารักษาเครื่องใช้ในการพิมพ 
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มาตรฐานอาชีพ  
หน่วยงานรับรองมาตรฐานอาชีพคณะกรรมการส่งเสริมการพัฒนาฝีมือแรงงานมาตรฐานอาชีพ   

สาขาวิชาชีพสาขาวิชาเทคโนโลยีดิจิทัล 
อาชีพ  ช่างไฟฟ้า อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1 

หน่วยสมรรถนะ สมรรถนะย่อย เกณฑ์การ
ปฏิบัติงาน 

วิธีประเมิน 
รหัส คำอธิบาย รหัส คำอธิบาย 

CEC-ITC-
2-001ZA 
ใช้
โปรแกรม
ประมวลผล
คำ 

บุคคลที่ทำหน้าที่
เกี่ยวกับการใช้งาน
โปรแกรม
ประมวลผลคำ ใน
การจัดการงาน
เอกสาร การ
จัดรูปแบบข้อความ 
การจัดการกับย่อ
หน้าในเอกสาร การ
แทรกวัตถุลงบน
งานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสาร 

20011 
จัดการ
งาน
เอกสาร 

การจัดการงาน
เอกสาร มีขอบเขต
ครอบคลุม การ
จัดการงานเอกสาร 
เช่น New, Open, 
Save เป็นต้น การ
แสดงมุมมอง เช่น 
Views, Ruler เป็น
ต้น การค้นหา แทนที่ 
การเคลื่อนย้าย 
รวมทั้งการยกเลิก
และทำซ้ำการกระทำ 

1.1 เอกสารถูก
จัดการได้อย่าง
ถูกต้องตามคู่มือ
การ ใช้งาน 
1.2 เอกสารถูก
แสดงมุมมองได้
อย่างถูกต้องตาม 
คู่มือการใช้งาน 
1.3 ข้อความบน
เอกสารถูกค้นหา 
แทนที่ได้อย่าง 
ถูกต้องตามคู่มือ
การใช้ 
1.4 ข้อมูลบน
เอกสารถูก
เคลื่อนย้ายได้
อย่างถูกต้อง ตาม
คู่มือการใช้งาน 
1.5 การกระทำ
บนเอกสารถูก
ยกเลิกได้อย่าง 
ถูกต้องตามคู่มือ
การใช้งาน 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
2. แบบทดสอบ
ภาคปฏิบัติ 
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CEC-ITC-
2-001ZA 
ใช้
โปรแกรม
ประมวลผล
คำ 

บุคคลที่ทำหน้าที่
เกี่ยวกับการใช้งาน
โปรแกรม
ประมวลผลคำ ใน
การจัดการงาน
เอกสาร การ
จัดรูปแบบข้อความ 
การจัดการกับย่อ
หน้าในเอกสาร การ
แทรกวัตถุลงบน
งานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสารพิมพ์
เอกสาร รวมทั้งการ
ตรวจทานงาน
เอกสาร 

20012 
จัดรูปแบบ
ข้อความ 

การจัดรูปแบบ
ข้อความ มีขอบเขต
ครอบคลุม การ
ปรับแต่งรูปแบบ
ตัวอักษร เช่น Font 
Type, Color, Size 
เป็นต้น การ
จัดรูปแบบด้วยสไตล์ 
รวมทั้งการใช้
เครื่องหมายนำหน้า
หัวข้อการจัดรูปแบบ
ข้อความ มีขอบเขต
ครอบคลุม การ
ปรับแต่งรูปแบบ
ตัวอักษร เช่น Font 
Type, Color, Size 
เป็นต้น การ
จัดรูปแบบด้วยสไตล์ 
รวมทั้งการใช้
เครื่องหมายนำหน้า
หัวข้อ 

2.1 เอกสารถูก
ปรับแต่งรูปแบบ
ตัวอักษรได้อย่าง 
ถูกต้องตามคู่มือ
การใช้งาน 
2.2 เอกสารถูก
จัดรูปแบบด้วย
สไตล์ได้อย่าง
ถูกต้อง ตามคู่มือ
การใช้งาน 
2.3 เอกสารถูกใช้
เครื่องหมาย
นำหน้าหัวข้อได้
ตาม เงื่อนไขที่
กำหนด 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
2. แบบทดสอบ
ภาคปฏิบัติ 
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CEC-ITC-
2-001ZA 
ใช้
โปรแกรม
ประมวลผล
คำ 

บุคคลที่ทำหน้าที่
เกี่ยวกับการใช้งาน
โปรแกรม
ประมวลผลคำ ใน
การจัดการงาน
เอกสาร การ
จัดรูปแบบข้อความ 
การจัดการกับย่อ
หน้าในเอกสาร การ
แทรกวัตถุลงบน
งานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสาร 

20013 
จัดการกับ
ย่อหน้าใน
เอกสาร 

การจัดการกับย่อหน้า
ในเอกสาร มีขอบเขต
ครอบคลุม การ
จัดรูปแบบย่อหน้า 
เช่น Spacing, 
Indent, Tab เป็นต้น 
การปรับแต่งด้วยชุด
รูปแบบ (Theme) 
รวมทั้งการแบ่งส่วน
เอกสาร เช่น Page 
Break, Section 
Break 

3.1 เอกสารถูก
จัดรูปแบบย่อ
หน้าได้อย่าง
ถูกต้อง ตามคู่มือ
การใช้งาน 
3.2 เอกสารถูก
ปรับแต่งด้วยชุด
รูปแบบได้อย่าง 
ถูกต้องตามคู่มือ
การใช้งาน 
3.3 เอกสารถูก
แบ่งส่วนได้อย่าง
ถูกต้องตามคู่มือ 
การใช้งาน 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
2. แบบทดสอบ
ภาคปฏิบัติ 

CEC-ITC-
2-001ZA 
ใช้
โปรแกรม
ประมวลผล
คำ 

บนงานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสารพิมพ์
เอกสาร รวมทั้งการ
ตรวจทานงาน
เอกสาร 

20014 
แทรกวัตถุ
ลงบนงาน
เอกสาร 

การแทรกวัตถุลงบน
งานเอกสาร มี
ขอบเขตครอบคลุม 
การแทรกและการ
ปรับแต่งวัตถุ เช่น 
Picture, Shape, 
Chart เป็นต้น 
รวมทั้งการแทรกและ
ปรับแต่งตาราง เช่น 
Table Style, Table 
Border เป็นต้น 

4.1 เอกสารถูก
แทรกวัตถุได้
อย่างถูกต้องตาม
คู่มือ การใช้งาน 
4.2 วัตถุถูก
ปรับแต่งได้อย่าง
ถูกต้องตามคู่มือ
การ ใช้งาน 
4.3 เอกสารถูก
แทรกตารางได้
อย่างถูกต้องตาม 
คู่มือการใช้งาน 
4.4. ตารางถูก
ปรับแต่งได้อย่าง
ถูกต้องตามคู่มือ 
การใช้งาน 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
2. แบบทดสอบ
ภาคปฏิบัติ 
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CEC-ITC-
2-001ZA 
ใช้
โปรแกรม
ประมวลผล
คำ 

บุคคลที่ทำหน้าที่
เกี่ยวกับการใช้งาน
โปรแกรม
ประมวลผลคำ ใน
การจัดการงาน
เอกสาร การ
จัดรูปแบบข้อความ 
การจัดการกับย่อ
หน้าในเอกสาร การ
แทรกวัตถุลงบน
งานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสาร 

20015 
จัดรูปแบบ
เอกสาร 

การจัดรูปแบบ
เอกสาร มีขอบเขต
ครอบคลุม การ
กำหนดค่า
หน้ากระดาษ เช่น 
Size, Orientation, 
Margins เป็นต้น 
การจัดรูปแบบ
หน้ากระดาษ เช่น 
Column, Border 
เป็นต้น รวมทั้งการ
แทรกหัว-ท้าย
กระดาษ 

5.1 เอกสารถูก
กำหนดค่า
หน้ากระดาษได้
อย่าง ถูกต้องตาม
คู่มือการใช้งาน 
5.2 เอกสารถูก
จัดรูปแบบ
หน้ากระดาษได้
อย่าง ถูกต้องตาม
คู่มือการใช้งาน 
5.3 เอกสารถูก
แทรกหัว-ท้าย
กระดาษได้อย่าง 
ถูกต้องตามคู่มือ
การใช้งาน 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
2. แบบทดสอบ
ภาคปฏิบัติ 

CEC-ITC-
2-001ZA 
ใช้
โปรแกรม
ประมวลผล
คำ 

บนงานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสารพิมพ์
เอกสาร รวมทั้งการ
ตรวจทานงาน
เอกสาร 

20016 
พิมพ์
เอกสาร 

การพิมพ์เอกสาร มี
ขอบเขตครอบคลุม 
การตั้งค่าการพิมพ์
เช่น ช่วง
หน้ากระดาษ 
เครื่องพิมพ์ จำนวน
สำเนา เป็นต้น การ
แสดงตัวอย่างก่อน
พิมพ์รวมทั้งการสั่ง
พิมพ์เอกสาร 

6.1 เอกสารถูก
ตั้งค่าการพิมพ์ได้
อย่างถูกต้องตาม 
คู่มือการใช้งาน 
6.2 เอกสารถูก
แสดงตัวอย่าง
ก่อนพิมพ์ได้อย่าง 
ถูกต้องตามคู่มือ
การใช้งาน 
6.3 เอกสารถูกสั่ง
พิมพ์ได้อย่าง
ถูกต้องตามคู่มือ 
การใช้งาน 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
2. แบบทดสอบ
ภาคปฏิบัติ 

CEC-ITC-
2-001ZA 

บุคคลที่ทำหน้าที่
เกี่ยวกับการใช้งาน
โปรแกรม

20017 การตรวจทานงาน
เอกสาร มีขอบเขต
ครอบคลุม การ

7.1 เอกสารถูก
ตรวจสอบแก้ไข
คำสะกด และ 

1.แบบทดสอบ
แบบปรนัย ชนิด 
4 ตัวเลือก 
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ใช้
โปรแกรม
ประมวลผล
คำ 

ประมวลผลคำ ใน
การจัดการงาน
เอกสาร การ
จัดรูปแบบข้อความ 
การจัดการกับย่อ
หน้าในเอกสาร การ
แทรกวัตถุลงบน
งานเอกสาร การ
จัดรูปแบบเอกสาร 
การพิมพ์เอกสาร 
รวมทั้งการ
ตรวจทานงาน
เอกสาร 

ตรวจทาน
งาน
เอกสาร 

ตรวจสอบแก้ไข
คำสะกด และ
ไวยากรณ์การ
ตรวจสอบสถิติ
จำนวนคำ รวมทั้ง
การจำกัดการแก้ไข
เอกสาร 

ไวยากรณ์ได้อย่าง
ถูกต้องตามคู่มือ
การใช้งาน 
7.2 เอกสารถูก
ตรวจสอบสถิติ
จำนวนคำได้
อย่าง ถูกต้องตาม
คู่มือการใช้งาน 
7.3 เอกสารถูก
จำกัดการแก้ไขได้
อย่างถูกต้องตาม 
คู่มือการใช้งาน 

2. แบบทดสอบ
ภาคปฏิบัติ 
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ตารางวิเคราะห์หน่วยการเรียนรู้ 
ผลลัพธ์การเรียนรู้ระดับรายวิชา(Job) พิมพ์อังกฤษดิจิทัล 

งานหลัก 
(Duty) 

งานย่อย 
(Task) 

สมรรถนะย่อย 
(มาตรฐานอาชีพ) 

ความรู้ 
ในการปฏิบัติงาน 

ทักษะ 
ในการปฏิบัติงาน 

งานหลักที ่1 
งานใช้โปรแกรม
ประมวลผลคำ 
(Word 
Processing) 

1.1 งานตั้งค่า
หน้ากระดาษ ภาษา 
รูปแบบตัวอักษร
(ฟอนต์) และขนาด
ตัวอักษร 
1.2 งานจัดรูปแบบ
เอกสาร เช่น การ
ย่อหน้า การตั้งกั้น
หน้ากั้นหลัง การ
จัดการรูปแวอักษร 
ตำแหน่งข้อความ 
1.3 งานบันทึกไฟล์ 
และส่งงานใน
รูปแบบดิจิทัล 

20012, 20013. 
20016 

1.การตั้งค่าหน้ากระดาษ 
รูปแบบตัวอักษร(ฟอนต์)
และขนาดตัวอักษร  
2.การจัดรูปแบบเอกสาร 
เช่น การย่อหน้า การตั้ง
กั้นหน้ากั้นหลัง การจัด
ตำแหน่งข้อความ การทำ
อักษรตัวหนา ตัวเอียง 
การขัดเส้นใต้ และการทำ
หัวข้อย่อย 
3.การบันทึกไฟล์ และส่ง
งานในรูปแบบดิจิทัล  

1.สามารถตั้งค่า
หน้ากระดาษ ภาษา
ฟอนต์ และขนาด
ตัวอักษรได้ 
2.สามารถจัดรูปแบบ
เอกสาร เช่น การย่อหน้า 
การจัดกึ่งกลาง การทำ
หัวข้อย่อยได้ 
3.สามารถบันทึกไฟล์ 
และส่งงานในรูปแบบ
ดิจิทัลได้ 

งานหลักที ่2 
งานพิมพ์
ตัวอักษร
ภาษาอังกฤษ 

2.1งานฝึกพิมพ์
ตัวอักษร A–Z 
แบบพิมพ์เล็ก และ
พิมพ์ใหญ่ 
2.2งานฝึกพิมพ์
ตัวเลข 0-9 และ
สัญลักษณ์พ้ืนฐาน 
เช่น @ # $ % & * 

20016 1.แป้นเหย้า A  S  D  F  J  K  
L 
2.-แป้นอักษร R  V  U  M  
3.แป้นอักษร G  H  T  Y  B  
N 
4.แป้นอักษร  E  C  I  , 
5.แป้นอักษร  W  X  O  . 
6.แป้นอักษร Q  Z  P  / 
7.การพิมพ์ตัวเลข 1  2  3  4  
5  6  7  8  9  0 
8.การพิมพ์สัญลักษณ์พิเศษ ‘  
-  “  _  ( )  &  *  %  #  @  
=  !  <>  ? { } [ ] 

1.สามารถพิมพ์แป้นเหย้า A  
S  D  F - G  H  T  J  K  L 
ได้ 
2.สามารถพิมพ์แป้น Q  W 
E  R  T -  Y  U  I  O  P ได ้
3.สามารถพิมพ์แป้น Z  X  
C  V  B – N  M  ได ้
-สามารถพิมพ์ตัวเลข 1  2  
3  4  5  6  7  8  9  0 ได้ 
-สามารถพิมพ์สัญลักษณ์
พิเศษ 
‘  -  “  _  ( )  &  *  %  #  
@  =  !  <>  ?  { }  [  ] ได ้
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งานหลักที ่3 
งานพิมพ์
เอกสาร 

3.1.การพิมพ์
ข้อความ 
3.2.การพิมพ์เป็น
ประโยค 
3.3.การพิมพ์จด
หมายุรกิจ 

20016 1.การพิมพ์ประโยคสั้น ๆ 
2.การพิมพ์ย่อหน้า 
(Paragraph) ที่มีโครงสร้าง
ง่าย ๆ 
3. การพิมพ์บันทึกข้อความ 
4..พิมพ์จดหมายภาษาอังกฤษ 
(Business Letter) 
 

1.สามารถพิมพ์ข้อความ
สั้นๆ ได้ 
2.สามารถพิมพ์ประโยคได้
ถูกต้อง 
3.สามารถพิมพ์บันทึก
ข้อความได้ 
4.สามารถพิมพ์จดหมาย
ธุรกิจได้ 

งานหลักที ่4 
งานคิดคำสุทธิ
และการพิมพ์
จับเวลาเพื่อ
พัฒนา 

4.1.หลักการในการ
คิดคำนวณหรือ
จำนวนคำสุทธิ/
นาท ี
4.2.การพิมพ์จับ
เวลา เพ่ือหาคำ
สุทธิ 

20012. 20016 1 วิธีการคำนวณเพ่ือหาคำ
สุทธิ 
2.สูตรการคำนวณ 
3.การนับ “จำนวนคำ” 
4.การเตรียมความพร้อมก่อน
เริ่มจับเวลา 
5.มารยาทและจรรยาบรรณ
ในการพิมพ์จับเวลา 
6.การสอบเพ่ือจับเวลา 

1 บอกวิธีการคำนวณเพ่ือหา
คำสุทธิได้ 
2.สามารถบอกสูตรการ
คำนวณได้ 
3.บอกวิธ๊การนับ “จำนวน
คำ”ได้ 
4.บอกการเตรียมความ
พร้อมก่อนเริ่มจับเวลาได้ 
5.บอกถึงมารยาทและ
จรรยาบรรณในการพิมพ์จับ
เวลาได ้
6.สามารถดำเนินการสอบ
เพ่ือจับเวลาได้ 

งานหลักท่ี 5 
งานตรวจสอบ
และปรับปรุง
งานพิมพ์ 

5.1 งานตรวจสอบ
การสะกดคำ 
(Spelling) 
5.2 งานแก้ไข
ข้อผิดพลาดด้วย 
Backspace, 
Delete และการ
แก้ไขข้อความ 

5.3 งานตรวจทาน
รูปแบบและความ
เรียบร้อยของงาน 

20017 1.การตรวจสอบการสะกดคำ 
(Spelling) 
2. การแก้ไขข้อผิดพลาดด้วย 
Backspace, Delete และ
การแก้ไขข้อความ 
3 การตรวจทานรูปแบบและ
ความเรียบร้อยของงาน1 

1.สามารถตรวจสอบการ
สะกดคำ (Spelling) ได้ 
2. สามารถแก้ไข
ข้อผิดพลาดด้วย 
Backspace, Delete และ
การแก้ไขข้อความได้ 
3 สามารถตรวจทานรูปแบบ
และความเรียบร้อยของงาน
ได้ 
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ตารางวิเคราะห์พฤติกรรมการเรียนรู้ 

วิชา....พิมพ์อังกฤษดิจิทัล.... รหัสวิชา.20200-1005..(ท-ป- น) เวลาเรียน..0-4-2...ชั่งโมง/สัปดาห์  
รวม..72..ชัว่โมง/ภาคเรียน    

 
 
 

หน่วยการเรียนรู้ 

 
 

ความสามารถที่คาดหวัง 

รวม 
  

จำนวน
ชั่วโมง 
ท/ป 

พุทธิพิสัย ทักษะ
พิสัย 

จิต
พิสัย 

ประยุกต์ 
ใช้ 

  
คว

าม
รู้ 

คว
าม

เข
้าใ

จ 

กา
รน

ำไ
ปใ

ช้ 

กา
รว

ิเค
รา

ะห
์ 

กา
รป

ระ
เม

ินค
่า 

กา
รส

ร้า
งส

รร
ค์      

1.งานใช้โปรแกรมประมวลผล
คำ (Word Processing) 

2 2 2 - - - 2 2 - 10  0/4 

2.งานพิมพ์ตัวอักษร
ภาษาอังกฤษ 

2 4 4 - - - 4 2 - 16 0/28 

3.งานพิมพ์เอกสาร 2 5 5 - - - 5 2 - 19 0/20 
4.งานคิดคำสุทธิและการพิมพ์
จับเวลาเพื่อพัฒนา 

2 5 5 - - - 5 2 - 19 0/8 

 5.งานตรวจสอบและปรับปรุง
งานพิมพ์ในโปรแกรม 
Microsoft Word 

2 4 4 - - - 4 2  16 0/8 

6.สอบปลายภาค - - - - - - - - - - 0/4 
            
            
รวม 10 20 20 - - - 20 10 - 80 72 

ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา (เมื่อเรียนรายวิชานี้สำเร็จแล้วทำอะไรได้) 20 0/4 
รวมทั้งรายวิชา 100 72 
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โครงการสอน/หน่วยการเรียนรู้ 
รหัสวิชา 30201–2005 วิชา พิมพ์อังกฤษดิจิทัล 

ทฤษฎี     0      ชัว่โมง/สัปดาห์  ปฏิบัติ     4     ชัว่โมง/สปัดาห์  จำนวน    2    หน่วยกิต 
หน่วย

ที ่
หน่วยการเรียนรู้ เวลาเรียน(ชม.) 

ทฤษฎี ปฏิบัติ รวม 
1 งานใช้โปรแกรมประมวลผลคำ ( Microsoft Word ) 

1. งานตั้งค่าหน้ากระดาษ ภาษา รูปแบบตัวอักษร(ฟอนต์) และ
ขนาดตัวอักษร 

2. งานจัดรูปแบบเอกสาร เช่น การย่อหน้า การตั้งกั้นหน้ากั้นหลัง 
การจัดการรูปแบบอักษร ตำแหน่งข้อความ 

3. งานบันทึกไฟล์ และส่งงานในรูปแบบดิจิทัลร 

0 4 4 

2 งานพิมพ์ตัวอักษรภาษาอังกฤษ 
1. การวางนิ้ว การสืบนิ้ว การเตาะแป้นเว้นวรรค และการยกแคร่ 
2. การวางนิ้ว;มือบนอักษรแป้นเหย้า A  S  F G  H  J  K  L  ; 
3. การวางนิ้วมือบนอักษรแป้นตัวอักษรบน Q  W  E  R  T  Y  U  

I  O  P 
4. การวางนิ้วมือบนอักษรแป้นตัวอักษรล่าง Z  X  C  V  B  N  

M 
5. การพิม์ตัวเลข 0 1 2 3 4 5 6 7 8 9 + - * / 
6. การพมพ์สัญลักษณ์พิเศษ ‘  -  “  _  ( )  &  *  %  #  @  =  !  

<>  ? { } [ ] 

0 28 28 

3 งานพิมพ์งานเอกสาร  
1. การพิมพ์ข้อความ 
2. การพิมพ์เป็นประโยค 
3. การพิมพ์จดหมายุรกิจ 

 0 20 20 

4 งานคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนา 
1. หลักการในการคิดคำนวณหรือจำนวนคำสุทธิ/นาที 
2. การพิมพ์จับเวลา เพ่ือหาคำสุทธิ 

0 8 8 

5 งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม Microsoft 
Word 

1. งานตรวจสอบการสะกดคำ (Spelling) 

0 8 8 



15 
 

2. งานแก้ไขข้อผิดพลาดด้วย Backspace, Delete และการ
แก้ไขข้อความ 

3. งานตรวจทานรูปแบบและความเรียบร้อยของงาน 
 ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา 0 4 4 
 รวม 0 72 72 
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กิจกรรมการเรียนการสอน 

ขั้นที่ 1 นำเข้าสู่บทเรียน (Motivation) 
ขั้นที่ 2 ให้เนื้อหา (Information) 
ขั้นที่ 3 ประกอบกิจกรรมการเรียน (Application) 
ขั้นที่ 4 สรุปผล (Progress)การวัดผลประเมินผล/ระดับคะแนน 

รายละเอียดการวัดผล 
การระหว่างหน่วยการเรียน      .....60.......คะแนน 
การสอบกลางภาค       .................คะแนน 
การสอบปลายภาค       .....20.......คะแนน 
บูรณาการคุณธรรม จริยธรรม และคุณลักษณะอันพึงประสงค์   ......20.....คะแนน 
งานมอบหมาย/ รายงาน/กิจกรรม       .................คะแนน 
อ่ืน ๆ         .................คะแนน 

รวม   ...100........คะแนน 
ระดับคะแนน 

 คะแนน 80 - 100 ระดับผลการเรียนระดับ  4 
 คะแนน 75 – 79  ระดับผลการเรียนระดับ  3 
 คะแนน 65 - 69  ระดับผลการเรียนระดับ           2.5 
 คะแนน 60 – 64  ระดับผลการเรียนระดับ  2 
 คะแนน 55 – 59  ระดับผลการเรียนระดับ  1.5 
 คะแนน 50 – 54  ระดับผลการเรียนระดับ  1 
 คะแนน  0 – 49  ระดับผลการเรียนระดับ  0 

สื่อการเรียนการสอน/หนังสือเรียน/หนังสือประกอบ 
1. หนังสือพิมพ์อังกฤษดิจิทัล 
2. เครื่องคอมพิวเตอร์(โปรแกรม Microsoft Words) 
3. TV 55 นิ้ว  

แหล่งเรียนรู้เพิ่มเติม 
1. ห้องปฏิบัติงานคอมพิวเตอร์แลบคอม  
2. ห้องสมุดวิทยาลัยเทคนิคบ้านค่าย 
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แบบทดสอบก่อนเรียนวิชาพิมพ์อังกฤษดิจิทัล 
คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
ตอนที่ 1: เลือกคำตอบที่ถูกที่สุด (ข้อ 1–15) 

1. แป้นพิมพ์ (Keyboard) ใช้สำหรับอะไร 
 ก. วาดภาพ   ข. ป้อนข้อมูลตัวอักษร   ค. ฟังเพลง   ง. ดูวิดีโอ 

2. แถวหลักของแป้นพิมพ์ (Home Row) คือแถวใด 
 ก. QWERTY   ข. ASDFGHJKL    ค. ZXCVBNM   ง. ตัวเลข 

3. ปุ่ม Caps Lock ใช้ทำอะไร 
 ก. ลบข้อความ   ข. พิมพ์ตัวใหญ่ทั้งหมด   ค. ขึ้นบรรทัดใหม่  ง. เว้นวรรค 

4. นิ้วก้อยขวาควรอยู่ที่ปุ่มใดเมื่อเริ่มพิมพ์ 
 ก. L    ข. ; (เซมิโคลอน)   ค. K    ง. J 

5. ปุ่ม Enter มีหน้าที่ 
 ก. ลบตัวอักษร     ข. ขึ้นบรรทัดใหม่    

6. ค. เว้นวรรค     ง. เปิดโปรแกรม 
7. ปุ่ม Space bar ใช้สำหรับ 

 ก. ลบข้อความ     ข. พิมพ์ตัวเลข 
 ค. เว้นวรรคระหว่างคำ    ง. พิมพ์ตัวพิมพ์ใหญ่ 

8. การพิมพ์โดยไม่มองแป้นพิมพ์เรียกว่า 
 ก. Blind Typing    ข. Smart Typing 
 ค. Touch Typing    ง. Speed Typing 

9. ปุ่ม Shift ใช้ร่วมกับปุ่มตัวอักษรเพ่ือทำอะไร 
 ก. พิมพ์ตัวพิมพ์ใหญ่    ข. ลบข้อความ 
 ค. บันทึกงาน     ง. เปิดไฟล์ 

10. การพิมพ์เอกสารในคอมพิวเตอร์มักใช้โปรแกรมใด 
 ก. Microsoft Word    ข. Paint       ค. Excel    ง. Chrome 

11. การจัดแนวข้อความให้อยู่ตรงกลางเรียกว่า 
 ก. Left Align      ข. Right Align 
 ค. Center Align     ง. Justify 

12. การฝึกพิมพ์ให้ได้ความเร็วสูงควรเน้นสิ่งใด 
 ก. มองคีย์บอร์ดตลอดเวลา    ข. ใช้นิ้วมือเดิมทุกครั้ง 
 ค. ใช้มือข้างเดียว     ง. กดปุ่มแรง ๆ 
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13. แป้นพิมพ์ภาษาอังกฤษทั่วไปเรียกว่า 
 ก. QWERTY Keyboard    ข. AZERTY Keyboard 
 ค. DVORAK Keyboard    ง. Numeric Keyboard 

14. ปุ่ม Backspace ใช้ทำอะไร 
 ก. ลบตัวอักษรถัดไป    ข. ลบตัวอักษรก่อนหน้า 
 ค. เว้นวรรค     ง. ยืนยันคำสั่ง 

15. ปุ่ม Tab ใช้สำหรับ 
 ก. ขึ้นบรรทัดใหม ่ ข. จัดระยะย่อหน้า  ค. ลบข้อความ   ง. พิมพ์ตัวใหญ่ 

16. โปรแกรม Google Docs อยู่ในระบบใด 
 ก. Offline     ข. Cloud (ออนไลน์)   

17. ค. เกมออนไลน์     ง. โปรแกรมตกแต่งภาพ 
 
 ตอนที่ 2: เติมคำลงในช่องว่าง (ข้อ 16–20) 

1. การวางนิ้วมือบนปุ่มหลักเรียกว่า “______________ position” 
2. ปุ่มที่ยาวที่สุดบนแป้นพิมพ์คือ “______________” 
3. โปรแกรมท่ีใช้พิมพ์เอกสารออนไลน์คือ “______________” 
4. ปุ่มที่ใช้ขึ้นบรรทัดใหม่คือ “______________” 
5. การพิมพ์โดยไม่มองแป้น เรียกว่า “______________” 

 
เฉลย (สำหรับครูผู้สอน)ตอนที่ 1 
1.ข 
2.ข 
3.ข 
4.ข 
5.ข 
6.ค 
7.ค 
8.ก 
9.ก 
1ค 

11.ข 
12.ก 
13.ข 
14.ข 
15.ข 

เฉลย (สำหรับครูผู้สอน)ตอนที่ 2 
16.Home Row 
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17.Space bar 
18.Google Docs 
19.Enter 
20.Touch Typing 
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แผนการจัดการเรียนที่ 1 หน่วยที ่    1 

รหัสวิชา 20200-1005     ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สอนครั้งที่ 1 
ชื่อหน่วยการเรียนรู้   งานใช้โปรแกรมประมวลผลคำ (Word 
Processing) 

ทฤษฎี  0 ชม. 
ปฏิบัติ  4 ชม. 

ชื่อเรื่อง/งาน   งานใช้โปรแกรมประมวลผลคำ (Word Processing)  
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการใช้งานโปรแกรม Microsoft Word การพิมพ์แบบพิมพ์เล็ก พิมพ์ใหญ่ 
การจัดการหน้ากระดาษ การตั้งก้ันหน้า กั้นหลัง การจัดการกับตัวอักษร การจัดตำแหน่งข้อความ ตลอดจน
การบันทึกงานโดยแปลงไฟล์เป็นไฟล์ PDF แลการส่งงานในรูปแบบดิจิทัล 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

1. แสดงความรู้ในการเรียกใช้โปรแกรม Microsoft Word 2019 ได้ 
2. แสดงความรู้ในการสร้างเอกสารใหม่ การใช้แป้นตัวอักษร และการใช้แถบเครื่องมือในการ
ทำงานได้ 
3. แสดงความรู้ในการตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ 
4. แสดงความรู้ในการบันทึกข้อมูล และการส่งงานทางดิจิทัลได้ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. ใช้งานโปรแกรม Microsoft Word 2019 ได้ 
2.สร้างเอกสารใหม่ ใช้แป้นตัวอักษร และสามารถใช้ถบเครื่องมือในการทำงานได้  
3. ตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ กำหนดขนาดกระดาษได้ 
 กำหนดแบบและขนาดตัวอักษรได้ 
4.บันทึกข้อมูล และส่งงานทางดิจิทัลได้ 
4.2 ด้านทักษะ ผู้เรียนสามารถ 
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1. สามารถเรียกใช้งานโปรแกรม Microsoft Word ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. สาระการเรียนรู้ 
1. การเรียกใช้โปรแกรม Microsoft Word 2019  
2. การสร้างเอกสารใหม่ ใช้แป้นตัวอักษร และใช้แถบเครื่องมือในการทำงาน 
3. การตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษร 
4. การบันทึกข้อมูล และส่งงานทางดิจิทัล 

สัปดาห์ที่ 1    
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1. ผู้สอนปฐมนิเทศผู้เรียนโดยชี้แจงหลักสูตร
ประกาศนียบัตรวิชาชีพ  หมวดสมรรถนะวิชาชีพ 
กลุ่มสมรรถนะวิชาชีพพ้ืนฐาน ประเภทวิชา
บริหารธุรกิจ จุดประสงค์รายวิชา มาตรฐาน เกณฑ์
การวัดผลประเมินผล และกิจกรรม กฎเกณฑ์ 
ระเบียบ และข้อปฏิบัติต่าง ๆ    
2. ผู้สอนแนะนำวิธีการเก็บคแนนและกำหนด
หลักเกณฑ์การให้คะแนน 
3. ผู้สอนชี้แจงการประเมินผลพฤติกรรมรายบุคคล 
การทำงาน การประเมินคุณธรรมจริยธรรม ค่านิยม 
และคุณลักษณะอันพึงประสงค์ให้ผู้เรียนปฏิบัติ 
ขั้นสอน                         
 1.ผู้สอนกล่าวเพ่ือเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
องค์ประกอบของโปรแกรม Microsoft Word  
2. ผู้สอนอธิบายเรื่องการวสร้างงานใหม่  การใช้ปุ่ม 
Delete และปุ ่ม Backspace การเคาะเว ้นวรรค 

1. ผู้เรียนรับทราบรายละเอียดของรายวิชาและ 
 ผลลัพธ์การเรียนรู้ระดับรายวิชาและระดับ 
 บทเรียน พร้อมทั้งเกณฑ์การวัดผลประเมินผล 
2.ผู้เรียนรับฟังการเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
องค์ประกอบของเครื่องคอมพิวเตอร์ 
3. ผู้เรียนทำแบบทดสอบก่อนเรียน 
4. ผู้เรียนฟังและปฏิบัติตามครูผู้สอน 
5.ผู้เรียนร่วมแสดงความคิดเห็นเพิ่มเติม และ 
 ซักถามในสิ่งที่ไม่เข้าใจ 
6.ผู้เสอนตรวจแบบทดสอบตามที่ผู้สอนเฉลย 
7.ผู้เรียนบอกคะแนนแบบทดสอบ   
8.ผู้เรียนฟังและนำไปพัฒนาในบทเรียนต่อไป 
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การขึ้นบรรทัดใหม่ การจัดเก็บงาน และการแปลง
เป็นไฟล์ PDF  
3. .ผู ้สอนให้ผู ้เรียนลองพิมพ์ข้อความสั ้นๆ แล้ว
จัดเก็บตัวอย่างไฟล์งาน 
นสรุป 
1.  ผู้สอนและผู้เรียนตรวจสอบการเก็บไฟล์งานของ
ตนเอง     
  

 
7. สื่อและแหล่งการเรียนรู้ 

1. หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์งเสริม
วิชาการ 
2. คอมพิวเตอร์ (โปรแกรมMicrosoft Word) 
3. ใบความรู้/ใบกิจกรรม 
4. TV      

8. หลักฐานการเรียนรู้ 
   8.1 หลักฐานความรู้          

- ใบงาน  
 - ใบความรู้  
  - ใบกิจกรรม   
8.2 หลักฐานการปฏิบัติงาน          

-ภาพการปฏิบัติงาน การฝึกฝนทักษะบันทึกในแบบบันทึกหลังการสอนออนไลน์  
9. การวัดและประเมินผล 

9.1 เกณฑ์การปฏิบัติงาน 

- แบบสังเกตพฤติกรรมรายบุคคล เกณฑ์ผ่าน  50%  ขึ้นไป 

- แบบทดสอบหลังเรียน เกณฑ์ผ่าน  60%  ขึ้นไป 
9.2  วิธีการประเมิน 

- สังเกตพฤติกรรมการปฏิบัติงาน  

- ตรวจแบบประเมินผลการเรียนรู้ก่อนเรียน และหลังเรียน 

- การสังเกตและประเมินผลพฤติกรรมด้านคุณธรรม จริยธรรม ค่านิยม และคุณลักษณะอันพึง
ประสงค์ 

9.3 เครื่องมือประเมิน 
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- แบบทดสอบแบบการเลือกตอบ  
10. บันทึกผลหลังการจัดการเรียนรู้ 
  10.1 เอกสารการบันทึกหลังการสอนในระบบออนไลน์ 
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ใว 
ใบความรู้ที่ 1 หน่วยที่   1   

รหัสวิชา 20200-1005     ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  1  
ชื่อหน่วยการเรียนรู้   งานใช้โปรแกรมประมวลผลคำ (Word 
Processing)  

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานใช้โปรแกรมประมวลผลคำ (Word Processing)  ปฏิบัติ    4    ชัว่โมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการใช้งานโปรแกรม Microsoft Word การพิมพ์แบบพิมพ์เล็ก พิมพ์ใหญ่ การ
จัดการหน้ากระดาษ การตั้งกั้นหน้า กั้นหลัง การจัดการกับตัวอักษร การจัดตำแหน่งข้อความ ตลอดจนการ
บันทึกงานโดยแปลงไฟล์เป็นไฟล์ PDF แลการส่งงานในรูปแบบดิจิทัล 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   
สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

1. แสดงความรู้ในการเรียกใช้โปรแกรม Microsoft Word 2019 ได้ 
2. แสดงความรู้ในการสร้างเอกสารใหม่ การใช้แป้นตัวอักษร และการใช้แถบเครื่องมือในการทำงาน
ได้ 
3. แสดงความรู้ในการตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ 
4. แสดงความรู้ในการบันทึกข้อมูล และการส่งงานทางดิจิทัลได้ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
    4.1 ด้านความรู้  ผู้เรียนสามารถ 

1. ใช้โปรแกรม Microsoft Word 2019 ได้ 
2.สร้างเอกสารใหม่ ใช้แป้นตัวอักษร และสามารถใช้ถบเครื่องมือในการทำงานได้  
3. ตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ กำหนดขนาดกระดาษได้ 
 กำหนดแบบและขนาดตัวอักษรได้ 
4.บันทึกข้อมูล และส่งงานทางดิจิทัลได้ 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
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1. สามารถเรียกใช้งานโปรแกรม Microsoft Word ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 

      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้ 5. เนื้อหาสาระ   

5.เนื้อหาสาระ   
1. การใช้โปรแกรม Microsoft Word 2019  
2.การสร้างเอกสารใหม่ การใช้แป้นตัวอักษร และการใช้แถบเครื่องมือในการทำงาน 
3. การตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษร การกำหนดขนาดกระดาษ 
 กำหนดแบบและขนาดตัวอักษรได้ 
4.บันทึกข้อมูล เป็นไฟล์ PDF 
5. การส่งงานทางดิจิทัล 

6.     แบบฝึกหัด/แบบทดสอบ 

คำสั่ง   จงตอบคำถามต่อไปนี้  
1. การสร้างเทคนิคท่ีดีในการพิมพ์สัมผัสมีอะไรบ้าง  
2. จงบอกวิธีการสร้างเอกสารใหม่ในโปรแกรม Microsoft Word  
3. จงบอกวิธีการปรับขนาดตัวอักษร และวิธีการเปลี่ยนแบบตัวอักษรใน Microsoft Word 
4.จงบอกวิธีการตั้งกั้นหน้า กั้นหลังในเอกสาร Microsoft Word 
5.จงบอกวิธีการบันทึกงานจากไฟล์ Microsoft Word เป็นไฟล์ PDF  

 7. เอกสารอ้างอิง  
1.    หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม

วิชาการ 

8.     ภาคผนวก  (เฉลยแบบทดสอบ) 

คำสั่ง   จงตอบคำถามต่อไปนี้  
1. การสร้างเทคนิคที่ดีในการพิมพ์สัมผัสมีอะไรบ้าง  
ตอบ 1. จัดวางนิ้วให้ถูกตำแหน่ง   มือซ้ายวางบนปุ่ม A S D F  มือขวาวางบนปุ่ม J K L ;  นิ้วหวัแม่มือ
วางบนปุ่ม Space bar 
2. ไม่มองแป้นพิมพ์  ฝึกให้สายตาอยู่บนหน้าจอตลอดเวลาใช้ความรู้สึกของนิ้วในการหาตำแหน่ง
ตัวอักษร เริ่มช้า ๆ เพ่ือให้จำตำแหน่งได้แม่นก่อนค่อยเพ่ิมความเร็ว 
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 3. พิมพ์ด้วยจังหวะสม่ำเสมอ พิมพ์ให้เป็นจังหวะต่อเนื่อง ไม่รีบ ไม่ช้าเกินไป ใช้เสียงพิมพ์หรือการนับ
จังหวะในใจช่วยให้คงจังหวะได้ 
 4. ใช้นิ้วทุกนิ้วให้เกิดประโยชน์ แต่ละนิ้วมีหน้าที่รับผิดชอบแป้นพิมพ์เฉพาะตำแหน่ง หลีกเลี่ยงการใช้
แค่นิ้วชี้สองนิ้ว  
 5. จัดท่านั่งให้เหมาะสม หลังตรง ไม่เอนมาก แขนและข้อมืออยู่ในระดับเดียวกับแป้นพิมพ์ จัดเก้าอ้ี
และโต๊ะให้สูงพอดี ไม่ต้องก้มมากเกินไป 
 6. ฝึกซ้ำเป็นประจำ ฝึกทุกวันวันละ 10–15 นาที จะช่วยให้กล้ามเนื้อมือจำตำแหน่งได้เอง 
7. เน้น “ความถูกต้อง” ก่อน “ความเร็ว”ความเร็วจะเพ่ิมข้ึนเองเมื่อพิมพ์ถูกต้องและม่ันใจ  
8. พักมือและสายตาเป็นระยะ ทุก ๆ 20 นาทีควรพักมือและมองออกห่างจากหน้าจอสัก 20 วินาที 
ช่วยลดอาการปวดเมื่อยและสายตาล้า 
 
2. จงบอกวิธีการสร้างเอกสารใหม่ในโปรแกรม Microsoft Word  
วิธีที่ 1 : สร้างเอกสารใหม่จากโปรแกรมโดยตรง 

- เปิดโปรแกรม Microsoft Word  

- ดับเบิลคลิกท่ีไอคอน Microsoft Word บนหน้าจอ (Desktop) หรือคลิก Start → All 

Programs → Microsoft Office → Microsoft Word 
- เมื่อเปิดโปรแกรมแล้ว จะมีหน้าต่างขึ้นว่า "New Document" หรือ "เอกสารใหม่" เลือก Blank 

Document (เอกสารเปล่า)  
- คลิกท่ี Blank document เพ่ือเริ่มสร้างเอกสารใหม่จากนั้นจะเข้าสู่หน้าจอที่สามารถพิมพ์งานได้

ทันที 
 วิธีที่ 2 : สร้างเอกสารใหม่จากเมนูในโปรแกรม 

- เปิดโปรแกรม Microsoft Word แล้ว คลิกท่ีเมนู File (แฟ้ม) ด้านบนซ้ายของหน้าจอ 
- เลือกคำสั่ง New (สร้างใหม่) คลิกเลือก Blank Document (เอกสารเปล่า) 
- โปรแกรมจะเปิดหน้าเอกสารใหม่ให้คุณพิมพ์ได้เลย 

 วิธีที่ 3 : ใช้เทมเพลต (Template) 

- คลิกเมนู File → New เลือกหมวดหมู่เทมเพลต เช่น Resume, Report, Letter 
- คลิกเลือกเทมเพลตที่ต้องการ คลิก Create (สร้าง) เพื่อเริ่มใช้งาน 

 
3. จงบอกวิธีการปรับขนาดตัวอักษร และวิธีการเปลี่ยนแบบตัวอักษรใน Microsoft Word 

1. วิธีการปรับขนาดตัวอักษร (Font Size) 
- เลือกข้อความที่ต้องการปรับขนาด ไปที่แท็บ Home (หน้าแรก)มองหากลุ่มคำสั่ง Font (แบบ

อักษร) บนแถบเครื่องมือด้านบน และเลือกแบบตัวอักษร 
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2. การปรับขนาดตัวอักษร 
- เลือกข้อความที่ต้องการปรับขนาด ไปที่แท็บ Home (หน้าแรก)) บนแถบเครื่องมือด้านบนคลิก

ที่ ช่องตัวเลขขนาดตัวอักษร (เช่น 11, 12, 14, 16...) 
 
4.จงบอกวิธีการตั้งกั้นหน้า กั้นหลังในเอกสาร Microsoft Word 
1. การตั้งก้ันหน้า (Margins) — ขอบกระดาษ 
 ขั้นตอนที่ 1 : เปิดเอกสารใน Microsoft Wordเปิดเอกสารที่ต้องการจัดหน้า หรือเริ่มเอกสารใหม่ก็ได้ 
 ขั้นตอนที่ 2 : ไปที่แท็บ Layout (เค้าโครงหน้า)หรือในบางเวอร์ชันอาจชื่อว่า Page Layout (เค้าโครง
เพจ) 

 ขั้นตอนที่ 3 : คลิกคำสั่ง Margins (ระยะขอบ)จะปรากฏรายการให้เลือก เช่น Normal (ปกติ) → บน 

1”, ล่าง 1”, ซ้าย 1”, ขวา 1”  Narrow (แคบ) → ทุกด้าน 0.5” , Moderate (ปานกลาง) → ซ้าย 

1.25”, ขวา 1”, บน/ล่าง 1” , Wide (กว้าง) → ซ้าย 2”, ขวา 1” 
 
 ตัวอย่างขนาดที่นิยมใช้ในเอกสารราชการไทย: 

บน 1 นิ้ว 
ล่าง 1 นิ้ว 
ซ้าย 1.5 นิ้ว 
ขวา 1 นิ้ว 

2. การตั้งก้ันหลัง (Indent) — ระยะเยื้องข้อความ 
ขั้นตอนที่ 1 : เลือกข้อความหรือย่อหน้าที่ต้องการปรับ (สามารถทำก่อนหรือหลังพิมพ์ก็ได้) 
 ขั้นตอนที่ 2 : ไปที่แท็บ Home (หน้าแรก) ในกลุ่ม Paragraph (ย่อหน้า) 
 ขั้นตอนที่ 3 : คลิกที ่ลูกศรเล็ก ๆ มุมขวาล่างของกลุ่ม Paragraph จะเปิดหน้าต่าง Paragraph 
Settings 

 ขั้นตอนที่ 4 : กำหนดค่าช่อง Indentation (ระยะเยื้อง) 
Left (ซ้าย) : เยื้องจากขอบซ้าย 
Right (ขวา) : เยื้องจากขอบขวา 
Special (พิเศษ) : เลือกได้ว่า 

First line → เยื้องบรรทัดแรกของแต่ละย่อหน้า 

Hanging → เยื้องทุกบรรทัด ยกเว้นบรรทัดแรก 
 
5.จงบอกวิธีการบันทึกงานจากไฟล์ Microsoft Word เป็นไฟล์ PDF  
วิธีที่ 1 : บันทึกไฟล์ Word เป็น PDF โดยตรง 
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ขั้นตอนที่ 1 : เปิดเอกสารที่ต้องการบันทึก  เปิดไฟล์ Word ที่พิมพ์งานเสร็จแล้ว 
ขั้นตอนที่ 2 : คลิกท่ีเมนู File (แฟ้ม) อยู่มุมบนซ้ายของหน้าจอ 
 ขั้นตอนที่ 3 : เลือกคำสั่ง Save As (บันทึกเป็น)  เลือกตำแหน่งที่จะบันทึก เช่น This PC, Desktop, 
หรือ Documents 
ขั้นตอนที่ 5 : ตั้งชื่อไฟล์ พิมพ์ชื่อไฟล์ที่ต้องการในช่อง File name (ชื่อไฟล์) 
ขั้นตอนที่ 6 : เปลี่ยนชนิดไฟล์คลิกช่อง Save as type (บันทึกเป็นชนิดไฟล์) เลือก PDF (*.pdf) จาก
รายการ 
 ขั้นตอนที่ 7 : คลิกปุ่ม Save (บันทึก) ไฟล์ PDF จะถูกสร้างขึ้นในตำแหน่งที่คุณเลือกไว้ 
วิธีที่ 2 : ใช้คำสั่ง Export (ส่งออก) 

- ไปที่เมนู File (แฟ้ม)  เลือก Export (ส่งออก) คลิก Create PDF/XPS Document (สร้าง
เอกสาร PDF/XPS) 

- คลิกปุ่ม Create PDF/XPS เลือกตำแหน่งจัดเก็บไฟล์ 

- ตั้งชื่อไฟล์ → คลิก Publish (เผยแพร่) 
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ใบกิจกรรมที่ 1 หน่วยที่  1   

รหัสวิชา 20200-1005     ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  1   
ชื่อหน่วยการเรียนรู้   งานใช้โปรแกรมประมวลผลคำ (Word 
Processing)  

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานใช้โปรแกรมประมวลผลคำ (Word Processing)  ปฏิบัติ    4    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการใช้งานโปรแกรม Microsoft Word การพิมพ์แบบพิมพ์เล็ก พิมพ์ใหญ่ การ
จัดการหน้ากระดาษ การตั้งกั้นหน้า กั้นหลัง การจัดการกับตัวอักษร การจัดตำแหน่งข้อความ ตลอดจนการ
บันทึกงานโดยแปลงไฟล์เป็นไฟล์ PDF แลการส่งงานในรูปแบบดิจิทัล 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   
สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

1. แสดงความรู้ในการเรียกใช้โปรแกรม Microsoft Word 2019 ได้ 
2. แสดงความรู้ในการสร้างเอกสารใหม่ การใช้แป้นตัวอักษร และการใช้แถบเครื่องมือในการทำงาน
ได้ 
3. แสดงความรู้ในการตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ 
4. แสดงความรู้ในการบันทึกข้อมูล และการส่งงานทางดิจิทัลได้ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
    4.1 ด้านความรู้  ผู้เรียนสามารถ 

1. ปรแกรม Microsoft Word 2019 ได้ 
2.สร้างเอกสารใหม่ ใช้แป้นตัวอักษร และสามารถใช้ถบเครื่องมือในการทำงานได้  
3. ตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ กำหนดขนาดกระดาษได้ 
 กำหนดแบบและขนาดตัวอักษรได้ 
4.บันทึกข้อมูล และส่งงานทางดิจิทัลได้ 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
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1. สามารถเรียกใช้งานโปรแกรม Microsoft Word ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 

ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     มีวินัยใน
ตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญาของเศรษฐกิจพอเพียงได้  
5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้ 
 5.3 คอมพิวเตอร์(โปรแกรม Microsoft Word) 
 5.4 TV 
6. ข้ันตอนการทำกิจกรรม 

    6.1 ผู้สอนจัดให้ผู้เรียนนั่งที่โต๊คอมพิวเตอร์แบบเรียงเลขท่ี(จำนวน 1 คน ต่อ 1 เครื่อง) 
6.2 ผู้สอนให้ผู้เรียนเปิดโปรแกรม Microsoft Word แล้วอิบายการใช้งานเบื้องต้น 
6.3 ผู้เรียนปฏิบัติตามผู้สอน แล้วทดลองส่งตัวอย่างงานให้ผู้สอนในกลุ่มไลน์ห้องเรียน 

7. สรุปและอภิปราย  
7.1 ครูและนักเรียน ช่วยกันสรุปเนื้อหา 

8.  สรุปและวิจารณ์ผล  
8.1 ครูและนักเรียนร่วมกันสรุปเนื้อหน้า แก้ไขปัญหาที่เกิดจากการไม่เข้าใจการใช้งาน Microsoft 

Word และการส่งงานทางกลุ่มไลน์ 
9. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม 

9.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ 
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ใบงานที่ 1 หน่วยที่   1   

รหัสวิชา 20200-1005     ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  1   
ชื่อหน่วยการเรียนรู้   งานใช้โปรแกรมประมวลผลคำ (Word 
Processing) 

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานใช้โปรแกรมประมวลผลคำ (Word Processing) ปฏิบัติ    4    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการใช้งานโปรแกรม Microsoft Word การพิมพ์แบบพิมพ์เล็ก พิมพ์ใหญ่ การ
จัดการหน้ากระดาษ การตั้งกั้นหน้า กั้นหลัง การจัดการกับตัวอักษร การจัดตำแหน่งข้อความ ตลอดจนการ
บันทึกงานโดยแปลงไฟล์เป็นไฟล์ PDF แลการส่งงานในรูปแบบดิจิทัล 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   
สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

1. แสดงความรู้ในการเรียกใช้โปรแกรม Microsoft Word 2019 ได้ 
2. แสดงความรู้ในการสร้างเอกสารใหม่ การใช้แป้นตัวอักษร และการใช้แถบเครื่องมือในการทำงาน
ได้ 
3. แสดงความรู้ในการตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ 
4. แสดงความรู้ในการบันทึกข้อมูล และการส่งงานทางดิจิทัลได้ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
    4.1 ด้านความรู้  ผู้เรียนสามารถ 

1. ใช้โปรแกรม Microsoft Word 2019 ได้ 
2.สร้างเอกสารใหม่ ใช้แป้นตัวอักษร และสามารถใช้ถบเครื่องมือในการทำงานได้  
3. ตั้งค่าหน้ากระดาษ และ กำหนดแบบและขนาดตัวอักษรได้ กำหนดขนาดกระดาษได้ 
 กำหนดแบบและขนาดตัวอักษรได้ 
4.บันทึกข้อมูล และส่งงานทางดิจิทัลได้ 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
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1. สามารถเรียกใช้งานโปรแกรม Microsoft Word ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 

ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์  มีวินัยใน
ตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญาของเศรษฐกิจพอเพียงได้  
5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้/ใบกิจกรรม 

5.3 คอมพิวเตอร์  
5.4 TV  

6. คำแนะนำ/ข้อควรระวัง  
6.1 ปฏิบัติงานด้วยความละเอียดรอบคอบ   

7. ข้ันตอนการปฏิบัติงาน 
ชื่อเรื่อง การใช้งานพื้นฐานโปรแกรม Microsoft Word 

  เวลา 120 นาที 
 จุดประสงค์   

1. ผู้เรียนใช้โปรแกรม Microsoft Word ในการเรียนพิมพ์อังกฤษดิจิทัลได้ 
2. ผู้เรียนสามารถส่งใบงานในรูปแบบดิจิทัลได้ 

 วัสดุอุปกรณ์   
1. คอมพิวเตอร์(โปรแกรม Microsoft Word) 

2.TV 

 ขั้นตอนการดำเนินงาน 
                      1.ผู้เรียนนัง่ตามเลขท่ี โดยผู้เรียน 1 คน ต่อคอมพิวเตอร์ 1 ตัว 

2.ผู้เรียนปฏิบัติงานตามผู้สอน โดยดูวิธีการทำงานจาก TV ที่ใช้เป็นสื่อการสอน 
3.ผู้เรียนทดลองส่งงานตัวอย่างให้ครูผู้สอนทางไลน์กลุ่ม  
4.ผู้สอนแก้ไขปัญหาในการใช้งาน Microsoft Word กรณีผู้เรียนส่งงานไม่ได้   

8.  สรุปและวิจารณ์ผล  
ครูและนักเรียนร่วมกันสรุปเนื้อหน้า และแก้ไขปัญหาการใช้งาน Microsoft Word 

9. การประเมินผล  
ผู้เรียนปฏิบัติตามผู้สอน และสามารถทดลองส่งตัวอย่างไฟล์งานได้ทุกคน 

10. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม  



33 
 

10.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ 
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 แผนการจัดการเรียนรู้ 2 หน่วยที่ 2 
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สอนครั้งที ่2 -8 
ชื่อหน่วยการเรียนรู้   งานพิมพ์ตัวอักษรภาษาอังกฤษ ทฤษฎี  0 ชม. 

ปฏิบัติ  28 ชม. ชื่อเรื่อง/งาน   งานพิมพ์ตัวอักษรภาษาอังกฤษ  
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาการพิมพ์ดีดภาษาอังกฤษ ที่ประกอบไปด้วยการวางนิ้ว การสืบนิ้ว การยกแคร่ แป้นอักษร
แป้นวรรณยุกต์ แป้นสระในภาษาอังกฤษ และแป้นตัวเลข แป้นสัญลักษณ์พิเศษ การพิมพ์ตัวพิมพ์ใหญ่ 
พิมพ์เล็ก 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2.มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 

4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       1.  มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
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     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. สาระการเรียนรู้ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4. กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

6. กิจกรรมการเรียนรู้     
สัปดาห์ที่  2    
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพ่ือเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นเหย้า ตัวอักษร a s 
d f g h j k l ;  เพ่ือการเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนสอนพิมพ์แป้นเหย้า และปฏิบัติให้ผู้เรียนฝึก
ปฏิบัติตาม 
ขั้นสอน 
1.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นเหย้า
อักษร  a s d f g h j k l ; เพ่ือการเรียนพิมพ์อังกฤษ
ดิจิทัล 
2. ผู้สอนบอกวิธีการวางนิ้วบนแป้นเหย้า การลบ
ตัวอักษร การเคาะเว้นวรรครหว่างคำ และการขึ้น
บรรทัดใหม่ พร้อมแจกใบงานที่ 2 ให้ผู้เรียน 
3. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์
ที่สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF และบันทึก
เป็นชื่อของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

1. ผู้เรียนปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นเหย้า เพ่ือ
การเรียนพิมพ์ไทยดิจิทัล 
2. ผู้เรียนฝึกก้าวนิ้วแป้นเหย้า และปฏิบัติงานตามใบ
งานที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 2 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบงาน 
 5.ผู้เรียนปฏิบัติที่ 2 เสร็จแลว้บันทึกงาน พร้อม
นำส่งทางกลุ่มไลน์ 
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สัปดาห์ที่  3    
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นตัวอักษรบน q w e 
r t y  u I o p  เพ่ือการเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนสอนการพิมพ์แป้นอักษรบน และปฏิบัติให้
ผู้เรียนฝึกปฏิบัติตาม 
ขั้นสอน 
1.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัต ิการฝึกหัดพิมพ์ส ัมผัสแป้น
อักษรบน  q w e r  t y  u I o p เพ่ือการเรียนพิมพ์
อังกฤษดิจิทัล 
2. ผู้สอนบอกวิธีการวางนิ้วบนแป้นอักษรบน บอก
ข้อตกลงในการทำใบงาน และแจกใบงานที่ 3 ให้
ผู้เรียน 
3. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

1. ผู้เรียนปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นเหย้า 
เพ่ือการเรียนพิมพ์ไทยดิจิทัล 
2. ผู้เรียนฝึกก้าวนิ้วแป้นอักษรบน และปฏิบัติ 
งานตามใบงานที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 3 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 3 เสร็จแลว้บันทึกงาน พร้อม
นำส่งทางกลุ่มไลน์ 

 
สัปดาห์ที่  4  
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นตัวอักษรล่าง z x c 
v b n m , . /  เพ่ือการเรียนพิมพ์อังกฤษดิจิทัล 

1. ผู้เรียนปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นเหย้า 
เพ่ือการเรียนพิมพ์ไทยดิจิทัล 
2. ผู้เรียนฝึกก้าวนิ้วแป้นอักษรล่าง และปฏิบัติ 
งานตามใบงานที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 4 
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2.ผู้สอนสอนการพิมพ์แป้นอักษรล่าง และปฏิบัติให้
ผู้เรียนฝึกปฏิบัติตาม 
ขั้นสอน 
1.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัต ิการฝึกหัดพิมพ์ส ัมผัสแป้น
อักษรล่าง z x c v b n m , . / เพื่อการเรียนพิมพ์
อังกฤษดิจิทัล 
2. ผ ู ้สอนบอกว ิธ ีการวางนิ ้วบนแป้นอักษรล่าง 
ข้อตกลงในการทำใบงาน และแจกใบงานที่ 4 ให้
ผู้เรียน 
3. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 4 เสร็จแลว้บันทึกงาน พร้อม
นำส่งทางกลุ่มไลน์ 

 
สัปดาห์ที่  5-6   
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นตัวอักษรตัวเลข
แป้นพิมพ์แถวบน 1 2 3 4 5 6 7 8 9  + - * / เพ่ือ
การเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนสอนการพิมพ์แป้นอักษรตัวเลข และปฏิบัติ
ให้ผู้เรียนฝึกปฏิบัติตาม 
ขั้นสอน 
1.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นตัวเลข
จากแป้นพิมพ์แถวบน 1 2 3 4 5 6 7 8 9 + - * / 
เพ่ือการเรียนพิมพ์อังกฤษดิจิทัล 

1. ผู้เรียนปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นตัวเลข 
เพ่ือการเรียนพิมพ์ไทยดิจิทัล 
2. ผู้เรียนฝึกก้าวนิ้วแป้นตัวเลข และปฏิบัติงาน
ตามใบงานที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 5 - 6 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 5- 6 เสร็จแล้วบันทึกงาน 
พร้อมนำส่งทางกลุ่มไลน์ 
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2. ผู ้สอนบอกวิธีการวางนิ ้วบนแป้นอักษรตัวเลข 
บอกข้อตกลงในการทำใบงาน และแจกใบงานที่ 5-6 
ให้ผู้เรียน 
3. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

 
สัปดาห์ที่  7-8   
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้นสัญลักษณ์พิเศษ ‘  
-  “  _  ( )  &  *  %  #  @  =  !  <>  ? { } [ ]  เพ่ือ
การเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู ้สอนสอนการพิมพ์แป้นสัญลักษณ์พิเศษ และ
ปฏิบัติให้ผู้เรียนฝึกปฏิบัติตาม 
ขั้นสอน 
1.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัต ิการฝึกหัดพิมพ์ส ัมผัสแป้น
สัญลักษณ์พิเศษ ‘  -  “  _  ( )  &  *  %  #  @  =  
!  <>  ? { } [ ] เพ่ือการเรียนพิมพ์อังกฤษดิจิทัล 
2. ผู้สอนบอกวิธีการวางนิ้วบนแป้นสัญลักษณ์พิเศษ 
ข้อตกลงในการทำใบงาน และแจกใบงานที่ 7-8 ให้
ผู้เรียน 
3. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 

1. ผู้เรียนปฏิบัติการฝึกหัดพิมพ์สัมผัสแป้น
สัญลักษณ์พิเศษ เพ่ือการเรียนพิมพ์ไทยดิจิทัล 
2. ผู้เรียนฝึกก้าวนิ้วแป้นสัญลักษณ์พิเศษ และ
ปฏิบัติงานตามใบงานที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 7-8 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 7-8 เสร็จแล้วบันทึกงาน 
พร้อมนำส่งทางกลุ่มไลน์ 
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1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

 
7. สื่อและแหล่งการเรียนรู้ 

1.   หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์  
      ส่งเสริมวชิาการ 
2.    ใบความรู้/ใบกิจกรรม     
3     กิจกรรมการเรียนการสอน 
4     เครื่องคอมพิวเตอร์ และ TV  

8. หลักฐานการเรียนรู้ 
   8.1 หลักฐานความรู้          
 - ใบความรู้ 
    - ใบกืจกรรม 
 - ใบงาน 
8.2 หลักฐานการปฏิบัติงาน          

-ภาพการปฏิบัติงาน การฝึกฝนทักษะบันทึกในแบบบันทึกหลังการสอนออนไลน์  
9. การวัดและประเมินผล 

9.1 เกณฑ์การปฏิบัติงาน 
1.    แบบสังเกตพฤติกรรมรายบุคคล เกณฑ์ผ่าน  50%  ขึ้นไป 
2.    แบบทดสอบหลังเรียน เกณฑ์ผ่าน  60%  ขึ้นไป 
3.    ชื้นงาน 70% ขึ้นไป 
9.2  วิธีการประเมิน 

- สังเกตพฤติกรรมการปฏิบัติงาน  

- การจับเวลา 

- - การตรวจชิ้นงาน 
9.3 เครื่องมือประเมิน 

- แบบประเมิน/แบบฟอร์มบันทึกความก้าวหน้า 

- แบบประเมินเชิงปริมาณ 
10. บันทึกผลหลังการจัดการเรียนรู้ 

- เอกสารการบันทึกหลังการสอนในระบบออนไลน์ 
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 ใบความรู้ที่ 2 หน่วยที่   2   
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  2- 8 
ชื่อหน่วยการเรียนรู้   งานพิมพ์ตัวอักษรภาษาอังกฤษ ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานพิมพ์ตัวอักษรภาษาอังกฤษ ปฏิบัติ    28   ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาการพิมพ์ดีดภาษาอังกฤษ ที่ประกอบไปด้วยการวางนิ้ว การสืบนิ้ว การยกแคร่ แป้นอักษร
แป้นวรรณยุกต์ แป้นสระในภาษาอังกฤษ และแป้นตัวเลข แป้นสัญลักษณ์พิเศษ การพิมพ์ตัวพิมพ์ใหญ่ 
พิมพ์เล็ก 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2.คิดค่ารวมและบันทึกรายงานความก้าวหน้าในการพิมพ์ได้ 
3.มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 

4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 

4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
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      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เนื้อหาสาระ   
1. แถวแป้นเหย้า (Home Row) 
คือแถวกลางของแป้นพิมพ์ภาษาอังกฤษ 
แป้นเหย้าของมือซ้ายและมือขวาคือ: 
A  S  D  F G  (มือซ้าย) 
H J  K  L  ;   (มือขวา) 

 
 2. การวางนิ้วที่ถูกต้อง 

• นิ้วชี้ซ้าย วางที่แป้น G 
• นิ้วชี้ซ้าย วางที่แป้น F 
• นิ้วชี้ขวา วางที่แป้น H 
• นิ้วชี้ขวา วางที่แป้น J 
• นิ้วกลางซ้าย วางที่แป้น D 
• นิ้วนางซ้าย วางที่แป้น S 
• นิ้วก้อยซ้าย วางที่แป้น A 
• นิ้วกลางขวา วางที่แป้น K 
• นิ้วนางขวา วางที่แป้น L 
• นิ้วก้อยขวา วางที่แป้น ; 
• นิ้วหัวแม่มือทั้งสองข้าง วางที่แป้น Space bar 

 
 3. วิธีสังเกตแป้นเหย้า 
บนแป้น F และ J จะมี “ปุ่มนูนเล็ก ๆ” 
เพ่ือให้นักพิมพ์สามารถวางนิ้วถูกตำแหน่งโดยไม่ต้องมองแป้นพิมพ์ 

 
4. การพิมพ์แถวอ่ืน 

• แถว บน (Top Row) เช่น Q W E R T(...Y U I O P…. 
ให้เลื่อนนิ้วขึ้นจากแป้นเหย้าโดยไม่ยกมือขึ้น 

o นิ้วชี้ซ้าย วางที่แป้นT 
o นิ้วชี้ซ้าย วางที่แป้น R 
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o นิ้วชี้ขวา วางที่แป้น Y 
o นิ้วชี้ขวา วางที่แป้นU 
o นิ้วกลางซ้าย วางที่แป้น E 
o นิ้วนางซ้าย วางที่แป้น W 
o นิ้วก้อยซ้าย วางที่แป้น Q 
o นิ้วกลางขวา วางที่แป้น I 
o นิ้วนางขวา วางที่แป้น O 
o นิ้วก้อยขวา วางที่แป้น P 

 
• แถว ล่าง (Bottom Row) เช่น Z X C V B...N M , . 

ให้เลื่อนนิ้วลงจากแป้นเหย้า แล้วกลับมาที่เดิมทุกครั้ง 
o นิ้วชี้ซ้าย วางที่แป้น B 
o นิ้วชี้ซ้าย วางที่แป้น V 
o นิ้วชี้ขวา วางที่แป้น N 
o นิ้วชี้ขวา วางที่แป้น M 
o นิ้วกลางซ้าย วางที่แป้น C 
o นิ้วนางซ้าย วางที่แป้น X 
o นิ้วก้อยซ้าย วางที่แป้น Z 
o นิ้วกลางขวา วางที่แป้น , 
o นิ้วนางขวา วางที่แป้น . 
o นิ้วก้อยขวา วางที่แป้น / 

 
 5. เคล็ดลับฝึกพิมพ์สัมผัส 

1. วางนิ้วให้ถูกตำแหน่งเสมอ 
2. อย่ามองแป้นพิมพ์ขณะพิมพ์ 
3. ฝึกพิมพ์คำง่าย ๆ ก่อน เช่น “asdf jkl;” 
4. เมื่อคล่องแล้ว ค่อยฝึกพิมพ์คำศัพท์จริง ๆ 

6.     แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 2   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. แถวแป้นเหย้าของแป้นพิมพ์ภาษาอังกฤษคือแถวใด 
ก. QWERTY  ข. ASDF JKL;  ค. ZXCVBNM  ง. ตัวเลข 123456 
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2. ปุ่มที่มี “นูน” เพื่อบอกตำแหน่งนิ้วชี้คือแป้นใด 
ก. A และ L  ข. F และ J  ค. S และ K  ง. D และ L 

3. นิ้วใดวางที่แป้น A 
ก. นิ้วชี้ซ้าย  ข. นิ้วกลางซ้าย  ค. นิ้วนางซ้าย  ง. นิ้วก้อยซ้าย 

4. แป้นใดเป็นตำแหน่งนิ้วชี้ขวา 
ก. K   ข. L   ค. J   ง. ; 

5. แป้นเหย้าของมือขวามีทั้งหมดกี่แป้น 
ก. 3   ข. 4   ค. 5   ง. 6 

6. เมื่อพิมพ์ตัวอักษรเสร็จแล้ว ควรทำอย่างไร 
ก. วางมือไว้เฉย ๆ    ข. ยกมือลอยขึ้น   
ค. กลับมาวางที่แป้นเหย้าเดิม   ง. วางมือบนโต๊ะ 

7. นิ้วหัวแม่มือใช้สำหรับกดแป้นใด 
ก. Enter  ข. Space bar  ค. Shift   ง. Caps Lock 

8. แถวบนของแป้นพิมพ์ภาษาอังกฤษคือแถวใด 
ก. QWERTY  ข. ASDFGH  ค. ZXCVBN  ง. ตัวเลข 

9. หากต้องการพิมพ์อักษร “K” ควรใช้นิ้วใด 
ก. นิ้วชี้ขวา  ข. นิ้วกลางขวา  ค. นิ้วนางขวา  ง. นิ้วก้อยขวา 

10. การพิมพ์สัมผัสที่ดีควรเป็นอย่างไร 
ก. พิมพ์เร็วแต่ผิดบ่อย    ข. พิมพ์ช้าแต่ถูกต้อง 
ค. พิมพ์โดยมองแป้นพิมพ์    ง. พิมพ์ด้วยนิ้วเดียว 

 
 แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 3   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. แถวแป้นบนของแป้นพิมพ์ภาษาอังกฤษมีอักษรเริ่มต้นว่าอะไร 
ก. ASDFGH  ข. ZXCVBN  ค. QWERTY  ง. 123456 

2. แป้นพิมพ์ “Q” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วก้อยซ้าย  ข. นิ้วนางซ้าย  ค. นิ้วกลางซ้าย  ง. นิ้วชี้ซ้าย 

3. แป้น “W” และ “E” ใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ซ้าย    ข. นิ้วกลางซ้ายและนิ้วนางซ้าย 
ค. นิ้วชี้ขวา    ง. นิ้วกลางขวา 

4. แป้น “R” และ “T” ใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ซ้าย  ข. นิ้วกลางซ้าย  ค. นิ้วนางซ้าย  ง. นิ้วก้อยซ้าย 
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5. แป้น “Y” และ “U” อยู่บริเวณมือใด 
ก. มือซ้าย    ข. มือขวา   
ค. มือซ้ายและมือขวาร่วมกัน  ง. มือขวาเท่านั้น 

6. แป้น “I” และ “O” ใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ขวา    ข. นิ้วกลางขวาและนิ้วนางขวา 
ค. นิ้วก้อยขวา    ง. นิ้วหัวแม่มือ 

7. แป้น “P” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ขวา  ข. นิ้วกลางขวา  ค. นิ้วนางขวา  ง. นิ้วก้อยขวา 

8. การพิมพ์แป้นบนควรทำอย่างไร 
ก. ยกมือขึ้นจากแป้นเหย้า   ข. เลื่อนนิ้วขึ้นจากแป้นเหย้าโดยไม่ยกมือ 
ค. ใช้มือข้างเดียว    ง. มองแป้นพิมพ์ตลอดเวลา 

9. หลังจากพิมพ์แป้นบนเสร็จ ควรทำอย่างไร 
ก. ปล่อยมือบนอากาศ   ข. กลับมาวางที่แป้นเหย้าเดิม 
ค. วางมือบนโต๊ะ    ง. เปลี่ยนนิ้วพิมพ์ 

10. ข้อใด “ไม่ใช่” แป้นบนของแป้นพิมพ์ภาษาอังกฤษ 
ก. E   ข. T   ค. L   ง. O 

 
แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 4   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. แถวแป้นล่างของแป้นพิมพ์ภาษาอังกฤษมีตัวอักษรเริ่มต้นว่าอะไร 
ก. QWERTY  ข. ASDFGH  ค. ZXCVBNM  ง. 123456 

2. แป้น “Z” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วก้อยซ้าย  ข. นิ้วนางซ้าย  ค. นิ้วกลางซ้าย  ง. นิ้วชี้ซ้าย 

3. แป้น “X” และ “C” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วก้อยซ้ายและนิ้วนางซ้าย  ข. นิ้วนางซ้ายและนิ้วกลางซ้าย 
ค. นิ้วกลางซ้ายและนิ้วชี้ซ้าย  ง. นิ้วชี้ซ้ายและนิ้วกลางซ้าย 

4. แป้น “V” และ “B” อยู่บริเวณมือใด 
ก. มือซ้าย    ข. มือขวา 
ค. มือซ้ายและมือขวาร่วมกัน  ง. มือขวาเท่านั้น 

5. แป้น “N” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ขวา  ข. นิ้วกลางขวา  ค. นิ้วนางขวา  ง. นิ้วก้อยขวา 
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6. แป้น “M” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วก้อยขวา  ข. นิ้วนางขวา  ค. นิ้วกลางขวา  ง. นิ้วชี้ขวา 

7. การพิมพ์แป้นล่างควรทำอย่างไร 
ก. ยกมือขึ้นจากแป้นเหย้า   ข. เลื่อนนิ้วลงจากแป้นเหย้าโดยไม่ยกมือ 
ค. ใช้มือข้างเดียวพิมพ์   ง. มองแป้นพิมพ์ตลอดเวลา 

8. หลังจากพิมพ์แป้นล่างเสร็จ ควรทำอย่างไร 
ก. ปล่อยมือบนอากาศ   ข. กลับมาวางที่แป้นเหย้า 
ค. พักมือไว้ที่โต๊ะ    ง. พิมพ์ต่อโดยไม่กลับตำแหน่ง 

9. แป้น “B” อยู่บริเวณใดของแป้นพิมพ์ 
ก. มือซ้าย    ข. มือขวา 
ค. อยู่ตรงกลางระหว่างมือซ้ายและมือขวา ง. ไม่มีคำตอบที่ถูก 

10. การฝึกพิมพ์แป้นล่างบ่อย ๆ มีประโยชน์อย่างไร 
ก. พิมพ์ได้เร็วขึ้น    ข. นิ้วแข็งและเม่ือย 
ค. ต้องมองแป้นตลอดเวลา  ง. พิมพ์ได้ช้าลง 

 
แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 5   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. แป้นตัวเลขของแป้นพิมพ์ภาษาอังกฤษอยู่บริเวณใด 
ก. แถวล่างสุด  ข. แถวกลาง  ค. แถวบนสุด  ง. แถวตัวอักษร 

2. ตัวเลขในแถวบนสุดของแป้นพิมพ์ เริ่มจากตัวเลขใด 
ก. 0   ข. 1   ค. 2   ง. 9 

3. ตัวเลขในแถวบนสุดของแป้นพิมพ์มีทั้งหมดก่ีตัว 
ก. 8   ข. 9   ค. 10   ง. 11 

4. ตัวเลข “1” อยู่เหนือแป้นใดของแป้นเหย้า 
ก. Q   ข. A   ค. Z   ง. W 

5. แป้น “5” อยู่เหนือแป้นใดของแป้นเหย้า 
ก. T   ข. F   ค. G   ง. H 

6. ตัวเลข “0” อยู่ระหว่างแป้นใด 
ก. 8 และ 9  ข. 9 และ -  ค. - และ =  ง. ไม่มีคำตอบที่ถูก 

7. การพิมพ์ตัวเลขแถวบน ควรใช้นิ้วแบบใด 
ก. ยกมือทั้งสองขึ้นพิมพ์   ข. ใช้นิ้วเลื่อนขึ้นจากแป้นเหย้าโดยไม่ยกมือ 
ค. ใช้เพียงมือขวา   ง. ใช้เพียงมือซ้าย 
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8. การพิมพ์หมายเลข “6” ใช้นิ้วใด 
ก. นิ้วชี้ซ้าย  ข. นิ้วชี้ขวา  ค. นิ้วกลางซ้าย  ง. นิ้วก้อยซ้าย 

9. ตัวเลข “7, 8, 9, 0” อยู่ในบริเวณมือใด 
ก. มือซ้าย  ข. มือขวา  ค. กลางแป้น  ง. ทั้งสองมือ 

10. การฝึกพิมพ์ตัวเลขช่วยให้เกิดประโยชน์ข้อใด 
ก. พิมพ์เร็วขึ้นและถูกต้องมากข้ึน  ข. จำตัวอักษรได้ดีขึ้น 
ค. ใช้มือเดียวพิมพ์ได้   ง. มองแป้นพิมพ์ได้ถนัดข้ึน 

 
แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 6   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. เครื่องหมาย + (บวก) บนแป้นพิมพ์ภาษาอังกฤษอยู่ร่วมกับแป้นใด 

ก. แป้น -  ข. แป้น =  ค. แป้น /  ง. แป้น * 
2. หากต้องการพิมพ์เครื่องหมาย + (บวก) ต้องกดปุ่มใดร่วมด้วย 

ก. Ctrl + =  ข. Shift + =  ค. Alt + =  ง. Shift + - 
3. เครื่องหมาย - (ลบ) อยู่ที่แป้นใดของแถวตัวเลข 

ก. ระหว่าง 7 และ 8   ข. ระหว่าง 9 และ 0 
ค. ถัดจากเลข 0    ง. ถัดจากแป้น P 

4. การพิมพ์เครื่องหมาย _ (ขีดล่าง) ต้องใช้ปุ่มใดร่วมกับแป้นลบ 
ก. Alt   ข. Ctrl   ค. Shift   ง. Tab 

5. เครื่องหมาย * (ดอกจัน) ใช้แทนการคำนวณแบบใด 
ก. บวก   ข. ลบ   ค. คูณ   ง. หาร 

6. การพิมพ์เครื่องหมาย * ต้องกดแป้นใดร่วมกัน 
ก. Shift + 7  ข. Shift + 8  ค. Ctrl + 8  ง. Alt + 8 

7. เครื่องหมาย / (ทับ)** ใช้แทนการคำนวณแบบใด 
ก. ลบ   ข. คูณ   ค. หาร   ง. บวก 

8. เครื่องหมาย / (ทับ)** อยู่บริเวณใดของแป้นพิมพ์ภาษาอังกฤษ 
ก. ใต้แป้น Enter    ข. ขวาของแป้น . (จุด) 
ค. ซ้ายของแป้น Shift   ง. เหนือแป้น Tab 

9. ถ้าต้องการพิมพ์เครื่องหมาย + - * / อย่างถูกต้อง ควรทำอย่างไร 
ก. ใช้นิ้วก้อยขวาทั้งหมด   ข. มองแป้นพิมพ์ทุกครั้ง 
ค. ใช้นิ้วที่ถูกต้องตามตำแหน่งและกด Shift เมื่อจำเป็น 
ง. ใช้นิ้วเดียวพิมพ์ทุกแป้น 
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10. การฝึกพิมพ์สัญลักษณ์เหล่านี้บ่อย ๆ ช่วยให้เกิดผลดีอย่างไร 
ก. พิมพ์ได้เร็วและแม่นยำขึ้น  ข. ใช้นิ้วได้เหนื่อยมากข้ึน 
ค. ต้องพิมพ์ช้าลง   ง. ต้องมองแป้นทุกครั้ง 

 
แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 7   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. เครื่องหมาย - (ขีดกลาง) พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม - โดยไม่ต้องกด Shift ข. Shift + -   ค. Alt + -   ง. Ctrl + - 
2. เครื่องหมาย _ (ขีดล่าง) พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม - โดยไม่ต้องกด Shift  ข. Shift + -   ค. Alt + -   ง. Shift + = 
3. การพิมพ์วงเล็บเปิด ( ใช้แป้นใด? 
    ก. Shift + 7   ข. Shift + 8   ค. Shift + 9   ง. Shift + 0 
4. การพิมพ์วงเล็บปิด ) ใช้แป้นใด? 
    ก. Shift + 7   ข. Shift + 8   ค. Shift + 9   ง. Shift + 0 
5. สัญลักษณ ์& พิมพ์โดยใช้แป้นใด? 
ก. Shift + 5   ข. Shift + 6   ค. Shift + 7   ง. Shift + 8 
6. เครื่องหมาย * (ดอกจัน) พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 6   ข. Shift + 7   ค. Shift + 8   ง. Shift + 9 
7. สัญลักษณ์ % พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 3   ข. Shift + 4   ค. Shift + 5   ง. Shift + 6 
8. เครื่องหมาย # พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 2   ข. Shift + 3   ค. Shift + 4   ง. Shift + 5 
9. เครื่องหมาย @ พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 1   ข. Shift + 2   ค. Shift + 3   ง. Shift + 4 
10. สัญลักษณ์ ! พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 1   ข. Shift + 2   ค. Shift + 3   ง. Shift + 4 

 
บบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 8   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. เครื่องหมาย < พิมพ์โดยใช้แป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /   ง. Shift + ; 
2. เครื่องหมาย > พิมพ์โดยใช้แป้นใด? 
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    ก. Shift + ,   ข. Shift + .   ค. Shift + /   ง. Shift + ; 
3. เครื่องหมาย ? พิมพ์โดยใช้แป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /   ง. Shift + ; 
4. เครื่องหมาย { พิมพ์โดยใช้แป้นใด? 
    ก. Shift + [   ข. Shift + ]   ค. Shift + {   ง. Shift + } 
5. เครื่องหมาย } พิมพ์โดยใช้แป้นใด? 
    ก. Shift + [   ข. Shift + ]    ค. Shift + {   ง. Shift + } 
6. เครื่องหมาย [ พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม [ โดยไม่ต้องกด Shift  ข. Shift + [   ค. Alt + [   ง. Ctrl + [ 
7. เครื่องหมาย ] พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม ] โดยไม่ต้องกด Shift  ข. Shift + ]   ค. Alt + ]   ง. Ctrl + ] 
8. เครื่องหมาย <> ใช้ในการพิมพ์อย่างไร? 
    ก. Shift + , และ Shift + .    ข. Shift + / และ Shift + \  
ค. Shift + [ และ Shift + ]    ง. Shift + ; และ Shift + ' 
9. เครื่องหมาย ? ใช้ในการพิมพ์ประโยคคำถาม ต้องกดแป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /    ง. Shift + ' 
10. การพิมพ์ { } ต้องกดแป้นใดร่วมกับ Shift? 
    ก. [ และ ]   ข. { และ }   ค. ( และ )    ง. < และ > 
7. เอกสารอ้างอิง  

1.    หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม

วิชาการ 

8.     ภาคผนวก  (เฉลยแบบทดสอบ) 
เฉลยสัปดาห์ที่ 2   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. แถวแป้นเหย้าของแป้นพิมพ์ภาษาอังกฤษคือแถวใด 
ก. QWERTY  ข. ASDF JKL;  ค. ZXCVBNM  ง. ตัวเลข 123456 

2. ปุ่มที่มี “นูน” เพื่อบอกตำแหน่งนิ้วชี้คือแป้นใด 
ก. A และ L  ข. F และ J  ค. S และ K  ง. D และ L 

3. นิ้วใดวางที่แป้น A 
ก. นิ้วชี้ซ้าย  ข. นิ้วกลางซ้าย  ค. นิ้วนางซ้าย  ง. นิ้วก้อยซ้าย 

4. แป้นใดเป็นตำแหน่งนิ้วชี้ขวา 
ก. K   ข. L   ค. J   ง. ; 
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5. แป้นเหย้าของมือขวามีทั้งหมดกี่แป้น 
ก. 3   ข. 4   ค. 5   ง. 6 

6. เมื่อพิมพ์ตัวอักษรเสร็จแล้ว ควรทำอย่างไร 
ก. วางมือไว้เฉย ๆ    ข. ยกมือลอยขึ้น   
ค. กลับมาวางที่แป้นเหย้าเดิม   ง. วางมือบนโต๊ะ 

7. นิ้วหัวแม่มือใช้สำหรับกดแป้นใด 
ก. Enter  ข. Space bar  ค. Shift   ง. Caps Lock 

8. แถวบนของแป้นพิมพ์ภาษาอังกฤษคือแถวใด 
ก. QWERTY  ข. ASDFGH  ค. ZXCVBN  ง. ตัวเลข 

9. หากต้องการพิมพ์อักษร “K” ควรใช้นิ้วใด 
ก. นิ้วชี้ขวา  ข. นิ้วกลางขวา  ค. นิ้วนางขวา  ง. นิ้วก้อยขวา 

10. การพิมพ์สัมผัสที่ดีควรเป็นอย่างไร 
ก. พิมพ์เร็วแต่ผิดบ่อย    ข. พิมพ์ช้าแต่ถูกต้อง 
ค. พิมพ์โดยมองแป้นพิมพ์    ง. พิมพ์ด้วยนิ้วเดียว 
1.ข   2.ข   3.ง   4.ค   5. ข   6.ค   7.ข    8.ก   9.ข   10.ข 

 
เฉลยสัปดาห์ที่ 3  คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. แถวแป้นบนของแป้นพิมพ์ภาษาอังกฤษมีอักษรเริ่มต้นว่าอะไร 
ก. ASDFGH  ข. ZXCVBN  ค. QWERTY  ง. 123456 

2. แป้นพิมพ์ “Q” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วก้อยซ้าย  ข. นิ้วนางซ้าย  ค. นิ้วกลางซ้าย  ง. นิ้วชี้ซ้าย 

3. แป้น “W” และ “E” ใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ซ้าย    ข. นิ้วกลางซ้ายและนิ้วนางซ้าย 
ค. นิ้วชี้ขวา    ง. นิ้วกลางขวา 

4. แป้น “R” และ “T” ใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ซ้าย  ข. นิ้วกลางซ้าย  ค. นิ้วนางซ้าย  ง. นิ้วก้อยซ้าย 

5. แป้น “Y” และ “U” อยู่บริเวณมือใด 
ก. มือซ้าย    ข. มือขวา   
ค. มือซ้ายและมือขวาร่วมกัน  ง. มือขวาเท่านั้น 

6. แป้น “I” และ “O” ใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ขวา    ข. นิ้วกลางขวาและนิ้วนางขวา 
ค. นิ้วก้อยขวา    ง. นิ้วหัวแม่มือ 
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7. แป้น “P” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ขวา  ข. นิ้วกลางขวา  ค. นิ้วนางขวา  ง. นิ้วก้อยขวา 

8. การพิมพ์แป้นบนควรทำอย่างไร 
ก. ยกมือขึ้นจากแป้นเหย้า   ข. เลื่อนนิ้วขึ้นจากแป้นเหย้าโดยไม่ยกมือ 
ค. ใช้มือข้างเดียว    ง. มองแป้นพิมพ์ตลอดเวลา 

9. หลังจากพิมพ์แป้นบนเสร็จ ควรทำอย่างไร 
ก. ปล่อยมือบนอากาศ   ข. กลับมาวางที่แป้นเหย้าเดิม 
ค. วางมือบนโต๊ะ    ง. เปลี่ยนนิ้วพิมพ์ 

10. ข้อใด “ไม่ใช่” แป้นบนของแป้นพิมพ์ภาษาอังกฤษ 
ก. E   ข. T   ค. L   ง. O 

1.ค    2.ก 3.ข 4.ก 5.ข 6.ข 7.ง 8.ข 9.ข 10.ค 

 
เฉลยสัปดาห์ที่ 4 

สัปดาห์ที่ 4   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. แถวแป้นล่างของแป้นพิมพ์ภาษาอังกฤษมีตัวอักษรเริ่มต้นว่าอะไร 

ก. QWERTY  ข. ASDFGH  ค. ZXCVBNM  ง. 123456 
2. แป้น “Z” ควรใช้นิ้วใดพิมพ์ 

ก. นิ้วก้อยซ้าย  ข. นิ้วนางซ้าย  ค. นิ้วกลางซ้าย  ง. นิ้วชี้ซ้าย 
3. แป้น “X” และ “C” ควรใช้นิ้วใดพิมพ์ 

ก. นิ้วก้อยซ้ายและนิ้วนางซ้าย  ข. นิ้วนางซ้ายและนิ้วกลางซ้าย 
ค. นิ้วกลางซ้ายและนิ้วชี้ซ้าย  ง. นิ้วชี้ซ้ายและนิ้วกลางซ้าย 

4. แป้น “V” และ “B” อยู่บริเวณมือใด 
ก. มือซ้าย    ข. มือขวา 
ค. มือซ้ายและมือขวาร่วมกัน  ง. มือขวาเท่านั้น 

5. แป้น “N” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วชี้ขวา  ข. นิ้วกลางขวา  ค. นิ้วนางขวา  ง. นิ้วก้อยขวา 

6. แป้น “M” ควรใช้นิ้วใดพิมพ์ 
ก. นิ้วก้อยขวา  ข. นิ้วนางขวา  ค. นิ้วกลางขวา  ง. นิ้วชี้ขวา 

7. การพิมพ์แป้นล่างควรทำอย่างไร 
ก. ยกมือขึ้นจากแป้นเหย้า   ข. เลื่อนนิ้วลงจากแป้นเหย้าโดยไม่ยกมือ 
ค. ใช้มือข้างเดียวพิมพ์   ง. มองแป้นพิมพ์ตลอดเวลา 



51 
 

8. หลังจากพิมพ์แป้นล่างเสร็จ ควรทำอย่างไร 
ก. ปล่อยมือบนอากาศ   ข. กลับมาวางที่แป้นเหย้า 
ค. พักมือไว้ที่โต๊ะ    ง. พิมพ์ต่อโดยไม่กลับตำแหน่ง 

9. แป้น “B” อยู่บริเวณใดของแป้นพิมพ์ 
ก. มือซ้าย    ข. มือขวา 
ค. อยู่ตรงกลางระหว่างมือซ้ายและมือขวา ง. ไม่มีคำตอบที่ถูก 

10. การฝึกพิมพ์แป้นล่างบ่อย ๆ มีประโยชน์อย่างไร 
ก. พิมพ์ได้เร็วขึ้น    ข. นิ้วแข็งและเม่ือย 
ค. ต้องมองแป้นตลอดเวลา  ง. พิมพ์ได้ช้าลง 

1.ค    2.ก  3.ค 4.ค 5.ก 6.ข 7.ข 8.ข 9.ค 10.ก 

 
เฉลยสัปดาห์ที่ 5 

สัปดาห์ที่ 5   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. แป้นตัวเลขของแป้นพิมพ์ภาษาอังกฤษอยู่บริเวณใด 

ก. แถวล่างสุด  ข. แถวกลาง  ค. แถวบนสุด  ง. แถวตัวอักษร 
2. ตัวเลขในแถวบนสุดของแป้นพิมพ์ เริ่มจากตัวเลขใด 

ก. 0   ข. 1   ค. 2   ง. 9 
3. ตัวเลขในแถวบนสุดของแป้นพิมพ์มีทั้งหมดก่ีตัว 

ก. 8   ข. 9   ค. 10   ง. 11 
4. ตัวเลข “1” อยู่เหนือแป้นใดของแป้นเหย้า 

ก. Q   ข. A   ค. Z   ง. W 
5. แป้น “5” อยู่เหนือแป้นใดของแป้นเหย้า 

ก. T   ข. F   ค. G   ง. H 
6. ตัวเลข “0” อยู่ระหว่างแป้นใด 

ก. 8 และ 9  ข. 9 และ -  ค. - และ =  ง. ไม่มีคำตอบที่ถูก 
7. การพิมพ์ตัวเลขแถวบน ควรใช้นิ้วแบบใด 

ก. ยกมือทั้งสองขึ้นพิมพ์   ข. ใช้นิ้วเลื่อนขึ้นจากแป้นเหย้าโดยไม่ยกมือ 
ค. ใช้เพียงมือขวา   ง. ใช้เพียงมือซ้าย 

8. การพิมพ์หมายเลข “6” ใช้นิ้วใด 
ก. นิ้วชี้ซ้าย  ข. นิ้วชี้ขวา  ค. นิ้วกลางซ้าย  ง. นิ้วก้อยซ้าย 

9. ตัวเลข “7, 8, 9, 0” อยู่ในบริเวณมือใด 
ก. มือซ้าย  ข. มือขวา  ค. กลางแป้น  ง. ทั้งสองมือ 
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10. การฝึกพิมพ์ตัวเลขช่วยให้เกิดประโยชน์ข้อใด 
ก. พิมพ์เร็วขึ้นและถูกต้องมากข้ึน  ข. จำตัวอักษรได้ดีขึ้น 
ค. ใช้มือเดียวพิมพ์ได้   ง. มองแป้นพิมพ์ได้ถนัดข้ึน 

1.ค    2.ข  3.ค 4.ก 5.ข 6.ข 7.ข 8.ข 9.ข 10.ก 

 
เฉลยสัปดาห์ที่ 6   

สัปดาห์ที่ 6   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
11. เครื่องหมาย + (บวก) บนแป้นพิมพ์ภาษาอังกฤษอยู่ร่วมกับแป้นใด 

ก. แป้น -  ข. แป้น =  ค. แป้น /  ง. แป้น * 
12. หากต้องการพิมพ์เครื่องหมาย + (บวก) ต้องกดปุ่มใดร่วมด้วย 

ก. Ctrl + =  ข. Shift + =  ค. Alt + =  ง. Shift + - 
13. เครื่องหมาย - (ลบ) อยู่ที่แป้นใดของแถวตัวเลข 

ก. ระหว่าง 7 และ 8   ข. ระหว่าง 9 และ 0 
ค. ถัดจากเลข 0    ง. ถัดจากแป้น P 

14. การพิมพ์เครื่องหมาย _ (ขีดล่าง) ต้องใช้ปุ่มใดร่วมกับแป้นลบ 
ก. Alt   ข. Ctrl   ค. Shift   ง. Tab 

15. เครื่องหมาย * (ดอกจัน) ใช้แทนการคำนวณแบบใด 
ก. บวก   ข. ลบ   ค. คูณ   ง. หาร 

16. การพิมพ์เครื่องหมาย * ต้องกดแป้นใดร่วมกัน 
ก. Shift + 7  ข. Shift + 8  ค. Ctrl + 8  ง. Alt + 8 

17. เครื่องหมาย / (ทับ)** ใช้แทนการคำนวณแบบใด 
ก. ลบ   ข. คูณ   ค. หาร   ง. บวก 

18. เครื่องหมาย / (ทับ)** อยู่บริเวณใดของแป้นพิมพ์ภาษาอังกฤษ 
ก. ใต้แป้น Enter    ข. ขวาของแป้น . (จุด) 
ค. ซ้ายของแป้น Shift   ง. เหนือแป้น Tab 

19. ถ้าต้องการพิมพ์เครื่องหมาย + - * / อย่างถูกต้อง ควรทำอย่างไร 
ก. ใช้นิ้วก้อยขวาทั้งหมด   ข. มองแป้นพิมพ์ทุกครั้ง 
ค. ใช้นิ้วที่ถูกต้องตามตำแหน่งและกด Shift เมื่อจำเป็น 
ง. ใช้นิ้วเดียวพิมพ์ทุกแป้น 

20. การฝึกพิมพ์สัญลักษณ์เหล่านี้บ่อย ๆ ช่วยให้เกิดผลดีอย่างไร 
ก. พิมพ์ได้เร็วและแม่นยำขึ้น  ข. ใช้นิ้วได้เหนื่อยมากข้ึน 
ค. ต้องพิมพ์ช้าลง   ง. ต้องมองแป้นทุกครั้ง 
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1.ข     2.ข  3  .ค   4.ค   5.ค   6.ข   7.ค   8.ข   9.ค   10.ก 

 
เฉลยสัปดาห์ที่ 7 

สัปดาห์ที่ 7  คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. เครื่องหมาย - (ขีดกลาง) พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม - โดยไม่ต้องกด Shift ข. Shift + -   ค. Alt + -   ง. Ctrl + - 
2. เครื่องหมาย _ (ขีดล่าง) พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม - โดยไม่ต้องกด Shift  ข. Shift + -   ค. Alt + -   ง. Shift + = 
3. การพิมพ์วงเล็บเปิด ( ใช้แป้นใด? 
    ก. Shift + 7   ข. Shift + 8   ค. Shift + 9   ง. Shift + 0 
4. การพิมพ์วงเล็บปิด ) ใช้แป้นใด? 
    ก. Shift + 7   ข. Shift + 8   ค. Shift + 9   ง. Shift + 0 
5. สัญลักษณ ์& พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 5   ข. Shift + 6   ค. Shift + 7   ง. Shift + 8 
6. เครื่องหมาย * (ดอกจัน) พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 6   ข. Shift + 7   ค. Shift + 8   ง. Shift + 9 
7. สัญลักษณ์ % พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 3   ข. Shift + 4   ค. Shift + 5   ง. Shift + 6 
8. เครื่องหมาย # พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 2   ข. Shift + 3   ค. Shift + 4   ง. Shift + 5 
9. เครื่องหมาย @ พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 1   ข. Shift + 2   ค. Shift + 3   ง. Shift + 4 
10. สัญลักษณ์ ! พิมพ์โดยใช้แป้นใด? 
    ก. Shift + 1   ข. Shift + 2   ค. Shift + 3   ง. Shift + 4 
เฉลย 
1. ก 2. ข 3. ค 4. ง 5. ค 6. ค 7. ค 8. ข 9.ข  10.ก 

 
เฉลยสัปดาห์ที่ 8 

สัปดาห์ที่ 8   คำสั่ง  จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. เครื่องหมาย < พิมพ์โดยใช้แป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /   ง. Shift + ; 
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2. เครื่องหมาย > พิมพ์โดยใช้แป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /   ง. Shift + ; 
3. เครื่องหมาย ? พิมพ์โดยใช้แป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /   ง. Shift + ; 
4. เครื่องหมาย { พิมพ์โดยใช้แป้นใด? 
    ก. Shift + [   ข. Shift + ]   ค. Shift + {   ง. Shift + } 
5. เครื่องหมาย } พิมพ์โดยใช้แป้นใด? 
    ก. Shift + [   ข. Shift + ]    ค. Shift + {   ง. Shift + } 
6. เครื่องหมาย [ พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม [ โดยไม่ต้องกด Shift  ข. Shift + [   ค. Alt + [   ง. Ctrl + [ 
7. เครื่องหมาย ] พิมพ์โดยใช้แป้นใด? 
    ก. ปุ่ม ] โดยไม่ต้องกด Shift  ข. Shift + ]   ค. Alt + ]   ง. Ctrl + ] 
8. เครื่องหมาย <> ใช้ในการพิมพ์อย่างไร? 
    ก. Shift + , และ Shift + .    ข. Shift + / และ Shift + \  
    ค. Shift + [ และ Shift + ]    ง. Shift + ; และ Shift + ' 
9. เครื่องหมาย ? ใช้ในการพิมพ์ประโยคคำถาม ต้องกดแป้นใด? 
    ก. Shift + ,   ข. Shift + .   ค. Shift + /    ง. Shift + ' 
10. การพิมพ์ { } ต้องกดแป้นใดร่วมกับ Shift? 
    ก. [ และ ]   ข. { และ }   ค. ( และ )    ง. < และ > 
เฉลย 
1. ก 2. ข 3. ค 4. ก 5. ข 6. ก 7. ก 8. ก 9. ค 10. ก 
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 ใบกิจกรรมที่ 2 หน่วยที่   2   
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  2 - 8  
ชื่อหน่วยการเรียนรู้   งานพิมพ์ตัวอักษรภาษาอังกฤษ ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานพิมพ์ตัวอักษรภาษาอังกฤษ ปฏิบัติ    28   ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาการพิมพ์ดีดภาษาอังกฤษ ที่ประกอบไปด้วยการวางนิ้ว การสืบนิ้ว การยกแคร่ แป้นอักษร
แป้นวรรณยุกต์ แป้นสระในภาษาอังกฤษ และแป้นตัวเลข แป้นสัญลักษณ์พิเศษ การพิมพ์ตัวพิมพ์ใหญ่ 
พิมพ์เล็ก 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 แสดงการฝึกพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ ได้ถูกต้องและรวดเร็ว 
2.พิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
3.มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 

4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 

4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
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      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
5.1 หนังสือเรียน 

 5.2 ใบความรู้/ใบงาน 
 5.3 คอมพิวเตอร์(โปรแกรม Microsoft Word) 

5.4 TV 
6. ข้ันตอนการทำกิจกรรม 
   6.1.ผู้สอนแจกใบความรู้ และใบงานให้ผู้เรียน บอกข้อตกลงในการทำใบงาน 

6.2 .ผู้เรียนศึกษารายละเอียดของใบงานที่ครูผู้สอนแจกให้ 
  6.3.ผู้เรียนเปิดโปรแกรม Microsoft Word สร้างเอกสารใหม่ 
 6.4.ผู้เรียนทำงานตามใบงานที่มอบให้ 
 6.5.ผู้เรียนสอบถามข้อสงสัยกรณีไม่เข้าใจใบงาน 
 6.6.ผู้เรียนทำใบงานเสร็จแล้วให้บันทึกลงคอมพิวเตอร์แล้วส่งงานในไลน์กลุ่ม 
7. สรุปและอภิปราย  

7.1 ครูและนักเรียน ช่วยกันสรุปเนื้อหา และเสนอแนะการแก้ไขข้อบกพร่อง 
8.  สรุปและวิจารณ์ผล  

8.1 .ครูผู้สอนตรวจสอบการส่งงาน ว่าผู้สอนส่งงานครบทุกคนหรือไม่ 
9. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม 

9.1   หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ 
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 ใบงานที่ 2 หน่วยที่   2 
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  2 - 8  
ชื่อหน่วยการเรียนรู้   งานพิมพ์ตัวอักษรภาษาอังกฤษ ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานพิมพ์ตัวอักษรภาษาอังกฤษ ปฏิบัติ    28   ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาการพิมพ์ดีดภาษาอังกฤษ ที่ประกอบไปด้วยการวางนิ้ว การสืบนิ้ว การยกแคร่ แป้นอักษร
แป้นวรรณยุกต์ แป้นสระในภาษาอังกฤษ และแป้นตัวเลข แป้นสัญลักษณ์พิเศษ การพิมพ์ตัวพิมพ์ใหญ่ 
พิมพ์เล็ก 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า 
อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2.คิดค่ารวมและบันทึกรายงานความก้าวหน้าในการพิมพ์ได้ 
3.มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 

4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 

4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
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      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้ 
 5.3 ใบงาน 
6. คำแนะนำ/ข้อควรระวัง  

6.1 ปฏิบัติงานด้วยความละเอียดรอบคอบ   
7. ข้ันตอนการปฏิบัติงาน 

ชื่อเรื่อง งานพิมพ์ตัวอักษรภาษาอังกฤษ 
  สัปดาห์ละ 180 นาที จำนวน 7 สัปดาห์ 

 จุดประสงค์   
1. เพ่ือฝึกพิมพ์อังกฤษดิจิทัลในโปรแกรม Microsoft Word  
2. สามารถพิมพ์ระบบสัมผัสได้ถูกต้อง 
3.ผู้เรียนจำตัวอักษรอังกฤษบนแป้นพิมพ์ได้ทุกตัวอักษร 

 วัสดุอุปกรณ์   
1. คอมพิวเตอร์  
2. สื่อการสอน TV  

 ขั้นตอนการดำเนินงาน 
1.ผู้สอนแจกใบความรู้ และใบงานให้ผู้เรียน บอกข้อตกลงในการทำใบงาน 
2 .ผู้เรียนศึกษารายละเอียดของใบงานที่ครูผู้สอนแจกให้ 

   3.ผู้เรียนเปิดโปรแกรม Microsoft Word สร้างเอกสารใหม่ 
  4.ผู้เรียนทำงานตามใบงานที่มอบให้ 
  5.ผู้เรียนสอบถามข้อสงสัยกรณีไม่เข้าใจใบงาน 
  6.ผู้เรียนทำใบงานเสร็จแล้วให้บันทึกลงคอมพิวเตอร์แล้วส่งงานในไลน์กลุ่ม 
8.  สรุปและวิจารณ์ผล  

8.1ครูและนักเรียนร่วมกันสรุปเนื้อหา 
8.2ครูผู้สอนตรวจสอบการส่งงาน ว่าผู้สอนส่งงานครบทุกคนหรือไม่ 

9. การประเมินผล  
9.1 ผ่านเกณฑ์การประเมินผลไม่ต่ำกว่าร้อยละ 60 

10. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม  
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10.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ 
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 แผนการจัดการเรียนรู้ 3 หน่วยที ่   3 
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สอนครั้งที่ 9 - 13 
ชื่อหน่วยการเรียนรู้   งานพิมพ์งานเอกสาร ทฤษฎี  0  ชม. 

ปฏิบัติ  20  ชม. ชื่อเรื่อง/งาน   งานพิมพ์งานเอกสาร  
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 พัฒนา และจดจำตำแหน่งแป้นอักษร ตัวพิมพ์ใหญ่ ตัวพิมพ์เล็ก และเครื่องหมายต่าง ๆ บน
แป้นพิมพ์ภาษาอังกฤษ สามารถพิมพ์คำศัพท์ภาษาอังกฤษได้ถูกต้องตามแบบ สามารถพิมพ์ประโยค
ภาษาอังกฤษได้อย่างถูกต้อง มีการเว้นวรรคและใช้ตัวพิมพ์ใหญ่–เล็กได้ถูกต้อง และเข้าใจการใช้โปรแกรม
พิมพ์งานด้วย Microsoft Word ในการจัดรูปแบบข้อความได้ถูกต้อง 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2 มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 
3. .คิดค่ารวมและบันทึกรายงานความก้าวหน้าในการพิมพ์ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
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4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. สาระการเรียนรู้ 
1. พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2. มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 
3.  ปฏิบัติตามกฎ ระเบียบ ข้อบังคับและข้อตกลงต่าง ๆ ในการเรียนวิชาพิมพ์อังกฤษดิจิทัลได้ 
4.   บูรณาการคุณธรรม จริยธรรม ด้านความสนใจ ใฝ่รู้ ความซื่อสัตย์ ความรับผิดชอบ ความประหยัด 

ความอดทน 
6. กิจกรรมการเรียนรู้     
สัปดาห์ที่ 9    
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์ผสมคำ เพื่อความแม่นยำใน
การเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนเน้นความถูกต้องของตัวอักษร การเว้นวรรค 
และการใช้นิ้วที่เหมาะสม 
ขั้นสอน 
1.ผู้สอนแจกใบงานท่ี 9 
2.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัติการพิมพ์ตามใบงานที่กำหนดให้ 
3. ผู้สอนบอกวิธีการ และข้อตกลงในการทำใบงาน  
4. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

1. ผู้เรียนศึกษารับใบงานที่ผู้สอนกำหนดให้ และ
ซักถามข้อข้องใจ 
2. ผู้เรียนฝึกก้าวนิ้วแป้นอักษรเพ่ือความแม่นยำ
ในการพิมพ์ ตามใบที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 9 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 9 เสร็จแลว้บันทึกงาน พร้อม
นำส่งทางกลุ่มไลน์ 
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สัปดาห์ที่  10 
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์เป็นประโยค เพ่ือความแม่นยำ
ในการเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนเน้นความถูกต้องของตัวอักษร การเว้นวรรค 
และการใช้นิ้วที่เหมาะสม 
ขั้นสอน 
1.ผู้สอนแจกใบงานท่ี 10 
2.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัติการพิมพ์ตามใบงานที่กำหนดให้ 
3. ผู้สอนบอกวิธีการ และข้อตกลงในการทำใบงาน  
4. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

1. ผู้เรียนศึกษารับใบงานที่ผู้สอนกำหนดให้ และ
ซักถามข้อข้องใจ 
2. ผู้เรียนฝึกก้าวนิ้วแป้นอักษรเพื่อความแม่นยำ
ในการพิมพ์ ตามใบที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 10 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 10 เสร็จแล้วบันทึกงาน พร้อม
นำส่งทางกลุ่มไลน์ 

 
สัปดาห์ที่  11-13 
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการฝึกหัดพิมพ์จดหมายธุรกิจในการเรียน
พิมพ์อังกฤษดิจิทัล 
2.ผ ู ้สอนเน ้นความถ ูกต ้องของต ัวอ ักษร และ
แบบฟอร์มที่กำหนดให้ การเว้นวรรค และการใช้นิ้ว
ที่เหมาะสม 
ขั้นสอน 

1. ผู้เรียนศึกษารับใบงานที่ผู้สอนกำหนดให้ และ
ซักถามข้อข้องใจ 
2. ผู้เรียนฝึกก้าวนิ้วแป้นอักษรเพื่อความแม่นยำ
ในการพิมพ์ ตามใบที่กำหนดให้  
3. ผู้เรียนทำใบงานที่ 11-13 
4. ผู้เรียนสอบถามปัญหาที่เกิดขึ้นระหว่างทำใบ
งาน 
 5.ผู้เรียนปฏิบัติที่ 11-13 เสร็จแล้วบันทึกงาน 
พร้อมนำส่งทางกลุ่มไลน์ 
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1.ผู้สอนแจกใบงานท่ี 11-13 
2.ผ ู ้สอนให ้ผ ู ้ เร ียนใช ้งานโปรแกรม MS Word  
ประกอบการปฏิบัติการพิมพ์จดหมายธุรกิจ ตามใบ
งานที่กำหนดให้ 
3. ผู้สอนบอกวิธีการ และข้อตกลงในการทำใบงาน  
4. ให้ผู้เรียนนำส่งงงานที่ทำเสร็จแล้วในกลุ่มไลน์ที่
สร้างไว้ โดยให้แปลงเป็นไฟล์ PDF แลบันทึกเป็นชื่อ
ของตัวผู้เรียน  
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ     
 2. ผู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

 
7. สื่อและแหล่งการเรียนรู้ 

1.   หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์  
      ส่งเสริมวชิาการ 
2.    ใบความรู้/ใบกิจกรรม     
3     กิจกรรมการเรียนการสอน 
4     เครื่องคอมพิวเตอร์ และ TV  

8. หลักฐานการเรียนรู้ 
   8.1 หลักฐานความรู้          
 - ใบความรู้ 
    - ใบกืจกรรม 
 - ใบงาน 
8.2 หลักฐานการปฏิบัติงาน          

-ภาพการปฏิบัติงาน การฝึกฝนทักษะบันทึกในแบบบันทึกหลังการสอนออนไลน์  
9. การวัดและประเมินผล 

9.1 เกณฑ์การปฏิบัติงาน 
1.    แบบสังเกตพฤติกรรมรายบุคคล เกณฑ์ผ่าน  50%  ขึ้นไป 
2.    แบบทดสอบหลังเรียน เกณฑ์ผ่าน  60%  ขึ้นไป 
3.    ชิ้นงาน 70 % ขึ้นไป 
9.2  วิธีการประเมิน 

- สังเกตพฤติกรรมการปฏิบัติงาน  
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- การจับเวลา 

- การตวจชิ้นงาน 
9.3 เครื่องมือประเมิน 

- แบบประเมิน/แบบฟอร์มบนทึกความก้าวหน้า 

- แบบประเมินเชิงปริมาณ 
10. บันทึกผลหลังการจัดการเรียนรู้ 

- เอกสารการบันทึกหลังการสอนในระบบออนไลน์ 
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ใว ใบความรู้ที่ 3 หน่วยที่   3   
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  9 - 13  
ชื่อหน่วยการเรียนรู้   งานพิมพ์งานเอกสาร ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานพิมพ์งานเอกสาร ปฏิบัติ    20    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 พัฒนา และจดจำตำแหน่งแป้นอักษร ตัวพิมพ์ใหญ่ ตัวพิมพ์เล็ก และเครื่องหมายต่าง ๆ บน
แป้นพิมพ์ภาษาอังกฤษ สามารถพิมพ์คำศัพท์ภาษาอังกฤษได้ถูกต้องตามแบบ สามารถพิมพ์ประโยค
ภาษาอังกฤษได้อย่างถูกต้อง มีการเว้นวรรคและใช้ตัวพิมพ์ใหญ่–เล็กได้ถูกต้อง และเข้าใจการใช้โปรแกรม
พิมพ์งานด้วย Microsoft Word ในการจัดรูปแบบข้อความได้ถูกต้อง 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2 มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 
3. .คิดค่ารวมและบันทึกรายงานความก้าวหน้าในการพิมพ์ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
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4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เนื้อหาสาระ   
5.1   การพิมพ์ข้อความภาษาอังกฤษ 
วิธีการพิมพ์ข้อความภาษาอังกฤษ 

1. เตรียมความพร้อมก่อนพิมพ์ 
1. ตรวจสอบภาษาแป้นพิมพ์ ให้เป็นภาษาอังกฤษ (EN) 
2. นั่งตัวตรง หลังไม่งอ เท้าวางราบกับพ้ืน 
3. มองตรงหน้าจอ ไม่ก้มมองแป้นพิมพ์ 
4. วางมือในตำแหน่งแป้นเหย้า (Home Row Keys) 

o มือซ้ายวางที่แป้น A S D F 
o มือขวาวางที่แป้น J K L ; 
o นิ้วโป้งข้างใดข้างหนึ่งวางที่ Space bar 

 
2. วิธีการพิมพ์ข้อความ 

1. เปิดโปรแกรมพิมพ์ เช่น Microsoft Word 
2. คลิกเมาส์ในตำแหน่งที่ต้องการเริ่มพิมพ์ 
3. พิมพ์ตัวอักษรโดยใช้ ระบบพิมพ์สัมผัส — ไม่มองแป้น 
4. ใช้นิ้วตามตำแหน่งที่ถูกต้อง เช่น 

o นิ้วชี้ซ้าย: R, T, F, G 
o นิ้วชี้ขวา: Y, H, J, N, M 
o นิ้วกลางซ้าย: D, E 
o นิ้วกลางขวา: K, I 
o นิ้วนางซ้าย: S, W 
o นิ้วนางขวา: L, O 

5. ใช้ ปุ่มพิเศษ ให้ถูกต้อง 
o Space bar: เว้นวรรค 1 ครั้งหลังแต่ละคำ 
o Shift: พิมพ์ตัวอักษรใหญ่ (เช่น “A”) 
o Enter: ขึ้นบรรทัดใหม่ 
o Backspace: ลบตัวอักษรที่พิมพ์ผิด 
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3. ตัวอย่างข้อความภาษาอังกฤษสั้น ๆ สำหรับฝึกพิมพ์ 

1. I like typing.   
2. My name is John.   
3. Typing is fun.   
4. I can type fast.   
5. This is my computer.   
6. Practice makes perfect.   
7. I study digital typing.   

 
4. เคล็ดลับการพิมพ์ให้เร็วและถูกต้อง 

• ฝึกพิมพ์ทุกวัน วันละ 10–15 นาท ี
• เริ่มจากคำง่าย ๆ ก่อน แล้วค่อยพิมพ์เป็นประโยค 
• มองหน้าจอ ไม่มองแป้นพิมพ์ 
• ตรวจสอบการสะกดคำก่อนบันทึกงาน 

 
5. สรุป 
การพิมพ์ข้อความภาษาอังกฤษอย่างถูกต้อง ต้องอาศัยท่าทางที่ดี 
การวางนิ้วที่ถูกตำแหน่ง และการฝึกฝนอย่างสม่ำเสมอ 
เพ่ือให้พิมพ์ได้ เร็ว แม่นยำ และมีประสิทธิภาพ 

 
 6.ตัวอย่างใบงานการพิมพ์ผสมคำ 
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5.2 การพิมพ์ประโยคภาษาอังกฤษ 

1.วิธีการพิมพ์ข้อความภาษาอังกฤษ 
1. เตรียมความพร้อมก่อนพิมพ์ 
5. ตรวจสอบภาษาแป้นพิมพ์ ให้เป็นภาษาอังกฤษ (EN) 
6. นั่งตัวตรง หลังไม่งอ เท้าวางราบกับพ้ืน 
7. มองตรงหน้าจอ ไม่ก้มมองแป้นพิมพ์ 
8. วางมือในตำแหน่งแป้นเหย้า (Home Row Keys) 

o มือซ้ายวางที่แป้น A S D F 
o มือขวาวางที่แป้น J K L ; 
o นิ้วโป้งข้างใดข้างหนึ่งวางที่ Space bar  

 
2. วิธีการพิมพ์ประโยค 

1. เปิดโปรแกรมพิมพ์ เช่น Microsoft Word 
2. คลิกเมาส์ในตำแหน่งที่ต้องการเริ่มพิมพ์ 
3. พิมพ์ตัวอักษรโดยใช้ ระบบพิมพ์สัมผัส — ไม่มองแป้น 
4. ใช้นิ้วตามตำแหน่งที่ถูกต้อง เช่น 

1. นิ้วชี้ซ้าย: R, T, F, G 
2. นิ้วชี้ขวา: Y, H, J, N, M 
3. นิ้วกลางซ้าย: D, E 
4. นิ้วกลางขวา: K, I 
5. นิ้วนางซ้าย: S, W 
6. นิ้วนางขวา: L, O 

5.ใช้ปุ่มพิเศษ ให้ถูกต้อง 
1. Space bar: เว้นวรรค 1 ครั้งหลังแต่ละคำ 
2. Shift: พิมพ์ตัวอักษรใหญ่ (เช่น “A”) 
3. Enter: ขึ้นบรรทัดใหม ่
4. Backspace: ลบตัวอักษรที่พิมพ์ผิด 

 
3. ตัวอย่างประโยคภาษาอังกฤษสั้น ๆ สำหรับฝึกพิมพ์ 

1. I like learning English every day. 
2. She types very fast and accurately. 
3. We are practicing keyboard skills in class. 
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4. Typing helps improve our computer skills. 
5. Please save your work before closing the program. 
6. Good posture is important when typing. 
7. My teacher gives us typing exercises every week. 
8. Practice makes perfect in typing. 
9. Always check your spelling after typing. 
10. I can type faster now than before. 

 
4. เคล็ดลับการพิมพ์ให้เร็วและถูกต้อง 

• ฝึกพิมพ์ทุกวัน วันละ 10–15 นาท ี
• เริ่มจากคำง่าย ๆ ก่อน แล้วค่อยพิมพ์เป็นประโยค 
• มองหน้าจอ ไม่มองแป้นพิมพ์ 
• ตรวจสอบการสะกดคำก่อนบันทึกงาน 

 
5. สรุป 

การพิมพ์ข้อความภาษาอังกฤษอย่างถูกต้อง ต้องอาศัยท่าทางที่ดี 
การวางนิ้วที่ถูกตำแหน่ง และการฝึกฝนอย่างสม่ำเสมอ 
เพ่ือให้พิมพ์ได้ เร็ว แม่นยำ และมีประสิทธิภาพ 

 
6. ตัวอย่างใบงาน 

เรื่อง : การฝึกพิมพ์ประโยคภาษาอังกฤษ 
รายวิชา : พิมพ์อังกฤษดิจิทัล 
ระดับชั้น : ปวช.1 
ชื่อ......................................................... รหสันักศึกษา............................... 
แผนกวิชา.................................................. วันที่............................................ 

 
 

 
ให้พิมพ์ประโยคภาษาอังกฤษต่อไปนี้ให้ถูกต้องและสวยงาม 
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5.3   การพิมพ์จดหมายุรกิจ 
ความหมายของจดหมายธุรกิจ (Business Letter) 

จดหมายธุรกิจ คือ จดหมายที่ใช้ติดต่อสื่อสารในเรื่องทางธุรกิจ เช่น การสั่งซื้อสินค้า การสมัครงาน 
การขอข้อมูล หรือการติดต่อระหว่างบริษัท โดยมีรูปแบบที่เป็นทางการและใช้ภาษาสุภาพ 
 
ประเภทของจดหมายธุรกิจ 

1. Letter of Inquiry – จดหมายสอบถามข้อมูล 
2. Letter of Order – จดหมายสั่งซื้อสินค้า 
3. Letter of Complaint – จดหมายร้องเรียน 
4. Letter of Application – จดหมายสมัครงาน 
5. Letter of Acknowledgment – จดหมายตอบรับ 
6. Letter of Thank You – จดหมายขอบคุณ 

 
 ส่วนประกอบของจดหมายธุรกิจภาษาอังกฤษ 

1. Sender’s Address – ที่อยู่ของผู้ส่ง 
2. Date – วันที่เขียนจดหมาย 
3. Inside Address – ที่อยู่ของผู้รับ 
4. Salutation – คำข้ึนต้น เช่น Dear Sir / Madam, 
5. Body of the Letter – เนื้อความของจดหมาย 
6. Closing – คำลงท้าย เช่น Yours sincerely, / Yours faithfully, 
7. Signature – ลายเซ็นชื่อผู้เขียน 

 
หลักการพิมพ์จดหมายธุรกิจ 

1. ใช้ฟอนต์มาตรฐาน เช่น Times New Roman หรือ Arial, ขนาด 12 pt 
2. พิมพ์อย่างเป็นระเบียบ โดยจัดหน้าแบบ Block Style (ชิดซ้ายทั้งหมด) 
3. ตรวจสอบการสะกดคำ และการเว้นบรรทัดให้ถูกต้อง 
4. ใช้ภาษาสุภาพและเหมาะสมกับเนื้อหา 
5. พิมพ์ให้เรียบร้อยและอ่านง่าย 

 
ตัวอย่างจดหมายธุรกิจภาษาอังกฤษ 

1. Letter of Inquiry – จดหมายสอบถามข้อมูล 
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Sender / Company Name: ............................................................... 
Sender’s Address: ....................................................................................... 
Date: ........../........../.......... 

Recipient / Company Name: ....................................................................................... 
Recipient’s Address: ....................................................................................... 

Salutation: ............................................................... (e.g., Dear Sir / Madam) 

 
Body of the Letter 

Dear ......................................................, 

We / Our company ...................................................... (introduce yourself or your company) 
are interested in ...................................................... (specify the product or service) 

Please send ...................................................... (request catalog, price list, or additional 
details) 
and also provide information about ...................................................... (e.g., delivery 
schedules, warranty conditions) 

We look forward to your prompt reply. 

 

Closing: ...................................................... (e.g., Yours faithfully,) 
Signature: ...................................................... 
Position / Title: ...................................................... 

2.Letter of Order – จดหมายสั่งซื้อสินค้า 

Sender / Company Name: ............................................................... 
Sender’s Address: .......................................................................................  
Date: ........../........../.......... 
Recipient / Company Name: .......................................................................................  
Recipient’s Address: .......................................................................................  
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Salutation: ............................................................... (e.g., Dear Sir / Madam) 

 
Body of the Letter / เนื้อความ 
Dear ......................................................, 
We / Our company ...................................................... (introduce yourself or your 
company) 
would like to place an order for the following items: 

Item Description Quantity Unit Price Total Price 

    

    

    

Please confirm the delivery schedule and payment terms. 
We look forward to receiving the products as soon as possible. 

 
Closing: ...................................................... (e.g., Yours faithfully,) 
Signature: ...................................................... 
Position / Title: ...................................................... 

 
3.Letter of Complaint – จดหมายร้องเรียน 

Letter of Complaint Form 
Sender / Company Name: ............................................................... 
Sender’s Address: .......................................................................................  
Date: ........../........../.......... 
Recipient / Company Name: .......................................................................................  
Recipient’s Address: .......................................................................................  
Salutation: ............................................................... (e.g., Dear Sir / Madam) 

 
Body of the Letter / เนื้อความ 
Dear ......................................................, 
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I / Our company ...................................................... (introduce yourself or your company) 
am writing to express my dissatisfaction regarding ...................................................... 
(describe the product/service problem) 
The issues encountered are as follows: 
1. ........................................................................ 
2. ........................................................................ 
3. ........................................................................ 
I request that you ...................................................... (state your desired solution, e.g., 
replacement, refund, or repair) 
and provide a response as soon as possible. 
We hope that this matter will be resolved promptly. 

 
Closing: ...................................................... (e.g., Yours faithfully,) 
Signature: ...................................................... 
Position / Title: ...................................................... 

 
4.Letter of Application – จดหมายสมัครงาน 

Applicant Name: ...............................................................  
Address: .......................................................................................  
Date: ........../........../.......... 

Recipient / Hiring Manager: .......................................................................................  
Company Name: .......................................................................................  
Company Address: .......................................................................................  

Salutation: ............................................................... (e.g., Dear Hiring Manager,) 
 
Body of the Letter / เนื้อความ 
Dear ......................................................, 
I am writing to apply for the position of ...................................................... (job title) 
advertised on ...................................................... (source of job posting, e.g., website, 

newspaper) 
I have ...................................................... (briefly describe your qualifications, education, 

and experience) 



77 
 

and I believe I am suitable for this position because ...................................................... 
(state reasons) 

Attached are my ...................................................... (resume, certificates, or other 
supporting documents) for your review. 

I would appreciate the opportunity to discuss my application further in an 
interview. 

Thank you for your consideration. 
 
Closing: ...................................................... (e.g., Yours sincerely,) 
Signature: ...................................................... 
Position / Title (if applicable): ..................................................... 

 
5.Letter of Acknowledgment – จดหมายตอบรับ Letter of Acknowledgment Form 

Sender / Company Name: ............................................................... 
Sender’s Address: .......................................................................................  
Date: ........../........../.......... 
Recipient / Company Name: .......................................................................................  
Recipient’s Address: .......................................................................................  
Salutation: ............................................................... (e.g., Dear Sir / Madam) 
Body of the Letter / เนื้อความ 
Dear ......................................................, 
We acknowledge receipt of your ...................................................... (e.g., order, 
application, payment) 
dated ...................................................... (specify date if applicable). 
We appreciate your ...................................................... (e.g., order, inquiry, submission) 
and will process it as soon as possible. 
Should you have any questions, please do not hesitate to contact us. 
Thank you for your continued trust and cooperation. 
 
Closing: ...................................................... (e.g., Yours faithfully,) 
Signature: ...................................................... 
Position / Title: ...................................................... 
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6.Letter of Thank You – จดหมายขอบคุณ 

Sender / Your Name: ............................................................... 
Sender’s Address: .......................................................................................  
Date: ........../........../.......... 
Recipient / Company or Person Name: .......................................................................................  
Recipient’s Address: .......................................................................................  
Salutation: ............................................................... (e.g., Dear Mr. / Ms. / Sir / Madam) 

 
Body of the Letter / เนื้อความ 
Dear ......................................................, 
I would like to express my sincere thanks for ...................................................... (reason for 
gratitude, e.g., your assistance, support, or hospitality) 
Your ...................................................... (e.g., help, guidance, service) is greatly 
appreciated, and it has ...................................................... (state the impact, e.g., helped 
me complete a task, made a meeting successful) 
Thank you once again for your ...................................................... (kindness, support, or 
generosity) 
 
Closing: ...................................................... (e.g., Yours sincerely,) 
Signature: ...................................................... 
Position / Title (if applicable): ...................................................... 

 
6.แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 9 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. การพิมพ์สัมผัส (Touch Typing) คืออะไร? 
ก. การพิมพ์โดยใช้สายตาช่วยมองแป้นตลอดเวลา 
ข. การพิมพ์โดยไม่มองแป้นพิมพ์ ใช้นิ้วมือวางตามตำแหน่งหลัก 
ค. การพิมพ์โดยใช้มือข้างเดียว 
ง. การพิมพ์โดยไม่สนใจความถูกต้อง 
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2. การเว้นวรรคในภาษาอังกฤษที่ถูกต้องหลังคำแต่ละคำคือ? 
ก. 1 space (เว้นวรรค 1 ช่อง)   ข. 2 spaces (เว้นวรรค 2 ช่อง) 
ค. ไม่ต้องเว้นวรรค    ง. เว้นวรรคตามใจชอบ 
3. ตัวอักษรแรกของประโยคภาษาอังกฤษควรเป็นตัวอักษรแบบใด? 
ก. ตัวพิมพ์เล็ก (lowercase)   ข. ตัวพิมพ์ใหญ่ (uppercase) 
ค. ตัวเอียง (italic)    ง. ตัวหนา (bold) 
4. ปุ่มใดใช้สำหรับพิมพ์ตัวอักษรใหญ่ชั่วคราว? 
ก. Ctrl   ข. Shift   ค. Alt   ง. Caps Lock 
คำตอบ: ข 
5. การพิมพ์ตัวเลขหรือสัญลักษณ์พิเศษส่วนใหญ่ใช้ปุ่มใดร่วมกับ Shift? 
ก. ปุ่มตัวอักษร  ข. ปุ่มตัวเลขด้านบนของแป้น ค. ปุ่ม Enter ง. ปุ่ม Space 
6. ข้อใดคือประโยชน์ของการพิมพ์สัมผัส? 
ก. พิมพ์ช้าลงแต่แม่นยำ   ข. พิมพ์เร็วขึ้นและแม่นยำ 
ค. ลดความจำของตัวอักษร  ง. ต้องมองแป้นพิมพ์ตลอดเวลา 
7. เมื่อพิมพ์ประโยคเสร็จควรทำอย่างไร? 
ก. กด Enter เพ่ือขึ้นบรรทัดใหม่   ข. ลบทุกตัวอักษรก่อน 
ค. กด Space ซ้ำ 5 ครั้ง    ง. ปิดคอมพิวเตอร์ทันที 
8. การจัดวางมือในการพิมพ์สัมผัสถูกต้องคือ? 
ก. นิ้ววางบน home row (แถวกลางของแป้นพิมพ์) 
ข. นิ้ววางกระจัดกระจายตามใจชอบ 
ค. ใช้นิ้วเดียวพิมพ์ทั้งหมด 
ง. ใช้แต่มือขวาพิมพ์ 
9. ข้อใดไม่ใช่ลักษณะของจดหมายธุรกิจที่ถูกต้อง? 
ก. ใช้ภาษาเป็นทางการ    ข. ใช้รูปแบบ Block Style ชดิซ้ายทั้งหมด 
ค. ใช้คำสแลงหรือคำไม่สุภาพ   ง. พิมพ์เรียบร้อยและอ่านง่าย 
10. เมื่อพิมพ์เอกสารภาษาอังกฤษเสร็จสิ้น ควรตรวจสอบสิ่งใด? 
ก. การสะกดคำ การเว้นวรรค และเครื่องหมายวรรคตอน 
ข. การจัดรูปแบบตัวอักษรและหน้ากระดาษ 
ค. ความถูกต้องของเนื้อหา 
ง. ถูกทุกข้อข้างต้น 

สัปดาห์ที่ 10 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
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1. ประโยคภาษาอังกฤษแต่ละประโยคควรขึ้นต้นด้วยตัวอักษรแบบใด? 
ก. ตัวพิมพ์เล็ก (lowercase)   ข. ตัวพิมพ์ใหญ่ (uppercase) 
ค. ตัวเอียง (italic)    ง. ตัวหนา (bold) 
2. เครื่องหมายใดใช้จบประโยคบอกเล่า? 
ก. ,   ข. .   ค. !   ง. ? 
3. หลังคำแต่ละคำในประโยคควรเว้นวรรคกี่ช่อง? 
ก. 1 space  ข. 2 spaces  ค. ไม่เว้นวรรค  ง. เว้นตามใจ 
4. การเว้นวรรคและการใช้ตัวอักษรใหญ่ถูกต้องมีประโยชน์อย่างไร? 
ก. ทำให้ข้อความอ่านง่ายและถูกต้อง  ข. ทำให้ข้อความสวยงามแต่ผิดไวยากรณ์ 
ค. ทำให้พิมพ์ช้าลง    ง. ไม่มีประโยชน์ 
5. การพิมพ์ประโยคแบบสัมผัส (Touch Typing) คืออะไร? 
ก. พิมพ์โดยไม่มองแป้นพิมพ์   ข. พิมพ์โดยใช้มือเดียว 
ค. พิมพ์โดยมองแป้นพิมพ์ตลอดเวลา  ง. พิมพ์โดยใช้แป้นตัวเลขเท่านั้น 
6. ประโยคภาษาอังกฤษควรมีอะไรบ้าง? 
ก. คำเริ่มต้น ตัวอักษรใหญ่ เครื่องหมายจบประโยค ข. ตัวอักษรเล็กทั้งหมดและเว้นวรรคไม่จำกัด 
ค. ไม่มีเครื่องหมายจบประโยค   ง. พิมพ์รวมคำทั้งหมด 
7. ปุ่มใดใช้สำหรับพิมพ์ตัวอักษรใหญ่ชั่วคราวในประโยค? 
ก. Ctrl   ข. Shift   ค. Alt   ง. Caps Lock 
8. หลังพิมพ์ประโยคเสร็จควรทำอย่างไร? 
ก. กด Enter ขึ้นบรรทัดใหม่   ข. ลบทุกตัวอักษรก่อน 
ค. กด Space ซ้ำหลายครั้ง   ง. ปิดคอมพิวเตอร์ทันที 
9. ข้อใดเป็นข้อผิดพลาดในการพิมพ์ประโยค? 
ก. พิมพ์คำแรกของประโยคเป็นตัวพิมพ์เล็ก  ข. เว้นวรรค 1 space หลังคำ 
ค. ใช้เครื่องหมายจบประโยคถูกต้อง  ง. วางมือบน home row ในการพิมพ์ 
10. การตรวจสอบประโยคหลังพิมพ์เสร็จควรตรวจสิ่งใด? 
ก. การสะกดคำ     ข. การเว้นวรรคและเครื่องหมายวรรคตอน 
ค. ความถูกต้องของเนื้อหา   ง. ถูกทุกข้อข้างต้น 

สัปดาห์ที่ 11 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. จดหมายธุรกิจภาษาอังกฤษควรใช้ภาษาแบบใด? 
ก. ภาษาเป็นทางการ (Formal)   ข. ภาษาไม่เป็นทางการ 
ค. ใช้คำสแลง     ง. ใช้ภาษาพูดทั่วไป 
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2. รูปแบบที่นิยมใช้ในการจัดหน้าจดหมายธุรกิจคือ? 
ก. Block Style (ชิดซ้ายทั้งหมด)   ข. Modified Block Style 
ค. Centered Style    ง. Shaded Style 
3. ส่วนใดของจดหมายระบุชื่อและที่อยู่ของผู้ส่ง? 
ก. Inside Address    ข. Sender’s Address 
ค. Salutation     ง. Closing 
4. คำข้ึนต้นจดหมายธุรกิจที่ถูกต้องคือ? 
ก. Dear Sir / Madam,    ข. Hi, 
ค. Hello,     ง. Hey! 
5. ส่วนใดของจดหมายใช้เขียนเนื้อความหรือวัตถุประสงค์ของจดหมาย? 
ก. Sender’s Address    ข. Inside Address 
ค. Body of the Letter    ง. Closing 
6. คำลงท้ายจดหมายธุรกิจแบบสุภาพควรใช้คำใด? 
ก. Yours faithfully,    ข. Bye, 
ค. Cheers,     ง. See you, 
7. หลังจากพิมพ์เนื้อความจดหมายเสร็จแล้ว ควรทำอะไร? 
ก. ตรวจสอบการสะกดคำและเครื่องหมายวรรคตอน    ข. พิมพ์ตัวอักษรซ้ำอีกครั้ง 
ค. เว้นวรรคหลายบรรทัด    ง. ส่งจดหมายทันทีโดยไม่ตรวจ 
8. การพิมพ์จดหมายธุรกิจสัมผัส (Touch Typing) มีประโยชน์อะไร? 
ก. พิมพ์ช้าลงแต่แม่นยำ    ข. พิมพ์เร็วขึ้นและแม่นยำ 
ค. ไม่ต้องสนใจความถูกต้อง   ง. ต้องมองแป้นพิมพ์ตลอดเวลา 
9. Inside Address ในจดหมายธุรกิจหมายถึงอะไร? 
ก. ที่อยู่ผู้ส่ง     ข. ที่อยู่ผู้รับ 
ค. เนื้อความของจดหมาย    ง. คำลงท้าย 
10. การจัดรูปแบบจดหมายธุรกิจควรตรวจสอบสิ่งใดก่อนส่ง? 
ก. ความเรียบร้อยของเอกสารและการจัดหน้า ข. การสะกดคำและเครื่องหมายวรรคตอน 
ค. ความถูกต้องของข้อมูล    ง. ถูกทุกข้อข้างต้น 

สัปดาห์ที่ 12 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1  จดหมายสอบถามข้อมูล (Letter of Inquiry) มีวัตถุประสงค์เพ่ืออะไร 
ก. เพื่อขอข้อมูลหรือรายละเอียดเพิ่มเติมเก่ียวกับสินค้าและบริการ 
ข. เพ่ือร้องเรียนสินค้า 
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ค. เพ่ือสมัครงาน 
ง. เพ่ือแสดงความขอบคุณ 
2  ข้อใดกล่าวถูกต้องเกี่ยวกับ Letter of Inquiry 
ก. เขียนก่อนการสั่งซื้อสินค้า   ข. เขียนหลังจากได้รับสินค้าแล้ว 
ค. เขียนเพ่ือยืนยันการชำระเงิน   ง. เขียนเพ่ือขอใบเสร็จ 
3  ประโยคใดเหมาะสมในจดหมายสอบถามข้อมูล 
ก. Could you please send me your latest price list? 
ข. We would like to place an order. 
ค. We are sorry to complain about your service. 
ง. Thank you for your payment. 
4  ในจดหมายสอบถามข้อมูลควรมีเนื้อหาเกี่ยวกับอะไร 
ก. รายละเอียดของสินค้าท่ีต้องการทราบเพ่ิมเติม  ข. การแจ้งยกเลิกการสั่งซื้อ 
ค. การชำระเงิน      ง. การขอคืนสินค้า 
5  จดหมายสั่งซื้อสินค้า (Letter of Order) มีวัตถุประสงค์เพ่ืออะไร 
ก. เพื่อสั่งซื้อสินค้าหรือบริการอย่างเป็นทางการ  ข. เพ่ือสอบถามราคาเบื้องต้น 
ค. เพ่ือแจ้งชำระเงิน     ง. เพ่ือขอใบเสนอราคา 
6  ข้อใดควรปรากฏอยู่ในจดหมายสั่งซื้อสินค้า 
ก. รายการสินค้า จำนวน ราคา และวันที่ต้องการรับสินค้า 
ข. ข้อมูลบริษัทของคู่ค้าเท่านั้น 
ค. รายชื่อพนักงานจัดส่งสินค้า 
ง. ที่อยู่ของลูกค้าอย่างเดียว 
7  ประโยคใดเหมาะสมในจดหมายสั่งซื้อสินค้า 
ก. We would like to order 100 sets of your product code A-101. 
ข. Could you please send your catalog? 
ค. We are sorry for the delay. 
ง. Please confirm the payment. 
8  การเขียนจดหมายสั่งซื้อสินค้าควรใช้ภาษาลักษณะใด 
ก. สุภาพ ชัดเจน และเป็นทางการ    ข. ภาษาพูดทั่วไป 
ค. ใช้อีโมจิและคำย่อ     ง. เขียนสั้นๆ ไม่ต้องมีส่วนหัวจดหมาย 
9  ในตอนท้ายของจดหมายสั่งซื้อ มักแสดงถึงอะไร 
ก. ความคาดหวังว่าจะได้รับสินค้าตามกำหนดเวลา  ข. การปฏิเสธการสั่งซื้อ 
ค. การร้องเรียนคุณภาพสินค้า    ง. การสอบถามข้อมูลทั่วไป 
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10  ข้อใดเป็นความแตกต่างหลักระหว่างจดหมายสอบถามข้อมูลและจดหมายสั่งซื้อสินค้า 
ก. Letter of Inquiry ใช้ถามข้อมูล ส่วน Letter of Order ใช้สั่งซื้อสินค้า 
ข. Letter of Inquiry ใช้ร้องเรียน ส่วน Letter of Order ใช้สมัครงาน 
ค. Letter of Inquiry ใช้แจ้งชำระเงิน ส่วน Letter of Order ใช้สอบถามราคา 
ง. ทั้งสองแบบมีวัตถุประสงค์เหมือนกัน 

สัปดาห์ที่ 13 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. จดหมายร้องเรียน (Letter of Complaint) มีวัตถุประสงค์เพ่ืออะไร 
ก. แจ้งปัญหาหรือความไม่พอใจเกี่ยวกับสินค้า/บริการ ข. ขอข้อมูลเพ่ิมเติม 
ค. สมัครงานในบริษัท    ง. ตอบรับคำเชิญ 

2. ข้อใดเป็นข้อความที่มักปรากฏในจดหมายร้องเรียน 
ก. We regret to inform you that the goods arrived damaged. 
ข. We would like to order 50 items. 
ค. Thank you for your kind invitation. 
ง. Please find my resume attached. 

3. จดหมายสมัครงาน (Letter of Application) มักแนบเอกสารใดมาด้วย 
ก. Resume หรือประวัติย่อ   ข. ใบสั่งซื้อสินค้า 
ค. ใบแจ้งหนี้     ง. ใบรับรองสินค้า 

4. ข้อใดเป็นประโยคที่เหมาะสมในจดหมายสมัครงาน 
ก. I am writing to apply for the position of Sales Assistant. 
ข. I am writing to complain about your delivery. 
ค. Please send me your price list. 
ง. We hope to receive your reply soon. 

5. จดหมายตอบรับ (Letter of Acceptance / Reply) ใช้เพื่อ ______ 
ก. ตอบกลับการติดต่อหรือตอบรับข้อเสนอ  ข. สั่งซื้อสินค้า 
ค. แสดงความไม่พอใจ    ง. สมัครงาน 

6. ข้อใดเหมาะสมในจดหมายตอบรับ 
ก. We are pleased to confirm your appointment on June 1. 
ข. Could you send me more details? 
ค. We are disappointed with your product. 
ง. Please find the attached catalog. 
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7. Letter of Appreciation คือจดหมายประเภทใด 
ก. จดหมายแสดงความขอบคุณ   ข. จดหมายสั่งซื้อสินค้า 
ค. จดหมายตอบข้อร้องเรียน   ง. จดหมายแจ้งปัญหา 

8. ข้อใดเป็นประโยคที่เหมาะสมในจดหมายขอบคุณ (Thank-you Letter) 
ก. We would like to express our sincere thanks for your cooperation. 
ข. We are sorry for the late delivery. 
ค. We would like to order your products. 
ง. Please send me your job application form. 

9. ลักษณะภาษาท่ีใช้ในจดหมายธุรกิจทุกประเภทควรเป็นแบบใด 
ก. สุภาพ กระชับ และเป็นทางการ   ข. ใช้คำย่อและอีโมจิ 
ค. ใช้ภาษาพูดไม่เป็นทางการ   ง. ใช้คำอุทานและสัญลักษณ์ตกแต่ง 

10. ความแตกต่างระหว่างจดหมายร้องเรียนกับจดหมายขอบคุณคืออะไร 
ก. จดหมายร้องเรียนใช้แสดงความไม่พอใจ ส่วนจดหมายขอบคุณใช้แสดงความชื่นชม 
ข. ทั้งสองใช้เพ่ือสมัครงาน 
ค. ทั้งสองใช้เพ่ือสั่งสินค้า 
ง. ทั้งสองมีวัตถุประสงค์เหมือนกัน 

7.       เอกสารอ้างอิง 
7.1 .    หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์

ส่งเสริมวิชาการ 

8.     ภาคผนวก  (เฉลยแบบทดสอบ) 
สัปดาห์ที่ 9 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. การพิมพ์สัมผัส (Touch Typing) คืออะไร? 
ก. การพิมพ์โดยใช้สายตาช่วยมองแป้นตลอดเวลา 
ข. การพิมพ์โดยไม่มองแป้นพิมพ์ ใช้นิ้วมือวางตามตำแหน่งหลัก 
ค. การพิมพ์โดยใช้มือข้างเดียว 
ง. การพิมพ์โดยไม่สนใจความถูกต้อง 
2. การเว้นวรรคในภาษาอังกฤษที่ถูกต้องหลังคำแต่ละคำคือ? 
ก. 1 space (เว้นวรรค 1 ช่อง)   ข. 2 spaces (เว้นวรรค 2 ช่อง) 
ค. ไม่ต้องเว้นวรรค    ง. เว้นวรรคตามใจชอบ 
3. ตัวอักษรแรกของประโยคภาษาอังกฤษควรเป็นตัวอักษรแบบใด? 
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ก. ตัวพิมพ์เล็ก (lowercase)   ข. ตัวพิมพ์ใหญ่ (uppercase) 
ค. ตัวเอียง (italic)    ง. ตัวหนา (bold) 
4. ปุ่มใดใช้สำหรับพิมพ์ตัวอักษรใหญ่ชั่วคราว? 
ก. Ctrl   ข. Shift   ค. Alt   ง. Caps Lock 
5. การพิมพ์ตัวเลขหรือสัญลักษณ์พิเศษส่วนใหญ่ใช้ปุ่มใดร่วมกับ Shift? 
ก. ปุ่มตัวอักษร  ข. ปุ่มตัวเลขด้านบนของแป้น ค. ปุ่ม Enter ง. ปุ่ม Space 
6. ข้อใดคือประโยชน์ของการพิมพ์สัมผัส? 
ก. พิมพ์ช้าลงแต่แม่นยำ   ข. พิมพ์เร็วขึ้นและแม่นยำ 
ค. ลดความจำของตัวอักษร  ง. ต้องมองแป้นพิมพ์ตลอดเวลา 
7. เมื่อพิมพ์ประโยคเสร็จควรทำอย่างไร? 
ก. กด Enter เพ่ือขึ้นบรรทัดใหม่   ข. ลบทุกตัวอักษรก่อน 
ค. กด Space ซ้ำ 5 ครั้ง    ง. ปิดคอมพิวเตอร์ทันที 
8. การจัดวางมือในการพิมพ์สัมผัสถูกต้องคือ? 
ก. นิ้ววางบน home row (แถวกลางของแป้นพิมพ์) 
ข. นิ้ววางกระจัดกระจายตามใจชอบ 
ค. ใช้นิ้วเดียวพิมพ์ทั้งหมด 
ง. ใช้แต่มือขวาพิมพ์ 
9. ข้อใดไม่ใช่ลักษณะของจดหมายธุรกิจที่ถูกต้อง? 
ก. ใช้ภาษาเป็นทางการ    ข. ใช้รูปแบบ Block Style ชดิซ้ายทั้งหมด 
ค. ใช้คำสแลงหรือคำไม่สุภาพ   ง. พิมพ์เรียบร้อยและอ่านง่าย 
10. เมื่อพิมพ์เอกสารภาษาอังกฤษเสร็จสิ้น ควรตรวจสอบสิ่งใด? 
ก. การสะกดคำ การเว้นวรรค และเครื่องหมายวรรคตอน 
ข. การจัดรูปแบบตัวอักษรและหน้ากระดาษ 
ค. ความถูกต้องของเนื้อหา 
ง. ถูกทุกข้อข้างต้น 
เฉลย 1.ข   2.ก   3.ข   4.ข   5.ข   6.ข   7.ก   8.ก   9.ค   10.ง 
 

สัปดาห์ที่ 10 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. ประโยคภาษาอังกฤษแต่ละประโยคควรขึ้นต้นด้วยตัวอักษรแบบใด? 
ก. ตัวพิมพ์เล็ก (lowercase)   ข. ตัวพิมพ์ใหญ่ (uppercase) 
ค. ตัวเอียง (italic)    ง. ตัวหนา (bold) 
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2. เครื่องหมายใดใช้จบประโยคบอกเล่า? 
ก. ,   ข. .   ค. !   ง. ? 
3. หลังคำแต่ละคำในประโยคควรเว้นวรรคกี่ช่อง? 
ก. 1 space  ข. 2 spaces  ค. ไม่เว้นวรรค  ง. เว้นตามใจ 
4. การเว้นวรรคและการใช้ตัวอักษรใหญ่ถูกต้องมีประโยชน์อย่างไร? 
ก. ทำให้ข้อความอ่านง่ายและถูกต้อง  ข. ทำให้ข้อความสวยงามแต่ผิดไวยากรณ์ 
ค. ทำให้พิมพ์ช้าลง    ง. ไม่มีประโยชน์ 
5. การพิมพ์ประโยคแบบสัมผัส (Touch Typing) คืออะไร? 
ก. พิมพ์โดยไม่มองแป้นพิมพ์   ข. พิมพ์โดยใช้มือเดียว 
ค. พิมพ์โดยมองแป้นพิมพ์ตลอดเวลา  ง. พิมพ์โดยใช้แป้นตัวเลขเท่านั้น 
6. ประโยคภาษาอังกฤษควรมีอะไรบ้าง? 
ก. คำเริ่มต้น ตัวอักษรใหญ่ เครื่องหมายจบประโยค ข. ตัวอักษรเล็กทั้งหมดและเว้นวรรคไม่จำกัด 
ค. ไม่มีเครื่องหมายจบประโยค   ง. พิมพ์รวมคำทั้งหมด 
7. ปุ่มใดใช้สำหรับพิมพ์ตัวอักษรใหญ่ชั่วคราวในประโยค? 
ก. Ctrl   ข. Shift   ค. Alt   ง. Caps Lock 
8. หลังพิมพ์ประโยคเสร็จควรทำอย่างไร? 
ก. กด Enter ขึ้นบรรทัดใหม่   ข. ลบทุกตัวอักษรก่อน 
ค. กด Space ซ้ำหลายครั้ง   ง. ปิดคอมพิวเตอร์ทันที 
9. ข้อใดเป็นข้อผิดพลาดในการพิมพ์ประโยค? 
ก. พิมพ์คำแรกของประโยคเป็นตัวพิมพ์เล็ก  ข. เว้นวรรค 1 space หลังคำ 
ค. ใช้เครื่องหมายจบประโยคถูกต้อง  ง. วางมือบน home row ในการพิมพ์ 
10. การตรวจสอบประโยคหลังพิมพ์เสร็จควรตรวจสิ่งใด? 
ก. การสะกดคำ     ข. การเว้นวรรคและเครื่องหมายวรรคตอน 
ค. ความถูกต้องของเนื้อหา   ง. ถูกทุกข้อข้างต้น 
เฉลย  1.ข   2.ข   3.ก   4.ก   5.ก   6.ก   7.ข   8.ก   9.ก   10.ง 

สัปดาห์ที่ 11 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. จดหมายธุรกิจภาษาอังกฤษควรใช้ภาษาแบบใด? 
ก. ภาษาเป็นทางการ (Formal)   ข. ภาษาไม่เป็นทางการ 
ค. ใช้คำสแลง     ง. ใช้ภาษาพูดทั่วไป 
2. รูปแบบที่นิยมใช้ในการจัดหน้าจดหมายธุรกิจคือ? 
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ก. Block Style (ชิดซ้ายทั้งหมด)   ข. Modified Block Style 
ค. Centered Style    ง. Shaded Style 
3. ส่วนใดของจดหมายระบุชื่อและที่อยู่ของผู้ส่ง? 
ก. Inside Address    ข. Sender’s Address 
ค. Salutation     ง. Closing 
4. คำข้ึนต้นจดหมายธุรกิจที่ถูกต้องคือ? 
ก. Dear Sir / Madam,    ข. Hi, 
ค. Hello,     ง. Hey! 
5. ส่วนใดของจดหมายใช้เขียนเนื้อความหรือวัตถุประสงค์ของจดหมาย? 
ก. Sender’s Address    ข. Inside Address 
ค. Body of the Letter    ง. Closing 
6. คำลงท้ายจดหมายธุรกิจแบบสุภาพควรใช้คำใด? 
ก. Yours faithfully,    ข. Bye, 
ค. Cheers,     ง. See you, 
7. หลังจากพิมพ์เนื้อความจดหมายเสร็จแล้ว ควรทำอะไร? 
ก. ตรวจสอบการสะกดคำและเครื่องหมายวรรคตอน    ข. พิมพ์ตัวอักษรซ้ำอีกครั้ง 
ค. เว้นวรรคหลายบรรทัด    ง. ส่งจดหมายทันทีโดยไม่ตรวจ 
8. การพิมพ์จดหมายธุรกิจสัมผัส (Touch Typing) มีประโยชน์อะไร? 
ก. พิมพ์ช้าลงแต่แม่นยำ    ข. พิมพ์เร็วขึ้นและแม่นยำ 
ค. ไม่ต้องสนใจความถูกต้อง   ง. ต้องมองแป้นพิมพ์ตลอดเวลา 
9. Inside Address ในจดหมายธุรกิจหมายถึงอะไร? 
ก. ที่อยู่ผู้ส่ง     ข. ที่อยู่ผู้รับ 
ค. เนื้อความของจดหมาย    ง. คำลงท้าย 
10. การจัดรูปแบบจดหมายธุรกิจควรตรวจสอบสิ่งใดก่อนส่ง? 
ก. ความเรียบร้อยของเอกสารและการจัดหน้า ข. การสะกดคำและเครื่องหมายวรรคตอน 
ค. ความถูกต้องของข้อมูล    ง. ถูกทุกข้อข้างต้น 
เฉลย  1.ก   2.ก   3.ข   4.ก   5.ค   6.ก   7.ก   8.ข   9.ข   10.ง 
 

สัปดาห์ที่ 12 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1  จดหมายสอบถามข้อมูล (Letter of Inquiry) มีวัตถุประสงค์เพ่ืออะไร 
ก. เพื่อขอข้อมูลหรือรายละเอียดเพิ่มเติมเก่ียวกับสินค้าและบริการ 
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ข. เพ่ือร้องเรียนสินค้า 
ค. เพ่ือสมัครงาน 
ง. เพ่ือแสดงความขอบคุณ 
2  ข้อใดกล่าวถูกต้องเกี่ยวกับ Letter of Inquiry 
ก. เขียนก่อนการสั่งซื้อสินค้า   ข. เขียนหลังจากได้รับสินค้าแล้ว 
ค. เขียนเพ่ือยืนยันการชำระเงิน   ง. เขียนเพ่ือขอใบเสร็จ 
3  ประโยคใดเหมาะสมในจดหมายสอบถามข้อมูล 
ก. Could you please send me your latest price list? 
ข. We would like to place an order. 
ค. We are sorry to complain about your service. 
ง. Thank you for your payment. 
4  ในจดหมายสอบถามข้อมูลควรมีเนื้อหาเกี่ยวกับอะไร 
ก. รายละเอียดของสินค้าท่ีต้องการทราบเพ่ิมเติม  ข. การแจ้งยกเลิกการสั่งซื้อ 
ค. การชำระเงิน      ง. การขอคืนสินค้า 
5  จดหมายสั่งซื้อสินค้า (Letter of Order) มีวัตถุประสงค์เพ่ืออะไร 
ก. เพื่อสั่งซื้อสินค้าหรือบริการอย่างเป็นทางการ  ข. เพ่ือสอบถามราคาเบื้องต้น 
ค. เพ่ือแจ้งชำระเงิน     ง. เพ่ือขอใบเสนอราคา 
6  ข้อใดควรปรากฏอยู่ในจดหมายสั่งซื้อสินค้า 
ก. รายการสินค้า จำนวน ราคา และวันที่ต้องการรับสินค้า 
ข. ข้อมูลบริษัทของคู่ค้าเท่านั้น 
ค. รายชื่อพนักงานจัดส่งสินค้า 
ง. ที่อยู่ของลูกค้าอย่างเดียว 
7  ประโยคใดเหมาะสมในจดหมายสั่งซื้อสินค้า 
ก. We would like to order 100 sets of your product code A-101. 
ข. Could you please send your catalog? 
ค. We are sorry for the delay. 
ง. Please confirm the payment. 
8  การเขียนจดหมายสั่งซื้อสินค้าควรใช้ภาษาลักษณะใด 
ก. สุภาพ ชัดเจน และเป็นทางการ    ข. ภาษาพูดทั่วไป 
ค. ใช้อีโมจิและคำย่อ     ง. เขียนสั้นๆ ไม่ต้องมีส่วนหัวจดหมาย 
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9  ในตอนท้ายของจดหมายสั่งซื้อ มักแสดงถึงอะไร 
ก. ความคาดหวังว่าจะได้รับสินค้าตามกำหนดเวลา  ข. การปฏิเสธการสั่งซื้อ 
ค. การร้องเรียนคุณภาพสินค้า    ง. การสอบถามข้อมูลทั่วไป 
10  ข้อใดเป็นความแตกต่างหลักระหว่างจดหมายสอบถามข้อมูลและจดหมายสั่งซื้อสินค้า 
ก. Letter of Inquiry ใช้ถามข้อมูล ส่วน Letter of Order ใช้สั่งซื้อสินค้า 
ข. Letter of Inquiry ใช้ร้องเรียน ส่วน Letter of Order ใช้สมัครงาน 
ค. Letter of Inquiry ใช้แจ้งชำระเงิน ส่วน Letter of Order ใช้สอบถามราคา 
ง. ทั้งสองแบบมีวัตถุประสงค์เหมือนกัน 

 เฉลย    1.ก   2.ก   3.ก   4.ก   5.ก   6.ก  7.ก  8.ก  9.ก   10.ก 
สัปดาห์ที่ 13 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. จดหมายร้องเรียน (Letter of Complaint) มีวัตถุประสงค์เพ่ืออะไร 
ก. แจ้งปัญหาหรือความไม่พอใจเกี่ยวกับสินค้า/บริการ ข. ขอข้อมูลเพ่ิมเติม 
ค. สมัครงานในบริษัท    ง. ตอบรับคำเชิญ 

2. ข้อใดเป็นข้อความที่มักปรากฏในจดหมายร้องเรียน 
ก. We regret to inform you that the goods arrived damaged. 
ข. We would like to order 50 items. 
ค. Thank you for your kind invitation. 
ง. Please find my resume attached. 

3. จดหมายสมัครงาน (Letter of Application) มักแนบเอกสารใดมาด้วย 
ก. Resume หรือประวัติย่อ   ข. ใบสั่งซื้อสินค้า 
ค. ใบแจ้งหนี้     ง. ใบรับรองสินค้า 

4. ข้อใดเป็นประโยคที่เหมาะสมในจดหมายสมัครงาน 
ก. I am writing to apply for the position of Sales Assistant. 
ข. I am writing to complain about your delivery. 
ค. Please send me your price list. 
ง. We hope to receive your reply soon. 

5. จดหมายตอบรับ (Letter of Acceptance / Reply) ใช้เพื่อ ______ 
ก. ตอบกลับการติดต่อหรือตอบรับข้อเสนอ  ข. สั่งซื้อสินค้า 
ค. แสดงความไม่พอใจ    ง. สมัครงาน 

6. ข้อใดเหมาะสมในจดหมายตอบรับ 
ก. We are pleased to confirm your appointment on June 1. 
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ข. Could you send me more details? 
ค. We are disappointed with your product. 
ง. Please find the attached catalog. 

7. Letter of Appreciation คือจดหมายประเภทใด 
ก. จดหมายแสดงความขอบคุณ   ข. จดหมายสั่งซื้อสินค้า 
ค. จดหมายตอบข้อร้องเรียน   ง. จดหมายแจ้งปัญหา 

8. ข้อใดเป็นประโยคที่เหมาะสมในจดหมายขอบคุณ (Thank-you Letter) 
ก. We would like to express our sincere thanks for your cooperation. 
ข. We are sorry for the late delivery. 
ค. We would like to order your products. 
ง. Please send me your job application form. 

9. ลักษณะภาษาท่ีใช้ในจดหมายธุรกิจทุกประเภทควรเป็นแบบใด 
ก. สุภาพ กระชับ และเป็นทางการ   ข. ใช้คำย่อและอีโมจิ 
ค. ใช้ภาษาพูดไม่เป็นทางการ   ง. ใช้คำอุทานและสัญลักษณ์ตกแต่ง 

10. ความแตกต่างระหว่างจดหมายร้องเรียนกับจดหมายขอบคุณคืออะไร 
ก. จดหมายร้องเรียนใช้แสดงความไม่พอใจ ส่วนจดหมายขอบคุณใช้แสดงความชื่นชม 
ข. ทั้งสองใช้เพ่ือสมัครงาน 
ค. ทั้งสองใช้เพ่ือสั่งสินค้า 
ง. ทั้งสองมีวัตถุประสงค์เหมือนกัน 

เฉลย    1.ก   2.ก   3.ก   4.ก   5.ก   6.ก  7.ก  8.ก  9.ก   10.ก 
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 ใบกิจกรรมที่ 3 หน่วยที่   3   
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  9 - 13   
ชื่อหน่วยการเรียนรู้   งานพิมพ์งานเอกสาร ทฤษฎี   0     ชั่วโมง 

ชื่อเรื่อง      งานพิมพ์งานเอกสาร ปฏิบัติ    20  ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 พัฒนา และจดจำตำแหน่งแป้นอักษร ตัวพิมพ์ใหญ่ ตัวพิมพ์เล็ก และเครื่องหมายต่าง ๆ บน
แป้นพิมพ์ภาษาอังกฤษ สามารถพิมพ์คำศัพท์ภาษาอังกฤษได้ถูกต้องตามแบบ สามารถพิมพ์ประโยค
ภาษาอังกฤษได้อย่างถูกต้อง มีการเว้นวรรคและใช้ตัวพิมพ์ใหญ่–เล็กได้ถูกต้อง และเข้าใจการใช้โปรแกรม
พิมพ์งานด้วย Microsoft Word ในการจัดรูปแบบข้อความได้ถูกต้อง 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2 มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 
3. .คิดค่ารวมและบันทึกรายงานความก้าวหน้าในการพิมพ์ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
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4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้/ใบงาน 
 5.3 คอมพิวเตอร์(โปรแกรม Microsoft Word) 

5.4 TV 
6. ข้ันตอนการทำกิจกรรม 
1. การเตรียมความพร้อมก่อนการเรียนการสอน 

1. ครูเตรียมสื่อการสอน เช่น แบบฝึกหัด ตัวอย่างข้อความ ประโยค และจดหมายธุรกิจ 
2. จัดเตรียมคอมพิวเตอร์พร้อมโปรแกรม Microsoft Word หรือ Google Docs 
3. ตรวจสอบแป้นพิมพ์และอุปกรณ์ให้พร้อมใช้งาน 
4. อธิบายวัตถุประสงค์การเรียนรู้ให้ชัดเจน เช่น 

o ฝึกพิมพ์ข้อความและประโยคภาษาอังกฤษให้ถูกต้อง 
o เข้าใจรูปแบบและส่วนประกอบของจดหมายธุรกิจ 

2. การฝึกพิมพ์ข้อความสั้น ๆ (Short Text) 
1. ครูมอบใบงานข้อความสั้น ๆ เช่น คำศัพท์ หรือประโยคสั้น 
2. นักเรียนฝึกพิมพ์ข้อความโดยใช้ เทคนิคการพิมพ์สัมผัส (Touch Typing) 
3. ครูสังเกตและประเมินความเร็วและความถูกต้อง 
4. ให้นักเรียนตรวจสอบตัวสะกดและเครื่องหมายวรรคตอน 

3. การฝึกพิมพ์ประโยค (Sentence Typing) 
1. ครูมอบตัวอย่างประโยค เช่น ประโยคบอกเล่า คำถาม หรือประโยคเชิงธุรกิจ 
2. นักเรียนฝึกพิมพ์ตามตัวอย่าง โดยเน้น 

o ตัวอักษรใหญ่ที่จุดเริ่มต้นของประโยค 
o เว้นวรรคหลังคำ 
o การใช้เครื่องหมายจบประโยคถูกต้อง 

3. ประเมินผลความถูกต้อง ความเรียบร้อย และความเร็วในการพิมพ์ 
4. การฝึกพิมพ์จดหมายธุรกิจ (Business Letter Typing) 

1. ครูอธิบาย ส่วนประกอบของจดหมายธุรกิจ 
o Sender’s Address, Date, Inside Address, Salutation, Body, Closing, Signature 
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2. นักเรียนเลือกประเภทจดหมาย เช่น 
o Letter of Inquiry (สอบถามข้อมูล) 
o Letter of Order (สั่งซื้อสินค้า) 
o Letter of Complaint (ร้องเรียน) 
o Letter of Application (สมัครงาน) 
o Letter of Acknowledgment (ตอบรับ) 
o Letter of Thank You (ขอบคุณ) 

3. นักเรียนพิมพ์จดหมายตามแบบฟอร์มที่ครูมอบให้ ในไลน์กลุ่มห้องเรียน 
4. ครูตรวจสอบความถูกต้องของเนื้อหา การจัดหน้า และความเรียบร้อย และให้คะแนน 

7. สรุปและอภิปราย  
7.1 ครูและนักเรียน ช่วยกันสรุปเนื้อหา 

8.  สรุปและวิจารณ์ผล  
8.1 ครผูู้สอนติดตามผู้เรียนให้ส่งงานให้ครบทุกคน 

9. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม 
9.1 .  หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม

วิชาการ 
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 ใบงานที่ 3 หน่วยที่   3   
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  9 - 13   
ชื่อหน่วยการเรียนรู้   งานพิมพ์งานเอกสาร ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานพิมพ์งานเอกสาร ปฏิบัติ    20    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 พัฒนา และจดจำตำแหน่งแป้นอักษร ตัวพิมพ์ใหญ่ ตัวพิมพ์เล็ก และเครื่องหมายต่าง ๆ บน
แป้นพิมพ์ภาษาอังกฤษ สามารถพิมพ์คำศัพท์ภาษาอังกฤษได้ถูกต้องตามแบบ สามารถพิมพ์ประโยค
ภาษาอังกฤษได้อย่างถูกต้อง มีการเว้นวรรคและใช้ตัวพิมพ์ใหญ่–เล็กได้ถูกต้อง และเข้าใจการใช้โปรแกรม
พิมพ์งานด้วย Microsoft Word ในการจัดรูปแบบข้อความได้ถูกต้อง 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 มีทักษะในการพิมพ์สัมผัสตามหลักเกณฑ์การพิมพ์ 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. วางนิ้วบนแป้นเหย้าและพิมพ์อักษรบนแป้นเหย้าได้ถูกต้อง 
2. ใช้นิ้วโป้งทั้งด้านซ้ายและขวาเคาะเว้นวรรคได้ถูกต้อง 
3. สืบนิ้วจากอักษรแป้นเหย้าไปพิมพ์แป้นอักษรแถวบน และล่างได้อย่างถูกต้องและรวดเร็ว 
4.  กดแป้น Shift พิมพ์แป้นอักษรบนและกดแป้น Enter ขึ้นบรรทัดใหม่ได้อย่างถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1.พิมพ์ผสมคำง่าย ๆ และพิมพ์ประโยคสั้น ๆ ได้ถูกต้องและรวดเร็ว 
2 มีทักษะในการพิมพ์เพ่ือพัฒนาความเร็วและความแม่นยำ 
3. .คิดค่ารวมและบันทึกรายงานความก้าวหน้าในการพิมพ์ได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
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4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้/ใบงาน 
 5.3 คอมพิวเตอร์ 
 5.4 TV 
6. คำแนะนำ/ข้อควรระวัง  

6.1 ปฏิบัติงานด้วยความละเอียดรอบคอบ   
7. ข้ันตอนการปฏิบัติงาน 

ชื่อเรื่อง งานพิมพ์คำและประโยคภาษาอังกฤษ 
 เวลา 60 นาท ี

 จุดประสงค์   
1. พัฒนาการพิมพ์ให้แม่นยำ ถูกต้อง 
2. สามารถพิมพ์จดหมายธุรกิจต่างๆ ตามใบงานที่มอบหมายให้ได้อย่างถูกต้อง 

 วัสดุอุปกรณ์   
1. คอมพิวเตอร์(โปรแกรม Microsoft Word)  
2. TV 

 ขั้นตอนการดำเนินงาน 
1.ผู้สอนแจกใบความรู้ และใบงานให้ผู้เรียน บอกข้อตกลงในการทำใบงาน 
2 .ผู้เรียนศึกษารายละเอียดของใบงานที่ครูผู้สอนแจกให้ 

   3.ผู้เรียนเปิดโปรแกรม Microsoft Word สร้างเอกสารใหม่ 
  4.ผู้เรียนทำงานตามใบงานที่มอบให้ 
  5.ผู้เรียนสอบถามข้อสงสัยกรณีไม่เข้าใจใบงาน 
  6.ผู้เรียนทำใบงานเสร็จแล้วให้บันทึกลงคอมพิวเตอร์แล้วส่งงานในไลน์กลุ่ม 
8.  สรุปและวิจารณ์ผล  

8.1 ครูและนักเรียนร่วมกันสรุปเนื้อหน้า  
8.2 .ครูผู้สอนตรวจสอบการส่งงาน ว่าผู้สอนส่งงานครบทุกคนหรือไม่ 

9. การประเมินผล  
ผ่านเกณฑ์การประเมินผลไม่ต่ำกว่าร้อยละ 60 
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10. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม  

หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ 
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 แผนการจัดการเรียนรู้ที่ 4  หน่วยที ่   4 
รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สอนครั้งที่ 14 - 15 
ชื่อหน่วยการเรียนรู้   งานคิดคำสุทธิและการพิมพ์จับเวลาเพ่ือพัฒนา ทฤษฎี  0  ชม. 

ปฏิบัติ  8  ชม. ชื่อเรื่อง/งาน   งานคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนา  
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนาความแม่นยำในการปฏิบัติ
พิมพ์ภาษาอังกฤษ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  
    3.1  ฝึกพิมพ์ทบทวน และมีเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
    3.2  ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์อย่างไรไม่ให้ปวดเมื่อย 
    3.3   ฝึกพิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำ การคิดคำสุทธิ 
    3.4  บูรณาการคุณธรรม จริยธรรม ด้านความสนใจ ใฝ่รู้ ความซื่อสัตย์ ความรับผิดชอบ ความประหยัด 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
1. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
2. สร้างเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
3. ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์ไรไม่ให้ปวดเมื่อย 
4. คิดคำสุทธิได้ถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1. พิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำได้ 
2. คิดคำสุทธิได้ถูกต้อง 
3. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
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1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. สาระการเรียนรู้ 
5.1 นักศึกษาสามารถพิมพ์ข้อความได้รวดเร็วและแม่นยำขึ้น 

       5.2 นักศึกษามีทักษะในการพิมพ์แป้นอักษรแถวล่างและแถวบนได้คล่องแคล่วขึ้น 
        5.3 นักศึกษาสามารถตรวจคำผิดคิดอัตราคำสุทธิ/นาทีได้ถูกต้อง 

6. กิจกรรมการเรียนรู้     
สัปดาห์ที่  14.  
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพ่ือเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการพิมพ์จับเวลาเพื่อความแม่นยำ และเพ่ือ
หาคำสุทธิในการเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนเน้นความถูกต้องของการจัดท่านั่ง การ
วางมือ การตรวจสอบอุปกรณ์ก่อนปฏิบัติงาน  
ขั้นสอน 
1.ผู้สอนแจกใบความรู้เรื่องวิธีการคิดคำสุทธิ 
2.ผู้สอนอธิบายวิธีการตรวจหาคำผิด และวิธีการหา
คำสุทธิ 
3. ผู้สอนให้ผู้เรียนทดลองฝึกพิมพ์เพ่ือจับเวลาการ
พิมพ์ 2,3,4,5 10 นาที 
4.ผู้สอนมุ่งเน้นการสอนในเรื่องความซื่อสัตย์  
ขั้นสรุป 
1.  ผู้สอนพาผู้เรียนทำแบบทดสอบท้ายบทเรียน  
 2.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ 

1. ผู้เรียนรับทราบรายละเอียดของเนื้อหาวิชาใน
หน่วยนี้ เรื่องหลักการในการคิดคำนวณหรือ
จำนวนคำสุทธิ/นาที 
2. ผู้เรียนทดลองคำนวณคำสุทธิตามครูผู้สอน
อธิบาย พร้อมจดบันทึก 
3. ผู้เรียนร่วมแสดงความคิดเห็นเพิ่มเติม และ
ซักถาม ในสิ่งที่ไม่เข้าใจ 
5. ผู้เรียนทำแบบฝึกหัดท้ายหน่วย 
6. ผู้เรียนตรวจแบบทดสอบตามท่ีผู้สอนเฉลย 
7. ผู้เรียนบอกคะแนนแบบทดสอบ   
8. ผู้เรียนฟังและนำไปพัฒนาในบทเรียนต่อไป 
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สัปดาห์ที่ 15  
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพื่อเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการพิมพ์จับเวลาเพื่อความแม่นยำ และเพ่ือ
หาคำสุทธิในการเรียนพิมพ์อังกฤษดิจิทัล 
2.ผู้สอนเน้นความถูกต้องของตัวอักษร การเว้นวรรค 
และการใช้นิ้วที่เหมาะสม และความซื่อสัตย์ในการ
คิดคำสุทธิ 
ขั้นสอน 
1.ผู้สอนแจกใบงาน(เอกสารที่ใช้พิมพ์จับเวลา) 
2.ผู ้สอนอธิบายวิธ ีการปฏิบัต ิงานตามใบงานที่
กำหนดให้ เช่น ข้อตกลงในการพิมพ์ การเว้นวรรค 
การข้ึนบรรทัดใหม่  
2.ผู้สอนอธิบายวิธีการตรวจหาคำผิด และวิธีการหา
คำสุทธิอีกครั้ง 
3. ผู้สอนจับเวลาการพิมพ์ 2,3,4,5 10 นาที 
ขั้นสรุป 
1.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ  
 2.  ผู้สอนพาผู้เรียนทำแบบทดสอบท้ายบทเรียน 
 3. ผู้สอนบันทึกผลการปฏิบัติการพิมพ์ในช่วงเวลาที่
กำหนดให้ของผู้เรียน 

1. ผู้เรียนศึกษาใบงานที่ผู้สอนกำหนดให้ และ
ซักถามข้อข้องใจ 
2. ผู้เรียนฝึกพิมพ์จับเวลา 2,3,4,5,10 นาที 
3. ผู้เรียนตรวจหาคำผิด และวิธีการหาคำสุทธิ  
4. ผู้เรียนบันทึกจำนวนคำผิด คำสุทธิ ในตารางการ
พัฒนาทักษะการพิมพ์ 

 
7. สื่อและแหล่งการเรียนรู้ 

1.   หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์  
      ส่งเสริมวชิาการ 
2.    ใบความรู้/ใบกิจกรรม     
3     กิจกรรมการเรียนการสอน 
4     เครื่องคอมพิวเตอร์ และ TV  

8. หลักฐานการเรียนรู้ 
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   8.1 หลักฐานความรู้          

- ใบงาน  
 - ใบความรู้  
   8.2 หลักฐานการปฏิบัติงาน          
             -ภาพการปฏิบัติงาน การฝึกฝนทักษะบันทึกในแบบบันทึกหลังการสอนออนไลน์  
9. การวัดและประเมินผล 

9.1 เกณฑ์การปฏิบัติงาน 
- แบบสังเกตพฤติกรรมรายบุคคล เกณฑ์ผ่าน  50%  ขึ้นไป 

- ตารางเทียบคะแนนจากตารางการพัฒนาทักษะการพิมพ์ 
        9.2  วธิีการประเมิน 

- สังเกตพฤติกรรมการปฏิบัติงาน  

- ตรวจนับคะแนนจากใบงานที่กำหนด 

- การสังเกตและประเมินผลพฤติกรรมด้านคุณธรรม จริยธรรม ค่านิยม และคุณลักษณะอันพึง
ประสงค์ 

9.3 เครื่องมือประเมิน 

- แบบทดสอบแบบการเลือกตอบ  

- ตารางการพัฒนาทักษะการพิมพ์ 
10. บันทึกผลหลังการจัดการเรียนรู้ 
         10.1 เอกสารการบันทึกหลังการสอนในระบบออนไลน์ 
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ใว 
ใบความรู้ที่ 4 หน่วยที่   4   

รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  14-15  
ชื่อหน่วยการเรียนรู้   งานคิดคำสุทธิและการพิมพ์จับเวลาเพ่ือ
พัฒนา 

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนา ปฏิบัติ    8    ชัว่โมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนาความแม่นยำในการปฏิบัติ
พิมพ์ภาษาอังกฤษ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  
    3.1  ฝึกพิมพ์ทบทวน และมีเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
    3.2  ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์อย่างไรไม่ให้ปวดเมื่อย 
    3.3   ฝึกพิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำ การคิดคำสุทธิ 
    3.4  บูรณาการคุณธรรม จริยธรรม ด้านความสนใจ ใฝ่รู้ ความซื่อสัตย์ ความรับผิดชอบ ความประหยัด 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
5. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
6. สร้างเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
7. ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์ไรไม่ให้ปวดเมื่อย 
8. คิดคำสุทธิได้ถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
4. พิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำได้ 
5. คิดคำสุทธิได้ถูกต้อง 
6. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
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4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 

4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เนื้อหาสาระ   
หลักการในการคิดคำนวณหรือจำนวนคำสุทธิ/นาที 
1. เตรียมความพร้อมก่อนพิมพ์ 

• จัดท่านั่งให้ถูกต้องหลังตรง เท้าวางราบกับพ้ืน 
• วางนิ้วมือตามแป้นเหย้า (Home Row) อย่างถูกต้อง 
• ตรวจสอบคีย์บอร์ดให้พร้อมใช้งาน 
• ตั้งเวลาที่ต้องการพิมพ์ (เช่น 1 นาท,ี 3 นาท,ี 5 นาที) 

2. เริ่มพิมพ์ตามข้อความท่ีกำหนด 
• พิมพ์ข้อความตามที่ครูกำหนดหรือจากแบบฝึกหัด 
• พิมพ์ต่อเนื่องไม่หยุดกลางคัน 
• ไม่ควรลบหรือตรวจแก้ระหว่างพิมพ์ (เพ่ือให้จับเวลาจริง) 
• ใช้การพิมพ์สัมผัส ไม่มองแป้นพิมพ์ 

3. การจับเวลา 
• ใช้นาฬิกาจับเวลา หรือโปรแกรมจับเวลาในคอมพิวเตอร์ 
• เมื่อครบเวลาที่กำหนด ให้หยุดพิมพ์ทันที 
• นับจำนวนคำที่พิมพ์ได้ทั้งหมด 

4. การตรวจสอบและคำนวณผล 
• ตรวจสอบความถูกต้องของข้อความ 
• หักจำนวนคำที่พิมพ์ผิดออกจากจำนวนคำท้ังหมด 
• คำนวณคำสุทธิ/นาที ด้วยสูตร: 
คำสุทธิ/นาท=ี(จำนวนคำที่พิมพ์ได้ทั้งหมด−จำนวนคำผิด)เวลาที่ใช้ (นาที)\text{คำสุทธิ/นาที} = 

\frac{(\text{จำนวนคำที่พิมพ์ได้ทั้งหมด} - \text{จำนวนคำผิด})}{\text{เวลาที่ใช้ (นาที)}}คำสุทธิ/นาท=ี
เวลาที่ใช้ (นาท)ี(จำนวนคำที่พิมพ์ได้ทั้งหมด−จำนวนคำผิด)  
5. การประเมินและปรับปรุง 

• จดบันทึกผลคะแนนในแต่ละรอบ 
• วิเคราะห์ข้อผิดพลาด เช่น พิมพ์ผิดตัวใดบ่อย 
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• ฝึกซ้ำเป็นประจำ เพ่ือพัฒนาความเร็วและความถูกต้อง 

ตารางการพัฒนาทักษะการพิมพ์ 

ครั้ง
ที ่

วันท่ีฝึก 
ประเภทการพิมพ์ (คำ / 

ประโยค / จดหมาย / จับเวลา) 
เวลาที่ใช้ 
(นาที) 

จำนวนคำ
ทั้งหมด 

จำนวน
คำผิด 

คำ
สุทธิ/
นาที 

ความ
แม่นยำ 

(%) 

ระดับความเร็ว 
(ช้า/ปานกลาง/

เร็ว) 

ข้อควร
ปรับปรุง / 
หมายเหต ุ

1          

2          

3          

4          

5          

แนวทางการประเมินผล 

ระดับความเร็ว คำสุทธิ/นาที ความหมาย 

ช้า ต่ำกว่า 25 ต้องฝึกเพ่ิมความคล่องมือ 

ปานกลาง 25 – 40 สามารถพิมพ์ได้ในระดับมาตรฐาน 

เร็ว มากกว่า 40 มีความชำนาญและแม่นยำสูง 

คำแนะนำในการใช้ตาราง 

• ครูให้นักเรียนฝึกพิมพ์จับเวลาในช่วงเวลาที่กำหนด เช่น 2,3,4,5 10 นาท ี
• บันทึกผลลงในตารางทุกครั้งหลังฝึก 
• เมื่อครบจำนวนครั้ง ให้เปรียบเทียบพัฒนาการจากครั้งแรกถึงครั้งล่าสุด 

6.     แบบฝึกหัด/แบบทดสอบ 

สัปดาห์ที่ 14 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 

1. การพิมพ์จับเวลามีจุดประสงค์หลักเพ่ืออะไร 
ก. เพื่อดูความสวยของตัวอักษร   ข. เพ่ือวัดความเร็วและความถูกต้องใน
การพิมพ์ 
ค. เพ่ือทดสอบความจำของผู้พิมพ์   ง. เพ่ือฝึกการตกแต่งเอกสาร 

2. ก่อนเริ่มพิมพ์จับเวลา ควรปฏิบัติสิ่งใดก่อนเป็นอันดับแรก 
ก. พิมพ์ข้อความทันที    ข. ตั้งเวลาจับเวลาให้ถูกต้อง 
ค. ตรวจสอบท่านั่งและตำแหน่งนิ้ว   ง. เปิดไฟล์งานเก่า 



104 
 

3. การพิมพ์จับเวลาควรใช้ระยะเวลาฝึกครั้งละประมาณเท่าใด 
ก. 1–5 นาที  ข. 10–15 นาที  ค. 20–30 นาที  ง. มากกว่า 30 นาที 

4. การพิมพ์จับเวลาควรพิมพ์แบบใด 
ก. พิมพ์โดยใช้สายตาดูแป้น   ข. พิมพ์แบบสัมผัสไม่มองแป้น 
ค. พิมพ์แบบคัดลอกข้อความ   ง. พิมพ์แบบอัตโนมัติ 

5. เมื่อครบเวลาที่กำหนดในการพิมพ์จับเวลา ควรทำอย่างไร 
ก. พิมพ์ต่อจนจบย่อหน้า    ข. หยุดพิมพ์ทันที 
ค. ลบข้อความที่ผิด    ง. บันทึกงานก่อน 

6. “จำนวนคำสุทธิ” หมายถึงอะไร 
ก. จำนวนคำทั้งหมดที่พิมพ์ได้   ข. จำนวนคำที่พิมพ์ผิด 
ค. จำนวนคำทั้งหมดลบด้วยคำที่ผิด  ง. จำนวนคำในหนึ่งบรรทัด 

7. สูตรการคำนวณคำสุทธิ/นาที คือข้อใด 
ก. จำนวนคำทั้งหมด ÷ เวลา   ข. (จำนวนคำทั้งหมด - คำผิด) ÷ เวลา 
ค. คำผิด ÷ เวลา     ง. คำสุทธิ × เวลา 

8. ถ้านักเรียนพิมพ์ได้ 180 คำใน 3 นาที และพิมพ์ผิด 15 คำ คำสุทธิ/นาทีคือเท่าใด 
ก. 55   ข. 60   ค. 65   ง. 70 

9. ข้อใดไม่ใช่หลักการที่ถูกต้องในการพิมพ์จับเวลา 
ก. ห้ามลบข้อความระหว่างพิมพ์   ข. พิมพ์ตามต้นฉบับให้ถูกต้อง 
ค. พิมพ์แบบมองแป้นพิมพ์   ง. หยุดเมื่อครบเวลา 

10. การคำนวณคำสุทธิ/นาที ใช้หน่วยใด 
ก. ตัวอักษร  ข. คำ  ค. บรรทัด  ง. ย่อหน้า 

สัปดาห์ที่ 15 

คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. การพิมพ์จับเวลาควรฝึกบ่อยเพียงใด 

ก. เดือนละ 1 ครั้ง    ข. สัปดาห์ละ 1 ครั้ง 
ค. ทุกวันหรือวันเว้นวัน   ง. ปีละ 1 ครั้ง 

2. หากพิมพ์ได้เร็วแต่ผิดมาก ผลลัพธ์จะเป็นอย่างไร 
ก. คำสุทธิลดลง    ข. คำสุทธิเพิ่มขึ้น    
ค. ค่าความแม่นยำสูง    ง. ความเร็วเท่าเดิม 

3. ความถูกต้องในการพิมพ์หมายถึงข้อใด 
ก. พิมพ์ครบทุกบรรทัด   ข. พิมพ์ข้อความถูกต้องตามต้นฉบับ 
ค. พิมพ์ข้อความเร็วที่สุด   ง. พิมพ์ข้อความตกแต่งสวยงาม 
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4. การวางนิ้วมือบนแป้นพิมพ์ก่อนเริ่มพิมพ์เรียกว่าอะไร 
ก. การวางแป้นเหย้า    ข. การวางแป้นเสริม 
ค. การเตรียมแป้นจับเวลา   ง. การตั้งค่าแป้นพิมพ์ 

5. การพิมพ์จับเวลาเน้นพัฒนาทักษะด้านใดมากท่ีสุด 
ก. การตกแต่งข้อความ   ข. ความเร็วและความถูกต้อง 
ค. การใช้โปรแกรม Word   ง. การจัดหน้าเอกสาร 

6. ในการพิมพ์จับเวลา ถ้าพิมพ์ผิดควรทำอย่างไร 
ก. ลบทันที     ข. พิมพ์ทับข้อความเดิม 
ค. พิมพ์ต่อไปโดยไม่ลบ   ง. หยุดพิมพ์แล้วเริ่มใหม่ 

7. คำว่า “Accuracy” ในการพิมพ์ หมายถึงอะไร 
ก. ความเร็ว  ข. ความถูกต้อง  ค. ความสวยงาม  ง. ความชำนาญ 

8. ปัจจัยใดช่วยให้พิมพ์จับเวลาได้เร็วขึ้น 
ก. ใช้สายตาจ้องแป้นตลอดเวลา  ข. ฝึกพิมพ์สัมผัสอย่างสม่ำเสมอ 
ค. ใช้คีย์บอร์ดขนาดเล็ก   ง. พิมพ์ตามจังหวะเพลง 

9. ถ้าผลการพิมพ์ของนักเรียนคือ 40 คำสุทธิ/นาที หมายถึงอะไร 
ก. อยู่ในระดับช้า    ข. อยู่ในระดับปานกลาง 
ค. อยู่ในระดับดี    ง. อยู่ในระดับชำนาญ 

10. การพิมพ์จับเวลาช่วยให้นักเรียนเกิดผลดีข้อใด 
ก. พิมพ์ได้เร็วขึ้นและแม่นยำขึ้น  ข. ใช้คอมพิวเตอร์เก่งขึ้น 
ค. พิมพ์งานสวยงาม    ง. เข้าใจภาษาอังกฤษมากข้ึน 

7.  เอกสารอ้างอิง 
7.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม

วิชาการเว็บไซต์สื่อการสอน 

8.     ภาคผนวก  (เฉลยแบบทดสอบ) 

คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. การพิมพ์จับเวลามีจุดประสงค์หลักเพ่ืออะไร 

ก. เพื่อดูความสวยของตัวอักษร   ข. เพ่ือวัดความเร็วและความถูกต้องในการพิมพ์ 
ค. เพ่ือทดสอบความจำของผู้พิมพ์   ง. เพ่ือฝึกการตกแต่งเอกสาร 

2. ก่อนเริ่มพิมพ์จับเวลา ควรปฏิบัติสิ่งใดก่อนเป็นอันดับแรก 
ก. พิมพ์ข้อความทันที    ข. ตั้งเวลาจับเวลาให้ถูกต้อง 
ค. ตรวจสอบท่านั่งและตำแหน่งนิ้ว   ง. เปิดไฟล์งานเก่า 
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3. การพิมพ์จับเวลาควรใช้ระยะเวลาฝึกครั้งละประมาณเท่าใด 
ก. 1–5 นาที  ข. 10–15 นาที  ค. 20–30 นาที  ง. มากกว่า 30 นาที 

4. การพิมพ์จับเวลาควรพิมพ์แบบใด 
ก. พิมพ์โดยใช้สายตาดูแป้น   ข. พิมพ์แบบสัมผัสไม่มองแป้น 
ค. พิมพ์แบบคัดลอกข้อความ   ง. พิมพ์แบบอัตโนมัติ 

5. เมื่อครบเวลาที่กำหนดในการพิมพ์จับเวลา ควรทำอย่างไร 
ก. พิมพ์ต่อจนจบย่อหน้า    ข. หยุดพิมพ์ทันที 
ค. ลบข้อความที่ผิด    ง. บันทึกงานก่อน 

6. “จำนวนคำสุทธิ” หมายถึงอะไร 
ก. จำนวนคำทั้งหมดที่พิมพ์ได้   ข. จำนวนคำที่พิมพ์ผิด 
ค. จำนวนคำทั้งหมดลบด้วยคำที่ผิด  ง. จำนวนคำในหนึ่งบรรทัด 

7. สูตรการคำนวณคำสุทธิ/นาที คือข้อใด 
ก. จำนวนคำทั้งหมด ÷ เวลา   ข. (จำนวนคำทั้งหมด - คำผิด) ÷ เวลา 
ค. คำผิด ÷ เวลา     ง. คำสุทธิ × เวลา 

8. ถ้านักเรียนพิมพ์ได้ 180 คำใน 3 นาที และพิมพ์ผิด 15 คำ คำสุทธิ/นาทีคือเท่าใด 
ก. 55   ข. 60   ค. 65   ง. 70 

9. ข้อใดไม่ใช่หลักการที่ถูกต้องในการพิมพ์จับเวลา 
ก. ห้ามลบข้อความระหว่างพิมพ์   ข. พิมพ์ตามต้นฉบับให้ถูกต้อง 
ค. พิมพ์แบบมองแป้นพิมพ์   ง. หยุดเมื่อครบเวลา 

10. การคำนวณคำสุทธิ/นาที ใช้หน่วยใด 
ก. ตัวอักษร  ข. คำ  ค. บรรทัด  ง. ย่อหน้า 

เฉลย    1.ข   2.ค   3.ก   4.ข   5.ข   6.ค   7.ข   8.ข   9.ค   10.ข 

สัปดาห์ที่ 15 

คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องที่สุด 
1. การพิมพ์จับเวลาควรฝึกบ่อยเพียงใด 

ก. เดือนละ 1 ครั้ง    ข. สัปดาห์ละ 1 ครั้ง 
ค. ทุกวันหรือวันเว้นวัน    ง. ปีละ 1 ครั้ง 

2. หากพิมพ์ได้เร็วแต่ผิดมาก ผลลัพธ์จะเป็นอย่างไร 
ก. คำสุทธิลดลง     ข. คำสุทธิเพิ่มขึ้น     
ค. ค่าความแม่นยำสูง    ง. ความเร็วเท่าเดิม 
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3. ความถูกต้องในการพิมพ์หมายถึงข้อใด 
ก. พิมพ์ครบทุกบรรทัด    ข. พิมพ์ข้อความถูกต้องตามต้นฉบับ 
ค. พิมพ์ข้อความเร็วที่สุด    ง. พิมพ์ข้อความตกแต่งสวยงาม 

4. การวางนิ้วมือบนแป้นพิมพ์ก่อนเริ่มพิมพ์เรียกว่าอะไร 
ก. การวางแป้นเหย้า    ข. การวางแป้นเสริม 
ค. การเตรียมแป้นจับเวลา    ง. การตั้งค่าแป้นพิมพ์ 

5. การพิมพ์จับเวลาเน้นพัฒนาทักษะด้านใดมากท่ีสุด 
ก. การตกแต่งข้อความ    ข. ความเร็วและความถูกต้อง 
ค. การใช้โปรแกรม Word    ง. การจัดหน้าเอกสาร 

6. ในการพิมพ์จับเวลา ถ้าพิมพ์ผิดควรทำอย่างไร 
ก. ลบทันที     ข. พิมพ์ทับข้อความเดิม 
ค. พิมพ์ต่อไปโดยไม่ลบ    ง. หยุดพิมพ์แล้วเริ่มใหม่ 

7. คำว่า “Accuracy” ในการพิมพ์ หมายถึงอะไร 
ก. ความเร็ว  ข. ความถูกต้อง  ค. ความสวยงาม  ง. ความชำนาญ 

8. ปัจจัยใดช่วยให้พิมพ์จับเวลาได้เร็วขึ้น 
ก. ใช้สายตาจ้องแป้นตลอดเวลา   ข. ฝึกพิมพ์สัมผัสอย่างสม่ำเสมอ 
ค. ใช้คีย์บอร์ดขนาดเล็ก    ง. พิมพ์ตามจังหวะเพลง 

9. ถ้าผลการพิมพ์ของนักเรียนคือ 40 คำสุทธิ/นาที หมายถึงอะไร 
ก. อยู่ในระดับช้า     ข. อยู่ในระดับปานกลาง 
ค. อยู่ในระดับดี     ง. อยู่ในระดับชำนาญ 

10. การพิมพ์จับเวลาช่วยให้นักเรียนเกิดผลดีข้อใด 
ก. พิมพ์ได้เร็วขึ้นและแม่นยำขึ้น   ข. ใช้คอมพิวเตอร์เก่งขึ้น 
ค. พิมพ์งานสวยงาม    ง. เข้าใจภาษาอังกฤษมากข้ึน 
เฉลย  1.ค   2.ก   3.ข   4.ก   5.ข   6.ค   7.ข   8.ข   9.ค   10.ก 
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ใบกิจกรรมที่ 4 หน่วยที่   4   

รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  14 - 15   
ชื่อหน่วยการเรียนรู้   งานคิดคำสุทธิและการพิมพ์จับเวลา
เพ่ือพัฒนา 

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนา ปฏิบัติ     8    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนาความแม่นยำในการปฏิบัติ
พิมพ์ภาษาอังกฤษ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  
    3.1  ฝึกพิมพ์ทบทวน และมีเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
    3.2  ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์อย่างไรไม่ให้ปวดเมื่อย 
    3.3   ฝึกพิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำ การคิดคำสุทธิ 
    3.4  บูรณาการคุณธรรม จริยธรรม ด้านความสนใจ ใฝ่รู้ ความซื่อสัตย์ ความรับผิดชอบ ความประหยัด 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
9. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
10. สร้างเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
11. ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์ไรไม่ให้ปวดเมื่อย 
12. คิดคำสุทธิได้ถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
7. พิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำได้ 
8. คิดคำสุทธิได้ถูกต้อง 



109 
 

9. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้/ใบงาน 
 5.3 คอมพิวเตอร์(โปรแกรม Microsoft Word) 

5.4 TV 
6. ข้ันตอนการทำกิจกรรม 

6.1. เตรียมความพร้อมก่อนพิมพ์ 
• ตรวจสอบเครื่องคอมพิวเตอร์หรือเครื่องพิมพ์ดีดให้อยู่ในสภาพพร้อมใช้งาน 
• เปิดโปรแกรมพิมพ์ Microsoft Word  
• ศึกษาใบงานที่ผู้สอนแจกให้ 

6.2. การพิมพ์จับเวลา 

• ครูกำหนดเวลา 2,3,4,5 10 นาที 

• นักเรียนเริ่มพิมพ์ข้อความตัวอย่างตามใบงานที่กำหนด โดยเน้น ความถูกต้องและต่อเนื่อง 

• เมื่อครบเวลาให้หยุดพิมพ์ทันที 
6.3. การนับจำนวนคำทั้งหมด 

• นับจำนวนคำทั้งหมดที่พิมพ์ได้ในเวลาที่กำหนด 
• หลักการนับคำ: 

o ในการพิมพ์ภาษาอังกฤษ 1 คำ = 5 ตัวอักษรรวมช่องว่าง 
o ใช้สูตร: 

จำนวนคำทั้งหมด=จำนวนตัวอักษรทั้งหมด5\text{จำนวนคำทั้งหมด} = \frac{\text{จำนวนตัวอักษร
ทั้งหมด}}{5}จำนวนคำทั้งหมด=5จำนวนตัวอักษรทั้งหมด  
6.4. การนับจำนวนผิด 

• ตรวจนับคำหรืออักษรที่พิมพ์ผิด 
• แต่ละคำผิดนับเป็น 1 ความผิด 
• บันทึกจำนวนความผิดไว้เพ่ือใช้คำนวณคำสุทธิ 
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6.5. การคำนวณคำสุทธิ (Net Words per Minute - NWPM) 
ใช้สูตร: 
คำสุทธิ/นาท=ีจำนวนคำทั้งหมด−จำนวนผิดเวลาที่ใช้ (นาที)\text{คำสุทธิ/นาท}ี = \frac{\text{
จำนวนคำทั้งหมด} - \text{จำนวนผิด}}{\text{เวลาที่ใช้ (นาที)}}คำสุทธิ/นาท=ีเวลาที่ใช้ (นาท)ี
จำนวนคำทั้งหมด−จำนวนผิด  
6.6. การบันทึกผล 
6.7. การวิเคราะห์และพัฒนา 

• เปรียบเทียบผลในแต่ละครั้ง เพ่ือดูพัฒนาการ 
• ฝึกซ้ำในส่วนที่ยังพิมพ์ช้า หรือมักผิดบ่อย 
• ตั้งเป้าหมาย เช่น “เพ่ิมข้ึน 5 คำสุทธิต่อสัปดาห์” 

6.8. การสรุปผลกิจกรรม 
• ครูและนักเรียนร่วมกันสรุปผล ว่าใครพัฒนาได้ดีขึ้น 
• ให้ข้อเสนอแนะการฝึกต่อเนื่อง เช่น 

o ฝึกพิมพ์ทุกวันวันละ 10 นาที 
o ใช้โปรแกรมฝึกจับเวลาออนไลน์ 
o เน้นความถูกต้องก่อนความเร็ว 

7. สรุปและอภิปราย  
7.1 ครูและนักเรียน ช่วยกันสรุปเนื้อหา 

8.  สรุปและวิจารณ์ผล  
8.1 ครูผู้สอนตรวจสอบการส่งงาน ว่าผู้สอนส่งงานครบทุกคนหรือไม่ 

9. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม 
9.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ 
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ใบงานที่ 4 หน่วยที่   4   

รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  14 - 15   
ชื่อหน่วยการเรียนรู้   งานคิดคำสุทธิและการพิมพ์จับเวลา
เพ่ือพัฒนา 

ทฤษฎี   0     ชั่วโมง 

ชื่อเรื่อง      งานคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนา ปฏิบัติ    8    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับการคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนาความแม่นยำในการปฏิบัติ
พิมพ์ภาษาอังกฤษ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  
    3.1  ฝึกพิมพ์ทบทวน และมีเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
    3.2  ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์อย่างไรไม่ให้ปวดเมื่อย 
    3.3   ฝึกพิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำ การคิดคำสุทธิ 
    3.4  บูรณาการคุณธรรม จริยธรรม ด้านความสนใจ ใฝ่รู้ ความซื่อสัตย์ ความรับผิดชอบ ความประหยัด 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
13. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
14. สร้างเทคนิคการพิมพ์ที่ดีเพ่ือการพัฒนาความเร็วและความแม่นยำ 
15. ฝึกวิธีนั่งหน้าจอคอมพิวเตอร์ไรไม่ให้ปวดเมื่อย 
16. คิดคำสุทธิได้ถูกต้อง 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
10. พิมพ์จับเวลาเพื่อพัฒนาความเร็วและความแม่นยำได้ 
11. คิดคำสุทธิได้ถูกต้อง 
12. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
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4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 

4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล  
 5.2 ใบความรู้/ใบงาน 

5.3 คอมพิวเตอร์ 
5.4 TV 

6. คำแนะนำ/ข้อควรระวัง  
6.1 ปฏิบัติงานด้วยความละเอียดรอบคอบ   

7. ข้ันตอนการปฏิบัติงาน 
ชื่อเรื่อง งานคิดคำสุทธิและการพิมพ์จับเวลาเพื่อพัฒนา 
  เวลา 180 นาท ี

 จุดประสงค์   
1. พัฒนาการพิมพ์ให้แม่นยำ ถูกต้อง 
2. สามารถพิมพ์จดหมายธุรกิจต่างๆ ตามใบงานที่มอบหมายให้ได้อย่างถูกต้อง 

 วัสดุอุปกรณ์   
1. คอมพิวเตอร์(โปรแกรม Microsoft Word)  
2. TV 

 ขั้นตอนการดำเนินงาน 
1. ผู้สอนให้ผู้เรียนเตรียมคอมพิวเตอร์ ตรวจสอบความพร้อม 
2. ให้ผู้เรียนศึกษาใบงาน และทบทววิธีนคิดคำสุทธิและหลักการพิมพ์จับเวลา    
3. ผู้สอนเริ่มทดลองจับเวลา 2,4,5 และ 10 นาที และให้ผู้เรียนคำนวณคำสุทธิโดยเน้นย้ำ

ในเรื่องความซื่อสัตย์ 
4. ให้ผู้เรียนบันทึกผลการปฏิบัติการพิมพ์ลงในตารางการพัฒนาทักษะการพิมพ์ 

8.  สรุปและวิจารณ์ผล  
8.1 ครูและนักเรียนร่วมกันสรุปเนื้อหาที่เรียน 

9. การประเมินผล  
9.1 ผ่านเกณฑ์การประเมินผลไม่ต่ำกว่าร้อยละ 80 
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10. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม  

10.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ ล  

ส่งเสริมวิชาการ 
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แผนการจัดการเรียนรู้ที่ 5 หน่วยที ่   5 

รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สอนครั้งที่ 16 - 17 
ชื่อหน่วยการเรียนรู้   งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม 
Microsoft Word 

ทฤษฎี  0  ชม. 
ปฏิบัติ  8  ชม. 

ชื่อเรื่อง/งาน   งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม Microsoft Word  
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับตรวจสอบความผิดพลาดจากการพิมพ์เอกสาร การใช้ฟังก์ชันตรวจสอบการ
สะกดคำถูก หรือคำผิด การใช้แป้น backspace และแป้น Delete เพื่อแก้ไขคำผิด ตลอดจนหลักการ
ตรวจสอบเอกสารที่ถูกต้อง และมีประสิทธิภาพ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 แสดงความรู้เกี่ยวกับการใช้คำสั่งการตรวจสอบการสะกดคำ 
3.2 แสดงความรู้เกี่ยวกับการใช้แป้นพิมพ์ Backspace และแป้นพิมพ์ Delete เพ่ือแก้ไขคี่พิมพ์ผิด 
3.3  แสดงความรู้เกี่ยวกับหลักการตรวจานเอกสารที่ถ฿กต้อง แฃะมีประสิทธาพ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
4.1 ด้านความรู้  ผู้เรียนสามารถ 

1. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
2. ใช้เครื่องมือเพ่ือตรวจสอบการสกดคำได้ 
3. ตรวจทานงานเอกสารได้อย่างมีประสิทธิภาพ และรวดเร็ว 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
1. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ถูกต้อง แม่นยำ 
2. ใช้โปรแกรม Microsoft Word ได้อย่างดี  
3. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 

4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
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1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. สาระการเรียนรู้ 
1. การใช้เครื่องมือ(คำสั่ง)การสะกดคำและไวยกรณ์ ในโปรแกรม Microsoft Word 
2. การลบข้อความโดยใช้แป้นพิมพ์ backspace และแป้นพิมพ์ Delete 
3. ทคนิคการตรวจทานเอกสาร 

6. กิจกรรมการเรียนรู้     
สัปดาห์ที่ 16  
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพ่ือเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
ปฏิบัติการใช้คำสั่งการสะกดคำ และไวยกรณ์ และ
การแก้ไขเอกสารโดยใช้แป้นพิมพ์ backspace และ
แป้นพิมพ์ Delete 
2.ผู้สอนเน้นความถูกแม่นยำ ความรอบคอบในการ
พิมพ์เอกสารตามใบงาน และการวางมือ 
ขั้นสอน 
1.ผู้สอนแจกใบงาน 
2.ผู้สอนอธิบายวิธีการทำใบงาน ข้อตดลงในการ
ปฏิบัติงาน 
3. ผู้สอนให้ผู้เรียนปฏิบัติตามใบงานโดยจับเวลา 10 
นาท ี
4.ผู้สอนให้ผู้เรียนตรวจสอบความถูกต้ององงาน
ตนเอง และบันทึกความก้าวหน้าลงตารางการพัฒนา
ทักษะการพิมพ์ 
ขั้นสรุป 
1.  ผู้สอนพาผู้เรียนทำแบบทดสอบท้ายบทเรียน  
 2.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ 

1. ผู้เรียนศึกษารายละเอียดของใบงาน 
2. ผู้เรียนซักถามรายละเอียดในใบงานที่ไม่เข้าใจ 
3. ผู้เรียนปฏิบัติใบงาน 
4. ผู้เรียนตรวจคำสะกด และนำส่งใบงานในไลน์
กลุ่ม 
5.ผู้เรียนทำแบบทดสอบหลังเรียน 
6. ผู้เรียนตรวจแบบทดสอบตามท่ีผู้สอนเฉลย 
7. ผู้เรียนบอกคะแนนแบบทดสอบ   
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สัปดาห์ที่  17  
ขั้นการสอนหรือกิจกรรมของครู ขั้นตอนการเรียนรู้หรือกิจกรรมของนักเรียน 
จุดประสงค์ข้อที่ 1-4 
  -ขั้นเตรียม 
1.ผู้สอนกล่าวเพ่ือเชื่อมโยงนำเข้าสู่บทเรียนเกี่ยวกับ
หลักการตรวจทานเอกสารที่ถูกต้อง รวดเร็ว และมี
ประสิทธาพ 
ขั้นสอน 
1.ผู้สอนแจกใบความรู้เรื่องหลักการตรวจทาน
เอกสาร 
2.ผู้สอนอธิบายวิธีการตรวจทานเอกสารที่ถูกต้อง 
3.ผู้สอนแจกใบงาน 
4. ผู้สอนให้ผู้เรียนปฏิบัติตามใบงานโดยจับเวลา 10 
นาท ี
ขั้นสรุป 
1.  ผู้สอนพาผู้เรียนทำแบบทดสอบท้ายบทเรียน  
 2.  ผู้สอนและผู้เรียนร่วมกันสรุปเนื้อหาสาระสำคัญ 

1. ผู้เรียนศึกษารายละเอียดของใบงาน 
2. ผู้เรียนซักถามรายละเอียดในใบงานที่ไม่เข้าใจ 
3. ผู้เรียนปฏิบัติใบงาน 
4. ผู้เรียนตรวจทานงานของตนเอง โดยใช้
หลักการตรวจทานเอกสารที่เรียนไปวันนี้ และ
นำส่งใบงานในไลน์กลุ่ม 
5.ผู้เรียนทำแบบทดสอบหลังเรียน 
6. ผู้เรียนตรวจแบบทดสอบตามท่ีผู้สอนเฉลย 
7. ผู้เรียนบอกคะแนนแบบทดสอบ   

 
7. สื่อและแหล่งการเรียนรู้ 

1.   หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์  
      ส่งเสริมวชิาการ 
2.    ใบความรู้/ใบกิจกรรม     
3     กิจกรรมการเรียนการสอน 
4     เครื่องคอมพิวเตอร์ และ TV  

8. หลักฐานการเรียนรู้ 
   8.1 หลักฐานความรู้          

- ใบงาน  
 - ใบความรู้  
   8.2 หลักฐานการปฏิบัติงาน          
             -ภาพการปฏิบัติงาน การฝึกฝนทักษะบันทึกในแบบบันทึกหลังการสอนออนไลน์  
9. การวัดและประเมินผล 
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9.1 เกณฑ์การปฏิบัติงาน 
- แบบสังเกตพฤติกรรมรายบุคคล เกณฑ์ผ่าน  50%  ขึ้นไป 
- แบบทดสอบหลังเรียน เกณฑ์ผ่าน  60%  ขึ้นไป 
- ชิ้นงาน เกณฑ์ผ่าน 80% 

9.2  วิธีการประเมิน 

- สังเกตพฤติกรรมการปฏิบัติงาน  

- ตรวจชื้นงาน 

- การสังเกตและประเมินผลพฤติกรรมด้านคุณธรรม จริยธรรม ค่านิยม และคุณลักษณะอันพึง
ประสงค์ 

9.3 เครื่องมือประเมิน 

- แบบทดสอบแบบการเลือกตอบ. 

-  ตารางการพัฒนาทักษะการพิมพ์ 
10. บันทึกผลหลังการจัดการเรียนรู้ 
 10.1 เอกสารการบันทึกหลังการสอนในระบบออนไลน์ 
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ใว 
ใบความรู้ที่ 5 หน่วยที่   5   

รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  16 - 17  
ชื่อหน่วยการเรียนรู้   งานตรวจสอบและปรับปรุงงานพิมพ์ใน
โปรแกรม Microsoft Word 

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม Microsoft Word ปฏิบัติ     8    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับตรวจสอบความผิดพลาดจากการพิมพ์เอกสาร การใช้ฟังก์ชันตรวจสอบการ
สะกดคำถูก หรือคำผิด การใช้แป้น backspace และแป้น Delete เพื่อแก้ไขคำผิด ตลอดจนหลักการ
ตรวจสอบเอกสารที่ถูกต้อง และมีประสิทธิภาพ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 แสดงความรู้เกี่ยวกับการใช้คำสั่งการตรวจสอบการสะกดคำ 
3.2 แสดงความรู้เกี่ยวกับการใช้แป้นพิมพ์ Backspace และแป้นพิมพ์ Delete เพ่ือแก้ไขคี่พิมพ์ผิด 
3.3  แสดงความรู้เกี่ยวกับหลักการตรวจานเอกสารที่ถ฿กต้อง แฃะมีประสิทธาพ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
4. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
5. ใช้เครื่องมือเพ่ือตรวจสอบการสกดคำได้ 
6. ตรวจทานงานเอกสารได้อย่างมีประสิทธิภาพ และรวดเร็ว 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
4. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ถูกต้อง แม่นยำ 
5. ใช้โปรแกรม Microsoft Word ได้อย่างดี  
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6. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เนื้อหาสาระ   
1.งานตรวจสอบการสะกดคำ (Spelling) 

วิธีที่ 1 : ตรวจสอบคำสะกดอัตโนมัติ 
1. เปิดไฟล์เอกสาร Word ที่ต้องการตรวจสอบ 
2. ถ้ามีคำที่สะกดผิด Word จะมี เส้นสีแดงหยัก ๆ ใต้คำที่ผิด 
3. คลิกขวาที่คำท่ีมีเส้นสีแดง 

4. โปรแกรมจะเสนอคำสะกดที่ถูกต้อง → คลิกเลือกคำที่ถูกต้อง 
5. คำสะกดจะถูกแก้ไขให้อัตโนมัติ 
วิธีที่ 2 : ตรวจสอบการสะกดคำท้ังเอกสาร 
1. ไปที ่แท็บ Review (รีวิว) ที่แถบเมนูด้านบน 
2. คลิกท่ีคำสั่ง Spelling & Grammar (การสะกดและไวยากรณ์) 
3. โปรแกรมจะเริ่มตรวจสอบตั้งแต่ต้นเอกสาร 
4. เมื่อเจอคำผิด Word จะเปิดกล่อง Editor หรือ Spelling Pane ด้านข้าง 
5. คุณสามารถเลือกได้ว่า 

o Change – เพ่ือแก้เป็นคำท่ีถูก 
o Change All – เพ่ือแก้ทุกคำในเอกสาร 
o  Ignore – เพ่ือข้ามคำนี้ไป 

6. เมื่อโปรแกรมตรวจครบ จะข้ึนข้อความว่า “Spelling and grammar check complete” 
วิธีที่ 3 : ตั้งค่าภาษาในการตรวจสอบ 
ถ้าคำไทยไม่ข้ึนเส้นแดง ให้ตรวจสอบภาษาท่ีใช้ตรวจคำ 
1. เลือกข้อความทั้งหมด (Ctrl + A) 

2. ไปที่แท็บ Review → Language → Set Proofing Language 
3. เลือกภาษา Thai หรือ English (ตามภาษาของเอกสาร) 
4. กด OK 
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เคล็ดลับเพ่ิมเติม 
• เปิด/ปิดการตรวจคำอัตโนมัติได้ที่ 

File → Options → Proofing → Check spelling as you type 
• ใช้ F7 เพ่ือเปิดการตรวจสอบการสะกดคำได้ทันที (ทางลัด 

2. งานแก้ไขข้อผิดพลาดด้วย Backspace, Delete และการแก้ไขข้อความ 
 1. การใช้ปุ่ม Backspace 

• ใช้สำหรับ ลบตัวอักษรทางด้านซ้ายของเคอร์เซอร์ (Cursor) 
• ตัวอย่าง: 
• ตัวอยา|ง 

→ กด Backspace 1 ครั้ง จะได้ “ตัวยา” 
สรุป: 
 Backspace = ลบตัวอักษรทางซ้ายของตำแหน่งเคอร์เซอร์ 

2. การใช้ปุ่ม Delete 
• ใช้สำหรับ ลบตัวอักษรทางด้านขวาของเคอร์เซอร์ 
• ตัวอย่าง: 
• ตัวอยา|ง 

→ กด Delete 1 ครั้ง จะได้ “ตัวอย” 
สรุป:  Delete = ลบตัวอักษรทางขวาของตำแหน่งเคอร์เซอร์ 

การแก้ไขข้อความในเอกสาร 
วิธีที่ 1: แทรกข้อความใหม่ 

1. คลิกตำแหน่งที่ต้องการเพ่ิมข้อความ 
2. พิมพ์ข้อความใหม่ลงไปได้เลย 

วิธีที่ 2: ลบข้อความเดิมแล้วพิมพ์ใหม่ 
1. คลิกเมาส์ลากคลุมข้อความที่ต้องการลบ 
2. กด Backspace หรือ Delete 
3. พิมพ์ข้อความใหม่แทนที่ 

วิธีที่ 3: คัดลอก / ตัด / วาง (Copy / Cut / Paste) 
• คัดลอก (Copy): กด Ctrl + C 
• ตัด (Cut): กด Ctrl + X 
• วาง (Paste): กด Ctrl + V 

 4. การยกเลิกคำสั่งแก้ไข (Undo / Redo) 
• Undo (ย้อนกลับ): Ctrl + Z 
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• Redo (ทำซ้ำ): Ctrl + Y 
ใช้เมื่อแก้ไขผิดพลาดหรือต้องการกลับไปยังข้อความก่อนหน้า 

5. การแก้ไขด้วยการแทนที่ (Replace) 

1. ไปที่แท็บ Home → Replace (หรือกด Ctrl + H) 
2. ในช่อง 

o Find what: ใส่คำที่ต้องการค้นหา 
o Replace with: ใส่คำใหม่ที่ต้องการแทน 

3. คลิก Replace หรือ Replace All 
สรุป 

คำสั่ง การทำงาน 

Backspace ลบตัวอักษรทางซ้ายของเคอร์เซอร์ 

Delete ลบตัวอักษรทางขวาของเคอร์เซอร์ 

Ctrl + Z ย้อนกลับ (Undo) 

Ctrl + Y ทำซ้ำ (Redo) 

Ctrl + C / X / V คัดลอก / ตัด / วาง 

Ctrl + H แทนที่ข้อความ 

3. งานตรวจทานรูปแบบและความเรียบร้อยของงาน 
1. ตรวจสอบ รูปแบบของเอกสาร (Formatting)  การจัดรูปแบบที่ดีจะทำให้งานดูเป็นระเบียบและน่าอ่าน 
ตรวจสอบดังนี้ 

1. ขนาดกระดาษ 
o ใช้มาตรฐาน A4 (21 × 29.7 ซม.) 

2. ระยะขอบ (Margins) 
o บน–ล่าง 1 นิ้ว 
o ซ้าย 1.25 นิ้ว 
o ขวา 1 นิ้ว 

3. แบบและขนาดตัวอักษร (Font & Size) 
o ฟอนต์มาตรฐาน เช่น TH SarabunPSK หรือ Angsana New 
o ขนาดหัวเรื่อง 16 pt, เนื้อหา 14 pt 

4. การจัดแนวข้อความ (Alignment) 
o หัวเรื่องจัดก่ึงกลาง 
o เนื้อหาชิดขอบทั้งสองด้าน (Justify) 
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2. ตรวจสอบ การสะกดคำและไวยากรณ์ (Spelling & Grammar) 

1. ใช้คำสั่ง Review → Spelling & Grammar 
2. สังเกตคำที่มีเส้นสีแดงใต้ข้อความ (สะกดผิด) หรือเส้นสีฟ้า (ไวยากรณ์ผิด) 
3. คลิกขวาเพ่ือดูคำแนะนำและเลือกคำที่ถูกต้อง 
4. อ่านทวนด้วยตนเองอีกครั้งเพ่ือความแน่นอน 

3. ตรวจสอบ การจัดย่อหน้าและระยะห่าง 
1. ตรวจการเว้นวรรคระหว่างคำให้ถูกต้อง 
2. ตรวจระยะบรรทัด (Line Spacing) ให้สม่ำเสมอ เช่น 1.15 หรือ 1.5 
3. ตรวจย่อหน้าแรกให้มีการย่อ (Indent) ประมาณ 1.25 ซม. 
4. ตรวจว่าไม่มีการกด Enter ซ้ำหลายครั้งเกินไป 

4. ตรวจสอบ ความถูกต้องของเนื้อหา 
1. อ่านเนื้อหาให้ครบถ้วน ตรงตามหัวข้อ 
2. ตรวจคำผิด ตัวสะกดผิด หรือการใช้คำไม่เหมาะสม 
3. ตรวจชื่อบุคคล สถานที่ ตัวเลข หรือวันที่ให้ถูกต้อง 
4. ตรวจว่าข้อความไม่ตกหล่นหรือซ้ำซ้อน 

 5. ตรวจสอบ ความเรียบร้อยของการจัดหน้า 
1. ตรวจการขึ้นหน้าใหม่ด้วยคำสั่ง Page Break (Ctrl + Enter) 
2. ตรวจหมายเลขหน้า (Page Number) 
3. ตรวจหัวกระดาษ (Header) และท้ายกระดาษ (Footer) ให้ถูกต้อง 
4. ตรวจไม่ให้มีหน้าว่างหรือบรรทัดว่างเกินความจำเป็น 

 
6. ตรวจสอบ องค์ประกอบเพิ่มเติม 

1. ชื่อเรื่อง ชื่อผู้จัดทำ วันเดือนปีครบถ้วน 
2. มีการจัดลำดับหัวข้ออย่างเป็นระบบ 
3. ใช้ Bullet หรือ Numbering ให้เหมาะสม 
4. ตรวจตาราง รูปภาพ หรือแผนภูมิให้ตรงกับเนื้อหาและไม่ล้นหน้า 

7. ตรวจทานครั้งสุดท้าย (Final Review) 
1. อ่านงานตั้งแต่ต้นจนจบอีกครั้ง 
2. เปิดดูในโหมด Print Preview เพ่ือดูความเรียบร้อยก่อนพิมพ์ 
3. บันทึกงานให้ถูกชื่อไฟล์ เช่น รายงานหน่วยที่ 3.docx 
4. ตรวจสำเนาไฟล์อีกครั้งก่อนส่งงาน 
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สรุป 

สิ่งที่ต้องตรวจ จุดที่เน้น 

รูปแบบเอกสาร ขนาดกระดาษ, ระยะขอบ, ฟอนต์ 

การสะกดคำ ตรวจด้วย Review หรืออ่านทวน 

การจัดหน้า ย่อหน้า, ระยะห่าง, เลขหน้า 

เนื้อหา ถูกต้อง ครบถ้วน ไม่ตกหล่น 

ความเรียบร้อย ไม่มีคำผิด หน้าว่าง หรือบรรทัดซ้ำ 

 

6.     แบบฝึกหัด/แบบทดสอบ 
สัปดาห์ที่ 16 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องท่ีสุด 
1. คำสั่งใดใช้สำหรับตรวจสอบการสะกดคำและไวยากรณ์ในโปรแกรม Microsoft Word 
ก. View   ข. Review  ค. Insert  ง. Layout 
2. หากต้องการให้ Word ตรวจสอบคำสะกดอัตโนมัติในขณะพิมพ์ ควรสังเกตสัญลักษณ์ใดใต้คำท่ีสะกดผิด 
ก. เส้นตรงสีดำ  ข. เส้นประสีน้ำเงิน ค. เส้นหยักสีแดง  ง. เส้นหยักสีเขียว 
3. การตรวจสอบการสะกดคำ (Spelling Check) มีประโยชน์อย่างไร 
ก. ทำให้ตัวอักษรมีสีสวยขึ้น ข. ช่วยตรวจหาคำผิดและเสนอคำที่ถูกต้อง 
ค. ใช้ตรวจสอบขนาดตัวอักษร ง. ใช้เปลี่ยนแบบอักษรอัตโนมัติ 
4. ทางลัดในการเรียกใช้คำสั่งตรวจสอบการสะกดคำคือปุ่มใด 
ก. F2   ข. F5   ค. F7   ง. F9 
5. เมื่อคลิกขวาที่คำที่สะกดผิด โปรแกรมจะ 
ก. แก้ไขคำโดยอัตโนมัติทันที ข. แสดงคำแนะนำที่สะกดถูกให้เลือก 
ค. ลบคำออกจากเอกสาร ง. แปลคำศัพท์เป็นภาษาไทย 
6. หาก Word ไม่ตรวจสอบการสะกดคำ ควรตรวจสอบที่เมนูใด 

ก. File → Options → Proofing ข. File → Save → Format 

ค. Review → View ง. Insert → Language 
7. การตั้งค่าภาษาในการตรวจคำสะกดทำได้ที่เมนูใด 

ก. Home → Font ข. Review → Language → Set Proofing Language 

ค. Insert → Symbols ง. View → Zoom 
8. เส้นหยักสีฟ้าใต้คำใน Word หมายถึงอะไร 
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ก. คำสะกดผิด ข. คำท่ีใช้ภาษาผิดหรือไวยากรณ์ผิด 
ค. คำท่ียังไม่ได้บันทึก ง. คำท่ีถูกต้องแล้ว 
9. หากต้องการให้ Word หยุดตรวจคำสะกดขณะพิมพ์ ต้องยกเลิกเครื่องหมายใด 
ก. Check spelling as you type ข. AutoSave file 
ค. Show gridlines ง. Track changes 
10. เมื่อโปรแกรมตรวจสอบคำสะกดครบทั้งเอกสาร จะปรากฏข้อความว่า 
ก. File saved successfully ข. Spelling and grammar check complete 
ค. Your document is formatted ง. Editing finished 
สัปดาห์ที่ 17 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องท่ีสุด 
1. การตรวจทานรูปแบบของงานมีวัตถุประสงค์เพ่ืออะไร 

ก. ทำให้งานมีสีสันสวยงาม ข. ทำให้งานมีระเบียบ ถูกต้อง และน่าอ่าน 
ค. เพ่ิมจำนวนหน้าของเอกสาร ง. ลดขนาดไฟล์เอกสาร 

2. ขนาดกระดาษมาตรฐานที่นิยมใช้ในการพิมพ์เอกสารคือข้อใด 
ก. A3   ข. A4   ค. B4   ง. Letter 

 3. การตรวจระยะขอบ (Margins) ของเอกสารควรตรวจจากเมนูใด 
ก. Layout  ข. Insert  ค. View   ง. Review 

4. ฟอนต์มาตรฐานที่นิยมใช้ในเอกสารราชการและงานทั่วไปคือข้อใด 
ก. Cordia New     ข. TH SarabunPSK  
ค. Comic Sans MS    ง. Arial Black 

5. หากต้องการตรวจสอบว่ามีคำผิดหรือไม่ ควรใช้คำสั่งใด 

ก. View → Zoom  ข. Review → Spelling & Grammar 

ค. Layout → Page Setup  ง. Insert → WordArt 
6. การจัดแนวข้อความของเนื้อหาให้ชิดขอบทั้งสองด้านควรเลือกแบบใด 

ก. Align Left  ข. Align Right   ค. Center  ง. Justify 
7. การตรวจสอบความเรียบร้อยของงานควรดูข้อใดเป็นอันดับแรก 

ก. การสะกดคำ ข. การจัดหน้าและระยะขอบ 
ค. การแทรกรูปภาพ ง. การเปลี่ยนสีพื้นหลัง 

8. คำสั่งใดใช้สำหรับดูความเรียบร้อยของเอกสารก่อนสั่งพิมพ์ 
ก. Print Preview ข. Page Break 
ค. Save As ง. Undo 

9. หากต้องการจัดระยะบรรทัดให้สม่ำเสมอ ควรปรับที่เมนูใด 
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ก. Home → Line and Paragraph Spacing ข. Layout → Size 

ค. Review → Language   ง. Insert → Table 
10. การตรวจทานครั้งสุดท้ายก่อนส่งงานควรทำสิ่งใด 

ก. ปรับสีตัวอักษรให้สวยงาม ข. อ่านทวนเอกสารทั้งหมดเพ่ือหาความผิดพลาด 
ค. เพ่ิมภาพประกอบให้มากขึ้น ง. ลบหน้าเอกสารที่ว่างออกท้ังหมดโดยไม่ตรวจเนื 

7. เอกสารอ้างอิง 
7.1 .    หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์
ส่งเสริมวิชาการ 

8.     ภาคผนวก  (เฉลยแบบทดสอบ) 
สัปดาห์ที่ 16 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องท่ีสุด 
1. คำสั่งใดใช้สำหรับตรวจสอบการสะกดคำและไวยากรณ์ในโปรแกรม Microsoft Word 

ก. View   ข. Review  ค. Insert  ง. Layout 
2. หากต้องการให้ Word ตรวจสอบคำสะกดอัตโนมัติในขณะพิมพ์ ควรสังเกตสัญลักษณ์ใดใต้คำท่ีสะกดผิด 

ก. เส้นตรงสีดำ  ข. เส้นประสีน้ำเงิน ค. เส้นหยักสีแดง  ง. เส้นหยักสีเขียว 
3. การตรวจสอบการสะกดคำ (Spelling Check) มีประโยชน์อย่างไร 

ก. ทำให้ตัวอักษรมีสีสวยขึ้น ข. ช่วยตรวจหาคำผิดและเสนอคำที่ถูกต้อง 
ค. ใช้ตรวจสอบขนาดตัวอักษร ง. ใช้เปลี่ยนแบบอักษรอัตโนมัติ 

4. ทางลัดในการเรียกใช้คำสั่งตรวจสอบการสะกดคำคือปุ่มใด 
ก. F2   ข. F5   ค. F7   ง. F9 

5. เมื่อคลิกขวาที่คำที่สะกดผิด โปรแกรมจะ 
ก. แก้ไขคำโดยอัตโนมัติทันที ข. แสดงคำแนะนำที่สะกดถูกให้เลือก 
ค. ลบคำออกจากเอกสาร ง. แปลคำศัพท์เป็นภาษาไทย 

6. หาก Word ไม่ตรวจสอบการสะกดคำ ควรตรวจสอบที่เมนูใด 

ก. File → Options → Proofing ข. File → Save → Format 

ค. Review → View ง. Insert → Language 
7. การตั้งค่าภาษาในการตรวจคำสะกดทำได้ที่เมนูใด 

ก. Home → Font ข. Review → Language → Set Proofing Language 

ค. Insert → Symbols ง. View → Zoom 
8. เส้นหยักสีฟ้าใต้คำใน Word หมายถึงอะไร 

ก. คำสะกดผิด ข. คำท่ีใช้ภาษาผิดหรือไวยากรณ์ผิด 
ค. คำท่ียังไม่ได้บันทึก ง. คำท่ีถูกต้องแล้ว 
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9. หากต้องการให้ Word หยุดตรวจคำสะกดขณะพิมพ์ ต้องยกเลิกเครื่องหมายใด 

ก. Check spelling as you type ข. AutoSave file 
ค. Show gridlines ง. Track changes 

10. เมื่อโปรแกรมตรวจสอบคำสะกดครบทั้งเอกสาร จะปรากฏข้อความว่า 
ก. File saved successfully  ข. Spelling and grammar check complete 
ค. Your document is formatted ง. Editing finished 
เฉลย 1.ข   2.ค   3.ข   4.ค   5.ข   6.ก   7.ข   8.ข   9.ค   1.ข 
สัปดาห์ที่ 17 
คำสั่ง   จงทำเครื่องหมายกากบาท (X) ลงหน้าข้อที่ถูกต้องท่ีสุด 
1. การตรวจทานรูปแบบของงานมีวัตถุประสงค์เพ่ืออะไร 

ก. ทำให้งานมีสีสันสวยงาม ข. ทำให้งานมีระเบียบ ถูกต้อง และน่าอ่าน 
ค. เพ่ิมจำนวนหน้าของเอกสาร ง. ลดขนาดไฟล์เอกสาร 

2. ขนาดกระดาษมาตรฐานที่นิยมใช้ในการพิมพ์เอกสารคือข้อใด 
ก. A3   ข. A4   ค. B4   ง. Letter 

 3. การตรวจระยะขอบ (Margins) ของเอกสารควรตรวจจากเมนูใด 
ก. Layout  ข. Insert  ค. View   ง. Review 

4. ฟอนต์มาตรฐานที่นิยมใช้ในเอกสารราชการและงานทั่วไปคือข้อใด 
ก. Cordia New     ข. TH SarabunPSK  
ค. Comic Sans MS    ง. Arial Black 

5. หากต้องการตรวจสอบว่ามีคำผิดหรือไม่ ควรใช้คำสั่งใด 

ก. View → Zoom  ข. Review → Spelling & Grammar 

ค. Layout → Page Setup  ง. Insert → WordArt 
6. การจัดแนวข้อความของเนื้อหาให้ชิดขอบทั้งสองด้านควรเลือกแบบใด 

ก. Align Left  ข. Align Right   ค. Center  ง. Justify 
7. การตรวจสอบความเรียบร้อยของงานควรดูข้อใดเป็นอันดับแรก 

ก. การสะกดคำ ข. การจัดหน้าและระยะขอบ 
ค. การแทรกรูปภาพ ง. การเปลี่ยนสีพื้นหลัง 

8. คำสั่งใดใช้สำหรับดูความเรียบร้อยของเอกสารก่อนสั่งพิมพ์ 
ก. Print Preview ข. Page Break 
ค. Save As ง. Undo 

9. หากต้องการจัดระยะบรรทัดให้สม่ำเสมอ ควรปรับที่เมนูใด 
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ก. Home → Line and Paragraph Spacing ข. Layout → Size 

ค. Review → Language   ง. Insert → Table 
10. การตรวจทานครั้งสุดท้ายก่อนส่งงานควรทำสิ่งใด 

ก. ปรับสีตัวอักษรให้สวยงาม ข. อ่านทวนเอกสารทั้งหมดเพ่ือหาความผิดพลาด 
ค. เพ่ิมภาพประกอบให้มากขึ้น ง. ลบหน้าเอกสารที่ว่างออกท้ังหมดโดยไม่ตรวจเนื 

เฉลย 1.ข   2.ข   3.ก   4.ข   5.ข   6.ง   7.ข   8.ก   9.ก   1.ข 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



128 
 
 

 
ใบกิจกรรมที่ 5 หน่วยที่   5   

รหัสวิชา   20001 – 1003     ชื่อวิชา     ธุรกิจเบื้องต้น สัปดาห์/ครั้งที่  16 - 17   
ชื่อหน่วยการเรียนรู้   งานตรวจสอบและปรับปรุงงานพิมพ์ใน
โปรแกรม Microsoft Word 

ทฤษฎี    0    ชั่วโมง 

ชื่อเรื่อง      งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม Microsoft Word ปฏิบัติ    8    ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับตรวจสอบความผิดพลาดจากการพิมพ์เอกสาร การใช้ฟังก์ชันตรวจสอบการ
สะกดคำถูก หรือคำผิด การใช้แป้น backspace และแป้น Delete เพื่อแก้ไขคำผิด ตลอดจนหลักการ
ตรวจสอบเอกสารที่ถูกต้อง และมีประสิทธิภาพ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 แสดงความรู้เกี่ยวกับการใช้คำสั่งการตรวจสอบการสะกดคำ 
3.2 แสดงความรู้เกี่ยวกับการใช้แป้นพิมพ์ Backspace และแป้นพิมพ์ Delete เพ่ือแก้ไขคี่พิมพ์ผิด 
3.3  แสดงความรู้เกี่ยวกับหลักการตรวจานเอกสารที่ถ฿กต้อง แฃะมีประสิทธาพ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
4.1 ด้านความรู้  ผู้เรียนสามารถ 

7. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
8. ใช้เครื่องมือเพ่ือตรวจสอบการสกดคำได้ 
9. ตรวจทานงานเอกสารได้อย่างมีประสิทธิภาพ และรวดเร็ว 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
7. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ถูกต้อง แม่นยำ 
8. ใช้โปรแกรม Microsoft Word ได้อย่างดี  
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9. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียน 
 5.2 ใบความรู้/ใบงาน 
 5.3 คอมพิวเตอร์(โปรแกรม Microsoft Word) 

5.4 TV 
6. ข้ันตอนการทำกิจกรรม 
ขั้นตอนที่ 1 : เปิดไฟล์งานที่ต้องการตรวจสอบ 

• เปิดเอกสารในโปรแกรม Microsoft Word 
• ตรวจสอบว่าชื่อไฟล์ถูกต้อง และเป็นเวอร์ชันล่าสุดของงาน 

ขั้นตอนที่ 2 : ตรวจสอบการสะกดคำและไวยากรณ์ (Spelling & Grammar Check) 
1. ไปที่แท็บ Review (รีวิว) 
2. คลิกคำสั่ง Spelling & Grammar หรือกดปุ่ม F7 
3. โปรแกรมจะแสดงคำที่สะกดผิด พร้อมคำแนะนำที่ถูกต้อง 
4. คลิก Change หรือ Ignore ตามความเหมาะสม 
5. อ่านทวนข้อความอีกครั้งเพ่ือความแน่ใจ 

ขั้นตอนที่ 3 : ตรวจสอบรูปแบบเอกสาร (Formatting) 

1. ตรวจขนาดกระดาษ → แท็บ Layout → Size → A4 

2. ตรวจระยะขอบ → Layout → Margins → Normal 

3. ตรวจแบบตัวอักษรและขนาด → Home → Font 
o ฟอนต์: TH SarabunPSK หรือ Angsana New 
o ขนาดตัวอักษร: 14 pt หรือ 16 pt (ตามรูปแบบงาน) 

ขั้นตอนที่ 4 : ตรวจสอบการจัดย่อหน้าและระยะห่าง (Paragraph & Line Spacing) 
1. คลิกเลือกข้อความทั้งหมด (Ctrl + A) 

2. ไปที่แท็บ Home → Line and Paragraph Spacing 
3. ตั้งค่าระยะบรรทัด เช่น 1.15 หรือ 1.5 
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4. จัดแนวข้อความให้ชิดขอบทั้งสองด้าน (Justify) 
5. ตรวจให้แน่ใจว่าย่อหน้ามีการเว้นระยะเท่ากัน 

ขั้นตอนที่ 5 : ตรวจสอบความถูกต้องของเนื้อหา 
• อ่านเนื้อหาทั้งหมดอย่างละเอียด 
• ตรวจชื่อบุคคล ตัวเลข วันเดือนปี หรือหัวข้อให้ถูกต้อง 
• ตรวจว่าข้อความไม่ตกหล่นหรือซ้ำซ้อน 
• ตรวจความสอดคล้องของหัวข้อกับเนื้อหา 

ขั้นตอนที่ 6 : ตรวจสอบการจัดหน้า (Page Layout) 
1. ตรวจให้แน่ใจว่าเอกสารไม่มีหน้าว่าง 
2. การข้ึนหน้าใหม่ควรใช้คำสั่ง Page Break (Ctrl + Enter) 

3. ใส่ เลขหน้า (Page Number) จากแท็บ Insert → Page Number 
4. ตรวจหัวกระดาษ/ท้ายกระดาษ (Header & Footer) ให้ถูกต้อง 

ขั้นตอนที่ 7 : ตรวจสอบองค์ประกอบเพิ่มเติม 
• ตรวจว่ามีชื่อเรื่อง ชื่อผู้จัดทำ และวันที่ครบถ้วน 
• ตรวจภาพ ตาราง หรือกราฟให้จัดตำแหน่งพอดี ไม่ล้นหน้า 
• ตรวจรายการหัวข้อ (Bullet / Numbering) ให้เรียงลำดับถูกต้อง 

ขั้นตอนที่ 8 : ปรับปรุงงานตามที่ตรวจพบ 
• แก้ไขคำผิด รูปแบบ ฟอนต์ หรือย่อหน้าที่ไม่ถูกต้อง 
• ลบส่วนเกิน หรือเพ่ิมเติมเนื้อหาที่ขาด 
• ตรวจซ้ำอีกครั้งหลังแก้ไขเสร็จ 

ขั้นตอนที่ 9 : ตรวจทานครั้งสุดท้าย 
1. เปิดดูเอกสารในโหมด Print Preview (ดูตัวอย่างก่อนพิมพ์) 
2. ตรวจการจัดหน้าและความเรียบร้อยโดยรวม 
3. หากถูกต้องครบถ้วน ให้ บันทึกไฟล์ใหม่ 

ขั้นตอนที่ 10 : ส่งงานและประเมินผล 
• ส่งไฟล์งานให้ครูตรวจ หรือพิมพ์ออกเป็นเอกสารจริง 
• ครูประเมินจากความถูกต้อง ความเรียบร้อย และรูปแบบมาตรฐาน 

สรุปกระบวนการตรวจสอบและปรับปรุงงานพิมพ์ 

ขั้นตอน รายการตรวจสอบ 

1 เปิดไฟล์งาน 

2 ตรวจคำสะกดและไวยากรณ์ 

3 ตรวจรูปแบบเอกสาร 
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ขั้นตอน รายการตรวจสอบ 

4 ตรวจย่อหน้าและระยะบรรทัด 

5 ตรวจเนื้อหาความถูกต้อง 

6 ตรวจการจัดหน้า 

7 ตรวจองค์ประกอบเพิ่มเติม 

8 ปรับปรุงแก้ไข 

9 ตรวจทานครั้งสุดท้าย 

10 ส่งงานและประเมินผล 

7. สรุปและอภิปราย  
7.1 ครูและนักเรียน ช่วยกันสรุปเนื้อหา 

8.  สรุปและวิจารณ์ผล  
8.1 ครูผู้สอนตรวจสอบการส่งงาน ว่าผู้สอนส่งงานครบทุกคนหรือไม่ 

9. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม 
9.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม

วิชาการ 
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ใบงานที่ 5 หน่วยที่   5   

รหัสวิชา 20200-1005  ชื่อวิชา  พิมพ์อังกฤษดิจิทัล สัปดาห์/ครั้งที่  16- 17   
ชื่อหน่วยการเรียนรู้   งานตรวจสอบและปรับปรุงงานพิมพ์ใน
โปรแกรม Microsoft Word 

ทฤษฎี    0   ชั่วโมง 

ชื่อเรื่อง      งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม Microsoft Word ปฏิบัติ    8   ชั่วโมง 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 ศึกษาความรู้เกี่ยวกับตรวจสอบความผิดพลาดจากการพิมพ์เอกสาร การใช้ฟังก์ชันตรวจสอบการ
สะกดคำถูก หรือคำผิด การใช้แป้น backspace และแป้น Delete เพื่อแก้ไขคำผิด ตลอดจนหลักการ
ตรวจสอบเอกสารที่ถูกต้อง และมีประสิทธิภาพ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
    2.1 มาตรฐานอาชีพ     มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน สาขาอาชีพ ช่างไฟฟ้า   
    อิเล็กทรอนิกส์และคอมพิวเตอร์สาขาพนักงานคอมพิวเตอร์ (ประมวลผลคำ) ระดับ 1   

สมรรถนะย่อย    การจัดการงานเอกสาร มีขอบเขตครอบคลุม การจัดการงานเอกสาร 
         1) เกณฑ์การปฏิบัติงาน     เอกสารถูกจัดการได้อย่างถูกต้องตามคู่มือการใช้งาน  
         2) วิธีประเมิน     แบบทดสอบภาคปฏิบัติ 
         3) หลักฐานการปฏิบัติงาน (Performance Evidence)      - 
         4) หลักฐานความรู้ (Knowledge Evidence)     - 
    2.2 บูรณาการกลุ่มอาชีพ    นักการจัดการ 
3. สมรรถนะประจำหน่วย  

3.1 แสดงความรู้เกี่ยวกับการใช้คำสั่งการตรวจสอบการสะกดคำ 
3.2 แสดงความรู้เกี่ยวกับการใช้แป้นพิมพ์ Backspace และแป้นพิมพ์ Delete เพ่ือแก้ไขคี่พิมพ์ผิด 
3.3  แสดงความรู้เกี่ยวกับหลักการตรวจานเอกสารที่ถ฿กต้อง แฃะมีประสิทธาพ 

4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 
4. จุดประสงค์เชิงพฤติกรรม (เขียนให้ครบด้าน พุทธิพิสัย ทักษะพิสัย จิตพิสัย และ ประยุกต์ใช้ฯ) 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
10. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ 
11. ใช้เครื่องมือเพ่ือตรวจสอบการสกดคำได้ 
12. ตรวจทานงานเอกสารได้อย่างมีประสิทธิภาพ และรวดเร็ว 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
10. พิมพ์ทบทวนแบบฝึกพิมพ์ได้ถูกต้อง แม่นยำ 
11. ใช้โปรแกรม Microsoft Word ได้อย่างดี  
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12. ปฏิบัติงารตามแบบฝึกพิมพ์เพ่ือฝึกทักษะความเร็วและความแม่นยำได้ 
4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 

1.    มีความรับผิดชอบตามบทบาทหน้าที่ของตนเองตามระบอบประชาธิปไตย 
4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
      ปฏิบัติงานด้วยความรับผิดชอบ ตรงต่อเวลา มีความสนใจใฝ่รู้ มีความคิดริเริ่มสร้างสรรค์     
     มีวินัยในตนเอง มีความกระตือรือร้นในการค้นคว้าข้อมูลเพิ่มเติม และประยุกต์ใช้หลักปรัชญา 
     ของเศรษฐกิจพอเพียงได้  

5. เครื่องมือ วัสดุ และอุปกรณ์  
          5.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล  
 5.2 ใบความรู้/ใบงาน 

5.3 คอมพิวเตอร์ 
5.4 TV 

6. คำแนะนำ/ข้อควรระวัง  
6.1 ปฏิบัติงานด้วยความละเอียดรอบคอบ   

7. ข้ันตอนการปฏิบัติงาน 
ชื่อเรื่อง งานตรวจสอบและปรับปรุงงานพิมพ์ในโปรแกรม Microsoft Word 
  เวลา 180 นาท ี

 จุดประสงค์   
1. เพ่ือให้นักเรียนหรือนักศึกษามีความสามารถในการตรวจสอบความถูกต้องและความ

เรียบร้อยของงานพิมพ์ก่อนส่งหรือเผยแพร่ โดยใช้เครื่องมือในโปรแกรม Microsoft 
Word อย่างเหมาะสม 

2. เพ่ือให้ผู้เรียนตรวจสอบการสะกดคำ (Spelling Check) ได้อย่างถูกต้อง 
3. เพ่ือให้ผู้เรียนสใช้คำสั่ง การสะกดและไวยกรณ์ เพ่ือตรวจหาคำท่ีสะกดผิดและ

ข้อผิดพลาดทางไวยากรณ์ 
4. เพ่ือให้แก้ไขคำผิดและปรับปรุงประโยค ให้ถูกต้องตามหลักภาษา 
5. เพ่ือตรวจสอบรูปแบบเอกสาร เช่น ขนาดตัวอักษร แบบอักษร การจัดย่อหน้า ระยะ

บรรทัด และการจัดวางหน้า 

 วัสดุอุปกรณ์   
1. คอมพิวเตอร์ 
2.. TV 

  
ขั้นตอนการดำเนินงาน 
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1 : เปิดเอกสารที่ต้องการตรวจสอบ 
 2 : ตรวจสอบการสะกดคำ (Spelling & Grammar) 

• ไปที่แถบเมนู Review (รีวิว) คลิกปุ่มการสะกดและไวยกรณ์ โปรแกรมจะแสดงคำที่
สะกดผิดหรือผิดไวยากรณ์  เลือก “Change” หรือ “Ignore” ตามความเหมาะสม 

 3 : ตรวจสอบรูปแบบเอกสาร (Format) 
• ตรวจสอบ แบบอักษร (Font)  การจัดย่อหน้า (Paragraph Alignment)  ระยะบรรทัด 

(Line Spacing) ระยะขอบกระดาษ (Margins) และหัวกระดาษ/ท้ายกระดาษ 
(Header/Footer) ถูกต้องตามใบงานหรือไม่ 

4 : ตรวจสอบความถูกต้องของเนื้อหา 
 5 : ปรับปรุงและแก้ไขข้อผิดพลาด 

• ใช้ปุ่ม Backspace หรือ Delete เพ่ือลบข้อความที่ไม่ต้องการ พิมพ์แก้ไขข้อความใหม่
ให้ถูกต้อง 

6 : ตรวจทานความเรียบร้อยขั้นสุดท้าย 
7 : บันทึกและจัดเก็บเอกสาร 

8.  สรุปและวิจารณ์ผล  
8.1 ครูและนักเรียนร่วมกันสรุปเนื้อหk 

9. การประเมินผล  
9.1 ผ่านเกณฑ์การประเมินผลไม่ต่ำกว่าร้อยละ 60 

10. เอกสารอ้างอิง/เอกสารค้นคว้าเพิ่มเติม     
10.1 หนังสือเรียนวิชา พิมพ์อังกฤษดิจิทัล (อรวรรณ  นันทปัญญา) ผลิตโดย...สำนักพิมพ์ศูนย์ส่งเสริม
วิชาการ   
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แบบประเมินการนำเสนอผลงาน 
ใบงานที่ ......................... เรื่อง .................................  
กลุ่มท่ี .................... ระดับชั้น ........................ ห้อง .............................. 
รายชื่อสมาชิก  1. ………………………………………………....  3. .................................................  
                   2. ..........................................................  4. ...............................................  

ลำดับ ราบการประเมิน คะแนน ความคิดเห็น 
1 การเตรียมความพร้อม 3 2 1  
2 เนื้อหาสาระครอบคลุมชัดเจน     
3 รูปแบบการนำเสนอ     
4 การรักษาเวลา     
      
 รวมคะแนน     

 
ผู้ประเมิน ......................................................... 
วันที่ ................. เดือน ............... พ.ศ. ............. 

หลักเกณฑ์การให้คะแนน 
1. การเตรียมความพร้อม  

3 คะแนน = มีการจัดเตรียมสถานที่ สื่อ/อุปกรณ์ไว้อย่างพร้อมเพรียง 
 2 คะแนน = มีสื่อ/อุปกรณ์พร้อม แต่ไม่ได้จัดเตรียมสถานที่  
 1 คะแนน = มีสื่อ/อุปกรณ์ ไม่เพียงพอ 

2. เนื้อหาสาระครอบคลุมชัดเจน  
3 คะแนน = มีสาระสำคัญครบถ้วนตรงตามจุดประสงค์  
2 คะแนน = สาระสำคัญไม่ครบถ้วน แต่ตรงตามจุดประสงค์  
1 คะแนน = สาระสำคัญไม่ตรงตามจุดประสงค์ 

3. รูปแบบการนำเสนอ  
3 คะแนน = มีรูปแบบการนำเสนอที่เหมาะสม มีการใช้เทคโนโลยีที่แปลกใหม่ ใช้สื่อและ

เทคโนโลยี ประกอบการนำเสนอท่ีน่าสนใจ นำวัสดุในท้องถิ่นมาประยุกต์ใช้อย่างคุ้มคาและประหยัด  
2 คะแนน = มีเทคนิคการนำเสนอที่แปลกใหม่ ใช้สื่อและเทคโนโลยีประกอบการนำเสนอที่

น่าสนใจ แต่ขาด การประยุกต์ใช้วัสดุท้องถิ่น 
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 1 คะแนน = เทคนิคการนำเสนอไม่เหมาะสม และไม่น่าสนใจ 
4. การรักษาเวลา  

3 คะแนน = ดำเนินกิจกรรมได้ตามเวลาที่กำหนด 
 2 คะแนน = ดำเนินกิจกรรมเร็วกว่าที่กำหนด  
1 คะแนน = ดำเนินกิจกรรมช้ากว่าเวลาที่กำหนด 
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1. การพิมพ์สัมผัสหมายถึงข้อใด 
ก. การพิมพ์โดยใช้สายตามองแป้นพิมพต์ลอดเวลา 
ข. การพิมพ์โดยใช้ปลายนิว้สัมผัสแป้นพมิพ์โดยไม่มองแป้น 
ค. การพิมพ์โดยใช้นิ้วชี้เพยีงนิ้วเดียว 
ง. การพิมพ์โดยใช้มือข้างเดียว 
2. แป้นเหย้าคืออะไร 
ก. แป้นตัวเลข                     ข. แป้นที่ใช้นิ้วสัมผัสตลอดเวลาเมื่อไม่พิมพ ์
ค. แป้นฟังก์ชัน                     ง. แปน้พิเศษ 
3. แป้นเหย้าของมือซ้ายได้แกข่้อใด 
ก. A S D F                            ข. J K L ; 
ค. Q W E R                           ง. Z X C V 
4. แป้นเหย้าของมือขวาได้แก่ขอ้ใด 
ก. A S D F                              ข. J K L ; 
ค. Q W E R                             ง. Z X C V 
5. นิ้วชี้ข้างขวาใช้พิมพ์แป้นใดได้บ้าง 
ก. J N M U Y                            ข. J H N M Y 
ค. J H U N M                            ง. J H N M U 
6. ปุ่ม “Shift” ใช้ทำหน้าที่อะไร 
ก. พิมพ์ตวัเลข                             ข. พิมพ์ตัวอักษรพิมพ์ใหญ ่
ค. ลบตัวอักษร                             ง. เคลื่อนเคอร์เซอร์ 
7. ปุ่ม “Caps Lock” ใช้เพื่อ 
ก. พิมพ์ตวัใหญ่ค้างไว้                      ข. ลบข้อความ 
ค. เคลื่อนเคอร์เซอร์                        ง. บันทึกไฟล ์
8. ปุ่ม “Enter” ใช้เพื่อ 

9. ปุ่ม “Backspace” ทำหน้าที ่
ก. ลบข้อความด้านซ้ายของเคอร์เซอร์      
ข. ลบข้อความด้านขวาของเคอร์เซอร์ 
ค. ขึ้นบรรทัดใหม่                              ง. เคลื่อนเคอร์เซอร์ไปหน้าเอกสาร 
10. ปุ่ม “Spacebar” ใช้ทำอะไร 
ก. เคาะบรรทัดใหม่                             ข. เว้นวรรคระหวา่งคำ 
ค. ลบตัวอักษร                                   ง. ย้ายเคอร์เซอร์ 
11. หน่วยวัดความเร็วในการพิมพ์เรียกว่าอะไร 
ก. คำสุทธิ/นาท ี                             ข. ตวัอักษร/วินาท ี
ค. คำรวม/ชั่วโมง                             ง. นาที/คำสุทธ ิ
12. การจัดรูปแบบเอกสารใน Microsoft Word อยู่ในเมนูใด 
ก. Home                                          ข. Insert 
ค. Layout                                          ง. Review 
13. การบันทึกงานใน Microsoft Word ใช้คำสั่งใด 

ก. File → Save                               ข. Edit → Copy 

ค. Insert → Picture                          ง. View → Zoom 
14. การพิมพ์ข้อความให้ชิดขอบซ้ายเรียกวา่ 
ก. Align Left                              ข. Align Right 
ค. Center                                   ง. Justify 
15. การพิมพ์ข้อความให้ชิดทั้งสองข้างเรียกวา่ 
ก. Center                                    ข. Align Right 
ค. Justify                                     ง. Align Left 
16. ไฟล์เอกสารที่บันทึกจาก Word มีนามสกุลใด 
ก. .xls                                                ข. .pptx 
ค. .docx                                             ง. .pdf 

 
วิทยาลัยเทคนิคบ้านค่าย 

ข้อสอบปลายภาค ภาคเรียนที่ 1/๒๕68                              วันที่  12  กันยายน 2568 
วิชา   พิมพฺอังกฤษดิจิทัล                                                  รหัสวิชา 20001-1003 จำนวน 2 นก. 
ระดับชั้นประกาศนียบัตรวิชาชีพ ชั้นปีที่ 1                               ผู้ออกข้อสอบ  นส.แพรวพรรณ  ในเมือง 
คำชี้แจง : ๑. ข้อสอบปรนัย  จำนวน  20  ข้อ เวลา  3  ชั่วโมง 

   ๒. ไม่อนุญาตนำเอกสารทุกชนิดเข้าห้องสอบ 
    ๓. ทุจริตในการสอบ ปรับตกทุกกรณี 
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ก. ย้ายบรรทัดใหม่                           ข. ลบขอ้ความ 

ค. เคลื่อนเคอร์เซอร์ไปข้างหน้า             ง. พิมพ์ตัวพิมพ์ใหญ ่

 
 

18. ปุ่มลัดในการวางข้อความคือ 
ก. Ctrl + C                             ข. Ctrl + V 
ค. Ctrl + X                              ง. Ctrl + Z 
19. ปุ่มลัดในการยกเลิกการทำงานล่าสดุคือ 
ก. Ctrl + Y                                  ข. Ctrl + X 
ค. Ctrl + Z                                  ง. Ctrl + S 

17. ปุ่มลัดในการคัดลอกข้อความคือ 
ก. Ctrl + C                           ข. Ctrl + X 
ค. Ctrl + V                            ง. Ctrl +. 
 
20. มารยาทที่ดีของนักพิมพ์งานคือข้อใด 
ก. พิมพ์เร็วแต่ไม่ตรวจทาน                   ข. ใช้แป้นแรง ๆ เพื่อความมั่นใจ 
ค. รักษาท่าทางการพิมพแ์ละตรวจทานก่อนส่ง 
ง. พิมพ์ขณะรับประทานอาหาร 

 

 

 
 
 
 
 
 
 
 


